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Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
DAQ-STC™, DAQCard™, DAQPad™, LabVIEW™, MITE™, natinst.com™, National Instruments™, NI-DAQ™
NI-PGIA™, PXI™, RTSI™, and SCXI™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.
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The LabVIEW Data Acquisition Basics Manual includes the information 
you need to get started with data acquisition and LabVIEW. You shoul
have a basic knowledge of LabVIEW before you try to read this manua
you have never worked with LabVIEW, please read through the LabVIEW 
QuickStart Guide or the LabVIEW Online Tutorial before you begin. This 
manual shows you how to configure your software, teaches you basic
concepts needed to accomplish your task, and refers you to common 
example VIs in LabVIEW. If you have used LabVIEW for data acquisitio
before, you can use this book as a troubleshooting guide.

This manual supplements the LabVIEW User Manual, and assumes that 
you are familiar with that material. You also should be familiar with the
operation of LabVIEW, your computer, your computer's operating syste
and your data acquisition (DAQ) board.

Organization of This Manual
The LabVIEW Data Acquisition Basics Manual is organized by sections, 
which in turn are made up of chapters. The sections in this manual are
follows:

• Part I, Before You Get Started, contains all the information you should
know before you start learning about data acquisition with LabVIE

• Part II, Catching the Wave with Analog Input, contains basic 
information about acquiring data with LabVIEW, including acquirin
a single point or multiple points, triggering your acquisition, and usi
outside sources to control acquisition rates.

• Part III, Making Waves with Analog Output, contains basic 
information about generating data with LabVIEW, including 
generating a single point or multiple points.

• Part IV, Getting Square with Digital I/O, describes basic concepts 
about how to use digital signals with data acquisition in LabVIEW,
including immediate and handshaked digital I/O.

• Part V, SCXI—Getting Your Signals in Great Condition, contains 
basic information about setting up and using SCXI modules with yo
data acquisition application, special programming considerations,
common SCXI applications, and calibration information.
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• Part VI, Counting Your Way to High-Precision Timing, describes 
the different ways you can use counters with your data acquisition
application, including generating a pulse or pulses; measuring pul
width, frequency, and period; counting events and time; and dividi
frequencies for precision timing.

• Part VII, Debugging Your Data Acquisition Application, contains an 
explanation of ways you can debug your data acquisition applicati
to make sure your application is accurate and runs smoothly. 

• Appendix A, LabVIEW Data Acquisition Common Questions, lists 
answers to questions frequently asked by LabVIEW users.

• Appendix B, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.

• The Glossary contains an alphabetical list and description of terms
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in th
manual, including the page where you can find each one.

Conventions Used in This Manual
The following conventions are used in this manual:

[] Square brackets enclose optional items—for example, [response ].

<> Angle brackets enclose the name of a key on the keyboard—for exam
<shift>. Angle brackets containing numbers separated by an ellipsis 
represent a range of values associated with a bit or signal name—for 
example, DBIO<3..0>.

- A hyphen between two or more key names enclosed in angle brackets
denotes that you should simultaneously press the named keys—for 
example, <Control-Alt-Delete>.

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence File»Page Setup»Options» Substitute 
Fonts directs you to pull down the File menu, select the Page Setup item, 
select Options, and finally select the Substitute Fonts options from the 
last dialog box.
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bold Bold text denotes the names of menus, menu items, parameters, dialo
boxes, dialog box buttons or options, icons, windows, Windows 95 tab
or LEDs.

bold italic Bold italic text denotes a note, caution, or warning.

italic Italic text denotes variables, emphasis, a cross reference, or an introdu
to a key concept. This font also denotes text from which you supply th
appropriate word or value, as in Windows 3.x.

monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subprograms, subroutines, device names, funct
operations, variables, filenames and extensions, and for statements a
comments taken from programs.

monospace bold Bold text in this font denotes the messages and responses that the com
automatically prints to the screen. This font also emphasizes lines of c
that are different from the other examples.

monospace italic Italic text in this font denotes that you must enter the appropriate word
values in the place of these items.

Platform Text in this font denotes information related to a specific platform.

NI-DAQ 4.8.x NI-DAQ 4.8.x refers to functions supported only on the Macintosh for 
NUBus DAQ products.

NI-DAQ 5.x NI-DAQ 5.x refers to functions supported only on Windows DAQ produc

NI-DAQ 6.0 NI-DAQ 6.0 refers to functions supported only on Windows and PCI-ba
Macintosh DAQ products.

This icon to the left of bold italicized text denotes a note, which alerts y
to important information.
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LabVIEW Data Types Each VI description gives a data type picture for each input and outp
parameter, as illustrated in the following table:

Abbreviations, acronyms, metric prefixes, mnemonics, symbols, and te
are listed in the Glossary.

Control Indicator Data Type

Signed 8-bit integer

Signed 16-bit integer

Signed 32-bit integer

Unsigned 8-bit integer

Unsigned 16-bit integer

Unsigned 32-bit integer

Single-precision floating-point number

Double-precision floating-point number

Extended-precision floating-point 
number

String

Boolean

Array of signed 32-bit integers

2D Array of signed 32-bit integers

Cluster

File Refnum
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Related Documentation
The following documents contain information you might find helpful as
you read this manual:

• LabVIEW User Manual

• G Programming Reference Manual

• LabVIEW Function and VI Reference Manual

• LabVIEW QuickStart Guide

• LabVIEW Online Reference, available online by selecting 
Help»Online Reference

• LabVIEW Online Tutorial, which you launch from the LabVIEW 
dialog box

• Application Note 025, Field Wiring and Noise Considerations for 
Analog Signals

• The user manuals for the data acquisition boards you use

Customer Communication
National Instruments wants to receive your comments on our products
manuals. We are interested in the applications you develop with our 
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix B, Customer 
Communication, at the end of this manual.
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Before You Get Started

This section contains all the information you should know before yo
start learning about data acquisition with LabVIEW. 

Part I, Before You Get Started, contains the following chapters:

• Chapter 1, How To Use This Book, explains how this manual is 
organized.

• Chapter 2, Installing and Configuring Your Data Acquisition 
Hardware, explains how to set up your system to use data acquisit
with LabVIEW and your Data Acquisition hardware.

• Chapter 3, Basic LabVIEW Data Acquisition Concepts, explains key 
concepts in understanding how data acquisition works with LabVIE

• Chapter 4, Where You Should Go Next, directs you to the chapter or 
chapters in the manual best suited to answer questions about your
acquisition application.



© National Instruments Corporation 1-1 LabVIEW Data Acquisiti
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How To Use This Book

This chapter explains how this manual is organized. The following outline 
shows you what information you can find in this manual.

Part I : Before You Get Started

How to Use This Book

Installing and Configuring Your Data Acquisition Hardware

Basic LabVIEW Data Acquisition Concepts

Where You Should Go Next

Part II : Catching the Wave with Analog Input

Things You Should Know about Analog Input

One-Stop Single-Point Acquisition

Buffering Your Way through Waveform Acquisition

Controlling Your Acquisition with Triggers

Letting an Outside Source Control Your Acquisition Rate

Part III : Making Waves with Analog Output

Things You Should Know about Analog Output

One-Stop Single-Point Generation

Buffering Your Way through Waveform Generation

Letting an Outside Source Control Your Update Rate

Simultaneous Buffered Waveform Acquisition and Generation

Part IV : Getting Square with Digital I/O

Things You Should Know about Digital I/O

When You Need It Now—Immediate Digital I/O

Shaking Hands with a Digital Partner
on Basics Manual



Chapter 1 How To Use This Book
Part V: SCXI—Getting Your Signals in Great Condition

Things You Should Know about SCXI

Hardware and Software Setup for Your SCXI System

Special Programming Considerations for SCXI

Common SCXI Applications

SCXI Calibration—Increasing Signal Measurement Precision 

Part VI : Counting Your Way to High-Precision Timing

Things You Should Know about Counters

Generating a Square Pulse or Pulse Trains

Measuring Pulse Width

Measuring Frequency and Period

Counting Signal Highs and Lows

Dividing Frequencies

Part VII : Debugging Your Data Acquisition Application

Debugging Techniques

If you already have started a LabVIEW DAQ application, please refer to 
Chapter 2, Installing and Configuring Your Data Acquisition Hardware, 
to check your configuration. Refer to Part VII, Debugging Your Data 
Acquisition Application, for information on common errors for your 
application. The following flowchart shows the steps to follow before 
running your application:

Install and Configure Your Hardware

Learn Basic Data Acquisition Concepts

Go to Your Specific Application Section

Review LabVIEW Example Applications

Learn How to Debug Your Application
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1. Install and Configure Your Hardware —When you install 
LabVIEW, the program prompts you to have the data acquisition 
(DAQ) drivers installed. This manual guides you through setting up
NI-DAQ software with your DAQ device and SCXI hardware. You 
should read any unique installation instructions for your platform in
Chapter 2, Installing and Configuring Your Data Acquisition 
Hardware. 

2. Learn Basic Data Acquisition Concepts—Chapter 3, Basic 
LabVIEW Data Acquisition Concepts, shows you the location of 
DAQ example VIs; DAQ VI organization; VI parameter conventions
default and current value conventions; common VI parameter 
definitions; error handling; channel, port and counter addressing; 
limit settings; and data organization for analog applications. 

3. Go to Your Specific Application Section—Chapter 4, Where You 
Should Go Next, shows you where to find information in this manua
for your application.

4. Review LabVIEW Example Applications—The remaining chapters 
teach you basic concepts in analog input and output, digital I/O, 
counters, and SCXI. Each application section first lists example V
then describes the basic concepts needed to understand these ex
VIs. Whenever possible, you should have the VI open as you refe
these examples. 

5. Learn How to Debug Your Application—Chapter 29, Debugging 
Techniques, describes the different ways you can debug your 
application. This chapter helps you troubleshoot for common 
programming errors.

Now you can begin the rewarding adventure of data acquisition with 
LabVIEW. 
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Installing and Configuring Your 
Data Acquisition Hardware

This chapter explains how to set up your system to use data acquisitio
with LabVIEW and your data acquisition hardware. The chapter conta
hardware installation and configuration and software configuration 
instructions and some general information and techniques.

Note The LabVIEW installer prompts you to have the NI-DAQ driver software 
installed. All National Instruments data acquisition (DAQ) devices are package
with NI-DAQ driver software. The version of NI-DAQ packaged with your 
DAQ device might be newer than the version installed by LabVIEW. You can 
determine the NI-DAQ version in LabVIEW by running the Get DAQ Device 
Information VI , located in Functions»Data Acquisition»Calibration and 
Configuration . 

After installing LabVIEW and the NI-DAQ driver, follow the steps 
in Figure 2-1 to install your hardware and complete the software 
configuration. LabVIEW uses the software configuration information 
to recognize your hardware and to set default DAQ parameters.

Get DAQ Device
Information VI
on Basics Manual
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Figure 2-1.  Installing and Configuring DAQ Devices

NI-DAQ driver software provides LabVIEW with a high-level interface t
DAQ devices and signal conditioning hardware.

Install Plug-in Devices

Use Your Configuration Utility 
to Configure Devices

Install and Configure SCXI

Read Chapter 3, Basic Data Acquisition Concepts, 
and Chapter 4, Where You Should Go Now

Using SCXI?
YesNo

Use the DAQ Channel Wizard 
to Configure Channels
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Figure 2-2 shows the relationship between LabVIEW, NI-DAQ, and 
DAQ hardware.

Figure 2-2.  How NI-DAQ Relates to Your System and DAQ Devices

(NI-DAQ 4.8.x for Macintosh) NI-DAQ 4.8.x for the Macintosh device drivers
are bundled in a single file that determines which drivers to load. When 
restart your computer, this control panel driver, called NI-DAQ , determines 
which devices are installed in the system and loads their correspondin
drivers. NI-DAQ uses its control panel settings to determine what 
SCXI hardware is configured and what the default device settings are 
devices in the computer. If you use DMA, NI-DAQ also communicates
with the NI-DMA/DSP for DMA services. When you install LabVIEW, 
the installer places both of these files on your hard drive.

(NI-DAQ 6.0 for Macintosh) The NI-DAQ Driver, called NI-DAQ  is installed 
in the National Instruments folder in your Macintosh Extensions folder.

(NI-DAQ 5.x, 6.0 for Windows) The NI-DAQ Driver, called NIDAQ.DLL  in 
Windows 3.x and NIDAQ32.DLL  in Windows 95/NT, is installed in your 
Windows system directory.

LabVIEW VIs

NI-DAQ Drivers

Data Acquisition Devices
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LabVIEW Data Acquisition Hardware Support
National Instruments periodically upgrades LabVIEW to add support f
new DAQ hardware. To make sure this version of LabVIEW supports 
hardware you use, refer to the following tables.

Table 2-1.  LabVIEW DAQ Hardware Support for Windows with NI-DAQ 5.x, 6.0

Device Type Devices Supported

AT Series 
Devices

AT-AO-6/10, AT-DIO-32F, AT-DIO-32HS, AT-MIO-16/16D, 
AT-MIO-16DE-10, AT-MIO-16E-1, AT-MIO-16E-2, AT-MIO-16E-10, 
AT-MIO-16F-5, AT-MIO-16X, AT-MIO-16XE-50, AT-MIO-64E-3, 
AT-MIO-64F-5, AT-AI-16XE-10, AT-MIO-16XE-10, AT-5102, AT-5411

PC Series 
Devices

Lab-PC+, PC-AO-2DC, PC-DIO-24, PC-DIO-96, PC-LPM-16, 
PC-OPDIO-16, PC-TIO-10, PC-DIO-96PnP, PC-DIO-24PnP, 
PC-LPM-16PnP, PC-516, Lab-PC-1200, Lab-PC-1200AI, PC-4350, 
PC-4060*

PCI Series 
Devices

PCI-MIO-16E-1, PCI-MIO-16E-4, PCI-MIO-16XE-50, PCI-MIO-16E-10, 
PCI-1200, PCI-DIO-96, PCI-5102, PCI-5411, PCI-DIO-32HS, PCI-4350, 
PCI-6031E, PCI-6032E, PCI-6033E, PCI-6051E, PCI-4060*, PCI-6110E*,
PCI-6111E*

PXI Series 
Devices

PXI-6040E, PXI-6070E, PXI-6533, PXI-1010*, PXI-4060*, PXI-5102*, 
PXI-DIO-96*

NEC Devices NEC-AI-16E-4, NEC-AI-16XE-50, NEC-MIO-16E-4, NEC-MIO-16XE-50

External Devices AMUX-64T, SC-2040, SC-2042-RTD, SC-2043-SG, DAQPad-12001, 
DAQPad-MIO-16XE-501, SC-2345, DAQPad-6020E* (USB), 
DAQPad-6507* (USB), DAQPad-4350* (USB)

PCMCIA 
Devices

DAQCard-500, DAQCard-700, DAQCard-1200, DAQCard-AO-2DC, 
DAQCard- DIO-24, DAQCard-AI-16E-4, DAQCard-AI-16XE-50, 
DAQCard-516, DAQCard-4050, DAQCard-5102, DAQCard-4350, 
DAQCard-4050, DAQCard-DIO-32HS, DAQCard-6533
LabVIEW Data Acquisition Basics Manual 2-4 © National Instruments Corporation
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SCXI Chassis and 
Modules

SCXI-1000, SCXI-1000DC, SCXI-1001, SCXI-1100, SCXI-1102, 
SCXI-1120, SCXI-1120D, SCXI-1121, SCXI-1122, SCXI-1124, SCXI-1140
SCXI-1141, SCXI-1160, SCXI-1161, SCXI-1162, SCXI-1162HV, 
SCXI-1163, SCXI-1163R, SCXI-12001, SCXI-2000, SCXI-2400, 
SCXI-1126*

VXI Modules VXI-MIO-64E-1, VXI-MIO-64XE-50, VXI-DIO-128, VXI-AO-48XDC, 
VXI-SC-1150, VXI-SC-1102, VXI-SC-1000

*These devices are supported only under DAQ 6.0. DAQ 5.x does not support these devices.

1The DAQPad-MIO-16XE-50 and DAQPad-1200 do not work with NEC PC-9800 Series computers. The SCXI-1200 
work with NEC PC-9800 Series computers ONLY when used with Remote SCXI.

Table 2-2.  LabVIEW DAQ Hardware Support for Macintosh with NI-DAQ 4.8.x

Device Type Devices Supported

Plug-In Devices DAQCard-500, DAQCard-700, DAQCard-1200, DAQCard-DIO-24, 
DAQCard-AO-2DC, Lab-LC, Lab-NB, NB-DIO-24, NB-DIO-32F, 
NB-DIO-96, NB-DMA-8-G, NB-DMA2800, NB-MIO-16, NB-MIO-16X, 
NB-TIO-10, NB-AO-6, NB-A2150, NB-A2100, NB-A2000, PCI-1200, 
PCI-DIO-96, PCI-MIO-16XE-50

External Devices AMUX-64T, SC-2040, SC-2042-RTD, SC-2043-SG

SCXI Modules SCXI-1000, SCXI-1001, SCXI-1100, SCXI-1102, SCXI-1120, SCXI-1121, 
SCXI-1122, SCXI-1124, SCXI-1140, SCXI-1141, SCXI-1160, SCXI-1161, 
SCXI-1162, SCXI-1162HV, SCXI-1163, SCXI-1163R

Table 2-3.  LabVIEW DAQ Hardware Support for Macintosh with NI-DAQ 6.0

Device Type Devices Supported

PCI Series 
Devices

PCI-MIO-16E-1, PCI-MIO-16E-4, PCI-MIO-16XE-10, PCI-MIO-16XE-50, 
PCI-6031E (PCI-MIO-64XE-10), PCI-6032E (PCI-AI-16XE-10), 
PCI-6033E (PCI-AI-64XE-10), PCI-6071E (PCI-MIO-64E-1), PCI-DIO-96, 
PCI-1200, PCI-DIO-32HS

DAQCard and 
PCMCIA cards

DAQCard-AI-16E-4, DAQCard-AI-16XE-50, DAQCard-1200, 
DAQCard-700, DAQCard-500, DAQCard-516, DAQCard-AO-2DC, 
DAQCard-DIO-24, DAQCard-6533

Table 2-1.  LabVIEW DAQ Hardware Support for Windows with NI-DAQ 5.x, 6.0 (Continued)

Device Type Devices Supported
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If you have any other questions regarding hardware support for LabVIE
refer to Appendix B, Hardware Capabilities, in the LabVIEW Function and 
VI Reference Manual, or the LabVIEW Online Reference, by selecting 
Help»Online Reference....

Installing and Configuring Your 
National Instruments Device

Some DAQ devices have jumpers to set analog input polarity, input mo
analog output reference, and so on. Before you install your device, ch
your hardware user manuals to see if your device has jumpers and ho
change its settings. You then can determine whether you need to cha
any jumper settings. Record any jumper settings that you change so t
you can enter the information correctly in the configuration utility.

The next step depends on what version of NI-DAQ you have. Go to th
appropriate section below to continue the configuration of your device

Installing and Configuring Your DAQ Device Using NI-DAQ 5.x, 6.0
You can refer to the NI-DAQ Configuration Utility online help file for 
specific instructions on how to install and configure your DAQ device. 
If you are using Windows 3.x or Windows NT 3.5.1, you can find the 
help file in the Program Group LabVIEW . If you are using Windows 95 
or Windows NT 4.0, you can find the help file in Start»Programs» 
LabVIEW»NI-DAQ Configuration Utility Help . If you are using 
a Macintosh, you can find the help file in the Help menu of the 
NI-DAQ Configuration Utility.

Configuring Your DAQ Device Using NI-DAQ 4.8.x on the Macintosh
After you check and record your jumper settings, turn off your comput
and insert your National Instruments devices.

Turn your computer back on. You can find NI-DAQ  in your control 

panels  folder. The NI-DAQ icon looks like the one shown to the left. 
Double-click on this icon to launch NI-DAQ.

When you launch the program, NI-DAQ displays a list of all of the devic
in your computer. Each device has a small list of attributes, as shown 
Figure 2-3. The number specified in the device line is the logical devic
number that NI-DAQ assigned to the device. You will use this number 
LabVIEW as the device number to select that device for any operation
LabVIEW Data Acquisition Basics Manual 2-6 © National Instruments Corporation
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Figure 2-3.  NI-DAQ Device Window Listing

Now show the Device Configuration window by selecting the 
Device Configuration option from the menu as shown in Figure 2-4.

Figure 2-4.  Accessing the Device Configuration Window in NI-DAQ
© National Instruments Corporation 2-7 LabVIEW Data Acquisition Basics Manual
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Figure 2-5 shows the NI-DAQ Device Configuration window. When you
are in the Device Configuration window of the utility, you can edit the 
default settings for parameters, such as analog input polarity and rang
on a per-device basis. If you are using AMUX-64T or signal conditionin
devices with your DAQ device, select the appropriate device using the
Accessories menu. LabVIEW uses these settings when initializing the 
device instead of the default settings listed in the descriptions of the 
hardware configuration VIs. (You can use these VIs to change any 
setting recorded by NI-DAQ.) When you click on the name of the devic
NI-DAQ displays the I/O connector for the device, as shown in Figure 2

Figure 2-5.  Device Configuration and I/O Connector Windows in NI-DAQ

You also can find helpful information by clicking on the Help button. If at 
any time during configuration you need to view a list of the LabVIEW DA
error codes and their meanings, you can do so by clicking on the NI-D
menu bar, located to the right of the Help button, and choosing Errors .

Note Some DAQ devices, such as the Lab-NB and NB-MIO-16 devices, require 
hardware jumper changes in addition to software configuration. Consult your 
DAQ device hardware reference manual for more information.
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Installing and Configuring Your SCXI Chassis
The following section describes the procedures for installing and 
configuring your SCXI chassis.

Hardware Configuration
Your SCXI hardware kit includes the Getting Started with SCXI manual, 
which contains detailed instructions for assembling your SCXI system
module jumper settings, cable assemblies, and terminal blocks. The 
following are the basic steps you must complete to assemble your 
SCXI system.

1. Check the jumpers on your modules. Generally, you will leave the
jumpers in their default positions. However, the Getting Started with 
SCXI manual contains a section for each module type that lists ca
where you might want to change the jumper settings.

2. Turn off the chassis power. Plug in your modules through the fron
the chassis. You can put the modules in any slot. For simplicity, st
with slot 1 on the left side of the chassis and move right with each
additional module. Be sure to tightly screw the modules into the 
chassis frame.

3. If you are using an SCXI-1180 feedthrough panel, you must install 
SCXI-1180 in the slot immediately to the right of the module that yo
will cable to the DAQ device. Otherwise, the cable connectors mig
not fit together conveniently.

4. If you have more than one chassis, select a unique jumpered add
for each additional chassis by using the jumpers directly behind th
front panel of the chassis.

5. Plug the appropriate terminal blocks into the front of each module 
screw them tightly into the chassis frame.
© National Instruments Corporation 2-9 LabVIEW Data Acquisition Basics Manual



Chapter 2 Installing and Configuring Your Data Acquisition Hardware

les 
able 
y 
s not 
es 

ou 
ce. 

you 
ice. 

 

.

6. If you are using a DAQ device in your computer to control your 
SCXI chassis, connect the mounting bracket of the SCXI-134x 
(wherex is a number) cable assembly to the back of one of the modu
and screw it into the chassis frame. Connect the other end of the c
to the DAQ device in your computer. In multiplexed mode, you onl
need to cable one module to the DAQ device. In most cases, it doe
matter which module you cable. The following are two special cas
where you should cable a specific module to the device:

a. If you use SCXI-1140 modules with other types of modules, y
need to cable one of the SCXI-1140 modules to the DAQ devi

b. If you use analog input modules and other types of modules, 
need to cable one of the analog input modules to the DAQ dev

7. Turn on your chassis power.

Refer to the Getting Started with SCXI manual for more information about
related topics, such as multichassis cabling.

NI-DAQ 5.x, 6.0 Software Configuration
Refer to the NI-DAQ Configuration Utility online help file for specific 
instructions about configuring your SCXI device. If you use Windows 3x 
or Windows NT 3.5.1, you can find the help file in the Program Group 
LabVIEW . If you use Windows 95 or Windows NT 4.0, you can find 
the help file in Start»Programs» LabVIEW»NI-DAQ Configuration 
Utility Help . If you use a Macintosh, you can find the help file in the 
Help menu of the NI-DAQ Configuration Utility.

NI-DAQ 4.8.x Software Configuration
To use SCXI with LabVIEW and NI-DAQ 4.8.x, you must enter 
the configuration for each SCXI chassis using NI-DAQ. Select 
SCXI Configuration in the NI-DAQ menu bar to bring up the 
SCXI Configuration window as shown in Figure 2-6.
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d.
Figure 2-6.  Accessing the NI-DAQ SCXI Configuration Window

Figure 2-7 shows NI-DAQ with the SCXI Configuration window selecte

Figure 2-7.  SCXI Configuration Window in NI-DAQ
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1. Leave the Chassis set to 1 if you have only one chassis. You will use
this number to access the SCXI chassis from your application. If y
have multiple chassis, advance the Chassis to configure the next 
chassis after you finish configuring the first chassis.

2. Select the appropriate chassis type for your chassis. This activate
remaining fields on the panel.

3. If you only have one chassis, leave the Address field and the address 
jumpers on your SCXI chassis set to 0. If you have additional chassis,
you must select a unique hardware-jumpered address for each ch
and enter it in the Address field.

4. Leave the Method set to Serial , which means that LabVIEW 
communicates with the chassis serially using a DIO port of the plug
DAQ device. The Path automatically sets itself to the device numbe
of the appropriate DAQ device when you enter the Cabled Device 
information in step 5b.

5. Enter the configuration for each slot in the chassis. The fields in th
bottom two sections of the window reflect the settings for the select
Module number. Refer to your SCXI chassis hardware manual to 
determine how the slots in a chassis are numbered. You must set
following fields for each SCXI module you install:

a. Module type—Select the correct module type for the module
installed in the current slot. If the current slot does not have a 
module, leave this field set to None and advance the Module 
number to the next slot.

b. Cabled Device—If the module in the current slot is directly 
cabled to a DAQ device in your computer, set this field to the 
device number of that DAQ device. Leave the Cabled Device field 
set to None if the module in the current slot is not directly cable
to a DAQ device. If you are operating your modules in multiplexe
mode, you only need to cable one module in each chassis to y
DAQ device. If you are not using multiplexed mode, refer to th
SCXI Operating Modes section of Chapter 19, Hardware and 
Software Setup for Your SCXI System, for instructions about 
module cabling.
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c. Operating Mode—The system defaults to the multiplexed 
operating mode, which is recommended for almost all 
SCXI applications. The operating modes available for each 
SCXI module type are described in the SCXI Operating Modes 
section of Chapter 19, Hardware and Software Setup for Your 
SCXI System.

If the module is an analog input module, enter the gain and fil
settings for each channel in the bottom section of the window. T
system disables the Channel control for any modules that use 
only one gain and filter setting for the entire module.

Configuring Your Channels in NI-DAQ 5.x, 6.0
Once you install and configure your hardware, you can configure your
channels. LabVIEW DAQ software includes a channel configuration 
application, the DAQ Channel Wizard, you can use to configure the ana
and digital channels on your DAQ device—DAQ plug-in boards, 
stand-alone DAQ products, or SCXI modules. In NI-DAQ 5.x only analog 
input channels can be configured. The DAQ Channel Wizard helps yo
define the physical quantities you are measuring or generating on eac
DAQ Hardware channel by querying for information about the physica
quantity being measured, the sensor or actuator being used, and the 
associated DAQ hardware. As you configure channels in the DAQ Chan
Wizard, you give each channel configuration a unique name which is u
when addressing your channels in LabVIEW. The channel configuratio
you define are saved in a file that instructs the NI-DAQ Driver how to sc
and process each DAQ channel by its name. You can simplify the 
programming required to measure your signal by using the DAQ Chan
Wizard to configure your channels.

Refer to the DAQ Channel Wizard online help file for specific instructio
on how to use the DAQ Channel Wizard. If you use Windows 3.x, you can 
find the help file in the Program Group LabVIEW . If you use Windows 95 
or NT 4.0, you can find the help file in Start»Programs»LabVIEW» 
DAQ Channel Wizard Help. Macintosh users can find the help file in the
NI-DAQ  folder. You can also launch the help file on any platform by 
clicking the Help button in the DAQ Channel Wizard.
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Refer to the Channel Name Addressing section of Chapter 3, Basic 
LabVIEW Data Acquisition Concepts, for information about how to use 
your named channels in LabVIEW.

Now that you have successfully installed and configured your 
DAQ hardware for LabVIEW, read Chapter 3, Basic LabVIEW Data 
Acquisition Concepts, for more information about data acquisition with 
LabVIEW.
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Basic LabVIEW Data 
Acquisition Concepts

This chapter explains key concepts in understanding how data acquis
works with LabVIEW. Before you start building your data acquisition 
(DAQ) application, you should know some of the following basic 
LabVIEW DAQ concepts:

• Location of Common DAQ Examples

• Locating the Data Acquisition VIs in LabVIEW

• DAQ VI Organization

• VI Parameter Conventions

• Common DAQ VI Parameters

• Default and Current Value Conventions

• Error Handling

• Channel, Port, and Counter Addressing

• Limit Settings

• Data Organization for Analog Applications

If you do not already understand basic programming concepts in 
LabVIEW, refer to the LabVIEW User Manual or the G Programming 
Reference Manual for help with programming in LabVIEW.

Location of Common DAQ Examples
(NI-DAQ 5.x, 6.0) The easiest way to locate a particular DAQ example is
run the DAQ Solution Wizard. You can access the DAQ Solution Wiza
by clicking on the DAQ Solution Wizard button when you first launch 
LabVIEW, or by selecting DAQ Solution Wizard from the File menu in 
LabVIEW.

The DAQ examples address many common applications involving 
data acquisition in LabVIEW. You can find these examples in 
labview\examples\daq . The following list briefly describes the 
on Basics Manual
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VI libraries (designated by the .llb  file extension) and directories located
in the daq  directory.

anlogin Folder containing the anlogin.llb  VIs that 
perform analog input and the strmdsk.llb  VIs 
that can write or stream the acquired data to dis

anlogout Folder containing the anlogout.llb  VIs that 
generate single values or multiple values 
(waveforms) to output through analog channels

anlog_io Folder containing the anlog_io.llb  VIs for 
analog I/O control loops and simultaneous analo
input and output.

counter Folder containing the DAQ-STC.llb , 
Am9513.llb , and 8253.llb  libraries of VIs that 
count the rising and falling edges of TTL signals
generate TTL pulses, and measure the frequen
and period of TTL signals.

digital Folder containing the digio.llb  VIs that 
perform immediate digital I/O and digital 
handshaking.

scxi Folder containing the scxi_ai.llb , 
scxi_ao.llb , and scxi_dig.llb  VIs, for use 
with SCXI modules.

solution Folder containing the benchtop.llb , 
control.llb , datalog.llb , and 
transduc.llb  VIs, a variety of ready-to-run 
application VIs.

run_me.llb Library containing the VIs that perform basic 
operations concerning analog I/O, digital I/O, an
counters.

Each chapter in this manual teaches the basic concepts behind several
DAQ examples. For a brief description of any example, open the exam
VI and choose Windows»Show VI Info for a text description of the 
example. You also can choose Help»Show Help to open the Help window. 
When the Help window is open, you can put your cursor over any front 
panel or block diagram item and see a description of that item in the 
window. 
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Locating the Data Acquisition VIs in LabVIEW
You can find the Data Acquisition VIs in the Functions palette from your 
block diagram in LabVIEW. When you put your cursor over each of th
icons in the Functions palette, LabVIEW displays the palette name you a
about to access at the top of the Functions palette. You can find the Data 
Acquisition icon near the bottom of the Functions palette, as shown in 
Figure 3-1.

Figure 3-1.  Accessing the Data Acquisition Palette

The Data Acquisition palette contains six subpalette icons that take you
the different classes of DAQ VIs. Figure 3-2 shows what each of the ic
in the Data Acquisition palette mean. 

Figure 3-2.  Data Acquisition VIs Palette

Display of Palette Name

Data Acquisition Icon

Counter VIs

Digital I/O VIsAnalog Output VIs

Analog Input VIs

Calibration and
Configuration VIs

Signal Conditioning VIs
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DAQ VI Organization
In most of the DAQ VI subpalettes, the VIs are arranged in different lev
according to their functionality. You can find some of the following fou
levels of DAQ VIs within the DAQ VI subpalettes.

• Easy VIs

• Intermediate VIs

• Utility VIs

• Advanced VIs

A good example of a palette that contains all of the available levels of 
DAQ VIs is the Analog Input palette. Figure 3-3 shows this palette.

Figure 3-3.  Analog Input VI Palette Organization

Easy VIs
The Easy VIs perform simple DAQ operations and are typically the firs
row of VIs in the DAQ palettes. You can run these VIs from the front pa
or use them as subVIs in basic applications.

These VIs are stand-alone in that you only need one Easy VI to perfor
each basic DAQ operation. Unlike intermediate- and advanced-level V
Easy VIs automatically alert you to errors with a dialog box that asks y
to stop the execution of the VI or to ignore the error. 

The Easy VIs actually are usually composed of Intermediate VIs, whic
are in turn composed of Advanced VIs. The Easy VIs provide a basic,
convenient interface with only the most commonly used inputs and outp
For more complex applications, you should use the intermediate- or 
advanced-level VIs for more functionality and better performance.

Easy Analog Input VIs

Intermediate
Analog Input VIs

Advanced
Analog Input VIs

Analog Input Utility VIs
LabVIEW Data Acquisition Basics Manual 3-4 © National Instruments Corporation



Chapter 3 Basic LabVIEW Data Acquisition Concepts

 in 
ate 
d do 

sy 
 to 

he 

 
 

ry 
ed 
ry to 

ly 
Refer to your particular type of VI in the LabVIEW Function and VI 
Reference Manual for specific VI information, or refer to the LabVIEW 
Online Reference, by selecting Help»Online Reference....

Intermediate VIs
The Intermediate VIs have more hardware functionality and efficiency
developing your application than the Easy VIs. Actually, the Intermedi
VIs contain groups of Advanced VIs, but they use fewer parameters an
not have some of the more advanced capabilities.

Intermediate VIs give you more control over error-handling than the Ea
VIs. With each VI, you can check for errors or pass the error cluster on
other VIs.

Note Most LabVIEW data acquisition examples shown in this manual are based on t
Intermediate VIs. You can find these example VIs in the examples  folder.

Utility VIs
The Utility VIs, found in many of the LabVIEW DAQ palettes, are also
intermediate-level VIs and thus have more hardware functionality and
efficiency in developing your application than the Easy VIs. Read the 
previous Intermediate VIs section for more information on how these 
operate.

Advanced VIs
The Advanced VIs are the lowest-level interface to the DAQ driver. Ve
few applications require the use of the Advanced VIs. Use the Advanc
VIs when the Easy or Intermediate VIs do not have the inputs necessa
control an unusual DAQ function. Advanced VIs return the greatest 
amount of status information from the DAQ driver. This manual primari
focuses on applications using the Easy or Intermediate VIs. 
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VI Parameter Conventions
In each LabVIEW DAQ VI front panel or Help window, the appearance 
of the control and indicator labels denote the importance of that parame
Control and indicator names in bold typically must be wired to a node 
the block diagram for your application to run. Controls and indicators n
necessary for your program to operate appear in plain text. You rarely n
to use the parameters with labels in square brackets ([ ]). Keep in mind
these conventions apply only to the information in the Help window an
on the front panel. Both this manual and the LabVIEW Function and VI 
Reference Manual list all parameter names in bold to distinguish them fro
other elements of the text. The default inputs appear in parentheses to
right of the parameter names.

Figure 3-4 illustrates these Help window parameter conventions for th
AI Read One Scan VI. As the window text for this VI indicates, you shou
wire the device (if you are not using channel names), channels, error in , 
and iteration  input parameters and the scaled data and error out  output 
parameters. In order to pass error information from one VI to another,
connect the error out  cluster of the current VI to the error in  cluster of 
the next VI. The coupling & input config, input limits , and output units 
input parameters and the binary data output parameter are optional 
parameters. You rarely need to use the number of AMUX boards 
parameter.

Figure 3-4.  LabVIEW Help Window Conventions
LabVIEW Data Acquisition Basics Manual 3-6 © National Instruments Corporation
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Default and Current Value Conventions
To use the DAQ VIs, you should know the difference between a default 
input, a default setting, and a current setting. A default input is the default 
value of a front panel control. When you do not wire an input to a terminal 
of a VI, the default input for the control associated with that terminal passes 
to the driver. In the Help window, default inputs appear in parentheses to 
the right of the parameter names. A default setting is a default parameter 
value recorded in the driver. The current setting is the value of a control at 
any given moment. The default setting of a control becomes the current 
setting and remains so until you change the value of the control.

In many cases, a control input defaults to a certain value (most often 0), 
which means you can use the current setting. For example, the default input 
for a parameter may be do not change the curren t  setting , and 
the current setting may be no AMUX-64T boards . If you change the value 
of such a parameter, the new value becomes the current setting.

Common DAQ VI Parameters
The device input on analog I/O, digital I/O, and counter VIs specifies the 
number assigned to your DAQ device in the DAQ configuration software. 
Your software assigns a unique number to each DAQ device. The device 
parameter usually appears as an input to the configuration VIs. Another 
common configuration VI output, task ID, assigns your specific 
I/O operation and device a unique number that identifies it throughout 
your program flow. The task ID can also contain group information about 
the channels and gain used in your operation.

Some DAQ VIs perform either the device configuration or the 
I/O operation, while other DAQ VIs perform both configuration and the 
operation. The VIs that handle both functions have an iteration input. 
When your VI has the iteration set to 0, LabVIEW configures the 
DAQ device and then performs the specific I/O operation. For iteration 
values greater than 0, LabVIEW uses the existing configuration to perform 
the I/O operation. You can improve the performance of your application 
by not configuring the DAQ device every time an I/O operation occurs. 
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Typically, you should wire the iteration  input to an iteration terminal in a 
loop as shown in the following illustration.

Wiring the iteration input this way means the device is only configured
on the first I/O operation. Subsequent I/O operations use the existing 
configuration.

Error Handling
Each Easy VI contains an error handling VI. A dialog box appears 
immediately if an error occurs in an Easy VI.

Every Intermediate and Advanced VI contains an error in  input cluster and 
an error out  output cluster, as shown in Figure 3-5. The clusters contai
Boolean that indicates whether an error occurred, the code for the error, and 
source or the name of the VI that returned the error. If error in  indicates an 
error, the VI passes the error information to error out  and does not execute
any DAQ functions.
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Figure 3-5.  LabVIEW Error In Input and Error Out Output Error Clusters

For more information on error handling, refer to Part VII, Debugging Your 
Data Acquisition Application, in this manual.

Channel, Port, and Counter Addressing
The Analog Input and Analog Output VIs have a channel list parameter 
where you can specify the channels from which the VIs read or to whi
they write. The Digital Input and Output VIs have a similar parameter, 
called digital channel list and the equivalent value is called counter list 
for the Counter VI’s. For ease of understanding of channel addressing
concepts, the channel list, digital channel list, and counter list parameters 
are referred to as channel list in this section. Any special exceptions for 
these parameters will be noted.

Each channel you specify in the channel list becomes a member of a group
For each group, you can acquire or generate data on the channels list
the group. VIs scan (during acquisition) or update (during generation) 
channels in the same order they are listed. To erase a group, pass an 
channel list and the group number to the VI or assign a new channel list 
to the group. Changing groups can only be done at the Advanced VI le
Refer to the LabVIEW Function and VI Reference Manual or the LabVIEW 
Online Reference, by selecting Help»Online Reference..., for more 
information.
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Channel Name Addressing
If you use the DAQ Channel Wizard to configure your analog and digit
channels, you can address your channels by name in the channel list 
parameter in LabVIEW. channel list can be an array of strings or, as with
the Easy VIs, a scalar string control, as shown in Figure 3-6. If you hav
channel list array, you can use one channel entry per array element, spe
the entire list in a single element, or use any combination of these two
If you enter multiple channel names in channel list, all of the channels in 
the list must be configured for the same DAQ Device. If you configure
channels with names of temperature  and pressure , both of which are 
measured by the same DAQ Device, you can specify a list of channel
in a single element by separating them by commas—for example 
temperature,pressure . In specifying channel names, spelling and 
spaces are important, but case is not.

Figure 3-6.  Channel String Controls

Using channel names, you do not need to wire the device, input limits , 
or input config input parameters. The device input is always ignored 
by LabVIEW when using channel names. LabVIEW configures your 
hardware in terms of your channel configuration. Unless you need to 
overwrite your channel name configuration, do not wire input limits  or 
input config; allow LabVIEW to set them up for you. In addition, 
LabVIEW orders and pads the channels specified in channel list for you 
as needed according to any special device requirements.

Channel Number Addressing
If you are not using channel names to address your channels, you can
address your channels by channel numbers in the channel list parameter. 
The channel list can be an array of strings or, as with the Easy VIs, a 
scalar string control. If you have a channel list array, you can use one 
channel entry per array element, specify the entire list in a single elem
or use any combination of these two methods. For instance, if 0, 1, and 2 
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are your channels, you can specify a list of channels in a single element by 
separating the individual channels by commas—for example, 0, 1, 2 . 
Or, because 0 refers to the first channel in a consecutive channel range and 
2 refers to the last channel, you can specify the range by separating the first
and last channels with a colon—for example, 0:2 .

Some Easy and Advanced Digital VIs and Intermediate Counter VIs only
need one port or counter to be specified. For more information, refer to the 
LabVIEW Function and VI Reference Manual or the LabVIEW Online 
Reference. Choose Help»Show Help and put your cursor on the VI to view 
the VI Help window for the VI you intend to use.

LabVIEW recognizes three types of analog channels on a DAQ device: 
onboard, AMUX -64T, and SCXI channels. It recognizes two types of 
digital ports and counters: onboard and SCXI. This section describes 
addressing onboard channels, ports, and counters. AMUX-64T 
addressing is described later in Chapter 5, Things You Should Know 
about Analog Input. SCXI channel, port, and counter addressing is 
described in Chapter 18, Things You Should Know about SCXI . 

Onboard channels refer to analog or digital I/O channels provided by the 
plug-in DAQ device. If x  is an onboard channel, you can specify this by 
entering x  or OBx as the channel list element. Refer to the description of 
your device in your hardware user manual for restrictions on channel order. 
Figure 3-7 shows several ways you can address onboard channels 0, 1, and 
2. The top three examples apply to VIs whose channel parameters are str
arrays. The bottom two examples apply to VIs whose channel parameters 
are scalar strings.

Figure 3-7.  Channel String Array Controls
© National Instruments Corporation 3-11 LabVIEW Data Acquisition Basics Manual
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Note Refer to Appendix B, Hardware Capabilities, in the LabVIEW Function and VI 
Reference Manual for the number of channels your device can acquire data from
at one time, or refer to the LabVIEW Online Reference, by selecting Help»Online 
Reference....

Limit Settings 
Limit settings are the maximum and minimum values of the analog 
signal(s) you are measuring or generating. The pair of limit setting val
can be unique for each analog input or output channel. For analog inp
applications, the limit setting values must be within the range for the 
device. For more information on the range for your device, refer to 
Chapter 5, Things You Should Know about Analog Input.

Each pair of limit setting values forms a cluster. (Analog output limits ha
a third member, the reference source; but, for simplicity, LabVIEW refe
to limit settings as a pair of values.) LabVIEW uses an array of these 
clusters to assign limits to the channels in your channel string array.

If you use the DAQ Channel Wizard to configure your analog input 
channels, the unit applied to the limit settings is the physical unit you 
specified for a particular channel name in the DAQ Channel Wizard. F
example, if you configured a channel in the DAQ Channel Wizard to ha
physical units of Deg C , the limit settings are treated as limits in degree
Celsius. LabVIEW configures your hardware to make the measuremen
terms of your channel name configuration. Unless you need to overwr
your channel name configuration, do not wire this input; allow LabVIEW
to set it up for you.

If you are not using the DAQ Channel Wizard, the default unit applied 
the limit settings is usually volts, although the unit applied to the limit 
settings may be volts, current, resistance, or frequency, depending on
capability and configuration of your device.

The default range of the device, set in the configuration utility or by 
LabVIEW according to the channel name configuration in the DAQ 
Channel Wizard, is used whenever you leave the limit settings termina
unwired or you enter 0 for your upper and lower limits.

As the previous Channel, Port, and Counter Addressing section explains, 
LabVIEW uses an array of strings to specify which channels belong to
group. Also, remember LabVIEW lists as few as one channel to as man
all of the device’s channels in a single array element in the channel string 
array. LabVIEW also assigns all the channels listed in a channel string 
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array element the same settings in the corresponding limit settings cluster 
array element. Figure 3-8 illustrates one case of this.

Figure 3-8.  Limit Settings, Case 1

In this example, channels 0:3  (or 0, 1, 2, and 3) are assigned limits of 
10.00  to –10.00 . Channel 4 has limits of 5.00  to –5.00 . Channels 5, 6, 
and 7 have limit settings of 1.00 to 0.00 . 

If the limit settings cluster array has fewer elements than the channel 
string array, LabVIEW assigns any remaining channels the limit setting
contained in the last entry of the limit settings cluster array. Figure 3-9 
illustrates this case.

Figure 3-9.  Limit Settings, Case 2

In this example, channels 0, 1, 2, and 3 have limits of 10.00  to –10.00 . 
There are more channels left, but the limit settings cluster array is 
exhausted. Therefore, the remaining channels (4, 5, 6, and 7) are also
assigned limits of 10.00  to –10.00 . 

The Easy Analog Input VIs have only one pair of input limits. This pair
forms a single cluster element. If you specify the default limit settings,
channels scanned with these VIs will have identical limit settings. The E
Analog Output VIs do not have limit settings. All the Intermediate VIs, 
both analog input and output, have the channel string array and the limit 
settings (or input limits ) cluster array on the same VI. Assignment of 
limits to channels works exactly as described above. Refer to the LabVIEW 
© National Instruments Corporation 3-13 LabVIEW Data Acquisition Basics Manual
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Function and VI Reference Manual for more information on how to assign 
limit settings to a particular analog channel using the Advanced VIs, the 
Group Config VI and the Hardware Config VI, or refer to the LabVIEW 
Online Reference, by selecting Help»Online Reference....

In analog applications, you not only specify the range of the signal, you 
must also specify the range and the polarity of the device. A unipolar range 
is a range containing either positive or negative values, but never both. 
A bipolar range is a range that has both positive and negative values. 
When a device uses jumpers or dip switches to select its range and polarity, 
you must enter the correct jumper setting in the configuration utility.

In DAQ hardware manuals and in the configuration utilit y, you may find 
reference to the concept of gain. Gain is the amplification or attenuation 
of a signal. Most National Instruments DAQ devices have programmable 
gains (no jumpers), but some SCXI modules require the use of jumpers 
or dip switches. For all DAQ devices used with LabVIEW, the gain is 
determined by limit settings. However, for some SCXI modules, you must 
enter the gain in the configuration utility.

Data Organization for Analog Applications
If you acquire data from more than one channel multiple times, the data is 
returned as a two-dimensional (2D) array. If you were to create a 2D array 
and label the index selectors on a LabVIEW front panel, the array might 
look like Figure 3-10.

Figure 3-10.  Example of a Basic 2D Array

The two vertically-arranged boxes on the left are the row and column index 
selectors for the array. The top index selects a row and the bottom index 
selects a column.

You can organize data for a 2D array in one of two ways. First, you can 
organize the data by rows. If the array contained data from analog input 
channels, this would mean that each row holds data from one channel. 
Selecting a row selects a channel. Selecting a column selects a scan of data. 
This ordering method is often referred to as row major order. When you 
create data in a nested For Loop, the inner loop creates a row for each 
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iteration of the outer loop. If you were to label your index selectors for 
row major 2D array, the array might look like Figure 3-11.

Figure 3-11.  2D Array in Row Major Order

You also can organize 2D array data by columns. The Analog Input VI
LabVIEW organize their data in this way. Each column holds data from o
channel, so selecting a column selects a channel. Selecting a row sele
a scan of data. This ordering method is often called column major order. 
If you were to label your index selectors for a column major 2D array, 
array might look like Figure 3-12.

Figure 3-12.  2D Array in Column Major Order

To graph a column major order 2D array, you must configure the wavefo
chart or graph to treat the data as transposed by turning on this option i
graph pop-up menu. 

Note This option appears in gray until you wire the 2D array to a graph. To convert 
the data to row major order, select Functions»Array & Cluster»Transpose 
2D Array .

If you want to extract a single channel from a column major 2D array, 
use the Index Array function from Functions»Array & Cluster . Add a 
dimension so that you have two black rectangles in the lower left corn
The top rectangle selects the row and the bottom rectangle selects the
column. Popup on the row rectangle and select Disable Indexing. Now, 
when you select a column (or channel) by wiring your selection to the 
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bottom rectangle, the Index Array function produces the entire column
data as a 1D array, as shown in Figure 3-13.

Figure 3-13.  Extracting a Single Channel from a Column Major 2D Array

Analog output buffers that contain data for more than one channel are 
column major 2D arrays. To create such an array, first make the data f
each output channel a 1D array. Then select the Build Array function fr
Functions»Array & Cluster . Add as many input terminals (rows) to the
Build Array terminal as you have channels of data. Wire each 1D array
the Build Array terminal to combine these arrays into a single row maj
2D array. Then use the Transpose 2D Array function to convert the arra
a column major array. The finished array is ready for the AO Write VI, 
shown in Figure 3-14.

Figure 3-14.  Analog Output Buffer 2D Array

Now that you have read some basic LabVIEW DAQ concepts, you can
to the section(s) that describe your specific application. For informatio
about how you can answer questions about your application to narrow
down where you should go next for help in this manual, refer to Chapte
Where You Should Go Next. 
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Where You Should Go Next

This chapter directs you to the chapter in the manual best suited to an
questions about your data acquisition application. You answer a serie
questions that help determine the purpose of your application. The 
questions start very broad and narrow in scope until you are referred t
specific section in the manual dealing with your type of application. 

Note This manual is divided into parts. You always should read the Things You Should 
Know about chapter at the beginning of each part specific to your application. Th
Things You Should Know about chapters teach you about basic concepts dealing
with your application.

Use the following flowchart as a guide as you answer the questions th
follow it. The questions should pinpoint the sections in the manual that 
should read for your particular application.
on Basics Manual



Chapter 4 Where You Should Go Next
Type of
Measuring Device?

Analyzing
Analog or Digital

Signals?

Signal Acquisition
or Generation?

Digital or
Counter Interfacing?

Single-Point
or Multiple-Point

Generation?

Single-Point
or Multiple-Point

Acquisition?

Using an Internal
or External Clock?

Triggering a Signal?

Latched or
Non-Latched Digital

I/O?

Plug-in DAQ Device Only SCXI

Analog Digital

Digital Counter

Latched Non-Latched

Acquisition Generation

Single Multiple

Internal External

Single

Yes No

Read about the DAQ Channel Wizard
in Chapters 2 and 3, and Section 5,

SCXI–Getting
Your Signals in Great Condition.

Read Chapter 23, Things You 
Should Know about Counters.

Read Chapter 17, Shaking Hands
with a Digital Partner.

Read Chapter 6, One-Stop
Single-Point Acquisition.

Read Chapter 8, Controlling
 Your Acquisition with Triggers.

Read Chapter 7, BufferingYour 
Way Through Waveform Acquisition.

Read Chapter 9, Letting an Outside
Source Control Your Acquisition Rate.

Read Chapter 11, One-Stop
Single-Point Generation.

Multiple

Read Chapter 12, Buffering Your
Way through Waveform Generation.

Read Chapter 16, When You Need
It Now–Immediate Digital I/O.

Read Chapter 24, Generating a 
Square Pulse or Pulse Train.

Read Chapter 25, Measuring
Pulse Width.

Read Chapter 26, Measuring 
Frequency and Period.

Read Chapter 27, Counting Signal 
Highs and Lows.

Read Chapter 28,
Dividing Frequencies.

Both

Read Chapter 14, Simultaneous Buffered 
Waveform Acquisition and Generation.

Internal or
External?

Internal

Read Chapter 13, Letting an Outside 
Source Control Your Update Rate.

External
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Questions You Should Answer
1. Measuring Device: DAQ Device or SCXI Module?
Are you working in a noisy environment? If you are, then you may hav
Signal Conditioning eXtensions for Instrumentation (SCXI) modules 
connected to your DAQ device or the parallel port of your computer. 
SCXI modules can filter and isolate noise from signals. They can also
amplify low signals. SCXI modules expand the number of channels to
acquire or generate data. 

DAQ devices are primarily used alone when extra signal conditioning is
necessary. 

If you are using a DAQ device, then read question 2. If you are using SC
go to Part V, SCXI—Getting Your Signals in Great Condition.

2. Analog or Digital Signal Analysis?
Does your signal have two discrete values that are TTL signals? If so, 
you have a digital signal. Otherwise, you have an analog signal. The t
of information you would need to know from an analog signal is the lev
(discrete value), shape, and frequency content.

Analog or Digital Signal Acquisition or Generation?
If you want to measure and analyze signals from a source outside the
computer, you want to acquire signals. If you want to send signals to an 
outside instrument to control its operation, then you want to generate 
signals.

If you want to acquire analog signals, go to question 4. If you want to 
generate analog signals, refer to question 5. If you want to acquire and
generate analog signals, refer to the Using Analog Input/Output Control 
Loops section of Chapter 6, One-Stop Single-Point Acquisition.

If you want to acquire or generate digital signals, read the next question.

3. Digital or Counter Interfacing?
Digital I/O interfaces primarily with binary operations, such as turning 
external equipment on or off or sense logic states, such as the on/off 
position of the switch. Counters generate individual digital pulses or wa
or count digital events, like how many times a digital signal rises or fal
in value.

If you are performing digital I/O, refer to question 7. If you need to use
counters, read question 8. 
© National Instruments Corporation 4-3 LabVIEW Data Acquisition Basics Manual
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4. Single-Point or Multiple-Point Acquisition?
Do you want to acquire a signal value(s) at one time or over a period o
time at a certain rate? If you measure a signal at a given instant of tim
you are performing single-point acquisition. If you measure signals over a
period of time at a certain rate, then you are performing multiple-point or 
waveform acquisition.

If you want single-point acquisition, refer to Chapter 6, One-Stop 
Single-Point Acquisition. If you want multiple-point acquisition, read 
question 6.

5. Single-Point or Multiple-Point Generation?
Are you outputting a steady (DC) signal or are you generating a chang
signal at a certain rate? A constant or slowly-changing signal output is
called single-point generation. The output of a changing signal at a certa
rate is called multiple-point or waveform generation.

If you want to perform single-point generation, refer to Chapter 11, 
One-Stop Single-Point Generation. If you want multiple point generation, 
refer to Chapter 12, Buffering Your Way through Waveform Generation.

6. Triggering a Signal or Using a Clock?
You can start an analog acquisition when a certain analog or digital va
occurs by triggering the acquisition.

If you want to trigger an analog acquisition, refer to Chapter 8, Controlling 
Your Acquisition with Triggers.

Multiple-Point Acquisition with an Internal or External Clock?
Multiple point or waveform acquisition can be done at a rate set by an
internal DAQ device clock or an external clock. The external clock will 
a TTL signal produced at a certain rate.

If you want to acquire a waveform at the rate of an external signal, refe
Chapter 9, Letting an Outside Source Control Your Acquisition Rate. If not, 
read Chapter 7, Buffering Your Way through Waveform Acquisition.
LabVIEW Data Acquisition Basics Manual 4-4 © National Instruments Corporation
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7. Non-Latched or Latched Digital I/O?
If you want your program to read the latest digital input or immediately
write a new digital output value, you should use non-latched (immedia
digital I/O. When a DAQ device accepts or transfers data after a digita
pulse has been received, it is called latched (handshaked) digital I/O. W
latched digital I/O, you can store the values you want to transfer in a bu
Only one value will be transferred after each handshaked pulse.

If you want to use non-latched (immediate) digital I/O, refer to Chapter
When You Need It Now— Immediate Digital I/O. If you need to perform 
latched (handshaked) digital I/O, refer to Chapter 17, Shaking Hands with 
a Digital Partner.

8. Counters: Counting or Generating Digital Pulses?
If you want to generate digital pulses from a counter at a certain rate, 
Chapter 24, Generating a Square Pulse or Pulse Trains. If you want to 
measure the width of a digital pulse, refer to Chapter 25, Measuring Pulse 
Width. If you want to measure the frequency or period of a digital signa
refer to Chapter 26, Measuring Frequency and Period. If you just want to 
count how many times a digital signal rises or falls, refer to Chapter 27
Counting Signal Highs and Lows. To learn how to slow the frequency of a
digital signal, refer to Chapter 28, Dividing Frequencies. 
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Catching the Wave with Analog Input

This section contains basic information about acquiring data with 
LabVIEW, including acquiring a single point or multiple points, 
triggering your acquisition, and using outside sources to control 
acquisition rates.

Part II, Catching the Wave with Analog Input, contains the following 
chapters:

• Chapter 5, Things You Should Know about Analog Input, explains 
basic concepts on using analog input with LabVIEW.

• Chapter 6, One-Stop Single-Point Acquisition, shows you how to 
acquire one data point from a single channel and then one data p
from each of several channels using LabVIEW, and explains how 
software-timing and/or hardware-timing affects the performance o
analog I/O.

• Chapter 7, Buffering Your Way through Waveform Acquisition, 
reviews the different methods of reading multiple channels and 
explains how LabVIEW stores the acquired data with each method

• Chapter 8, Controlling Your Acquisition with Triggers, explains how 
to set your analog acquisition to occur at a certain time using eithe
software or hardware triggering methods.

• Chapter 9, Letting an Outside Source Control Your Acquisition Rat, 
shows you how to control your data acquisition rate by some othe
external source in your system.



© National Instruments Corporation 5-1 LabVIEW Data Acquisiti
5

 
. 
e 

e 

u 
ust 

r 
ged 
s 

 
to 

ain, 
k 

 my 
s of 
Things You Should Know 
about Analog Input

Hunting has been a part of survival from the beginning of time. People
used to hunt for the things they needed to survive, like food and water
Today, engineers and scientists use data acquisition to “hunt down” th
information they need to survive in the information age. This chapter 
focuses on defining the tools you need to be a successful hunter in th
world of data acquisition.

Defining Your Signal
You and your friends plan a hunting trip for this weekend. What do yo
plan to bring with you? This question is really not valid, because you m
know first what you will be hunting before you pack your fishing pole o
elephant rifle. The same idea applies to scientists and engineers enga
in the quest for information. You must know the defining characteristic
of what you want to “hunt,” be it a wild animal or an analog signal. 
You cannot just say, “I will hunt voltages,” or even “I will hunt analog 
voltages.” Voltages come in various forms. This chapter gives you the
terms, tools, and techniques designed to help show you the best way 
catch your wave.

You can break down analog signals into three categories: DC, time dom
and frequency domain. You must ask yourself, “Is the information I see
primarily contained in the level, the shape, or the frequency content of
signal?” Figure 5-1 illustrates which signals correspond to certain type
signal information.

Figure 5-1.  Types of Analog Signals

Analog Signal Time Domain

Frequency Domain

DC ADC/DAC
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You might be saying to yourself, “I know that I have a thermocouple an
that the primary information (temperature) is contained in the level of t
analog voltage. Now I am ready to go hunting!” Well, you are almost ready 
to hunt, but you first must figure out a few more signal characteristics 
before you can begin. For example, to what is your signal referenced? H
fast does the signal vary with time? The rate you sample determines h
often the A/D conversions take place. A fast sampling rate acquires m
points in a given time, and therefore can often form a better representa
of the original signal than a slow sampling rate. According to the Nyqu
Theorem, you must sample at a rate greater than twice the maximum 
frequency component in that signal to get accurate frequency informa
about that signal. The frequency at one half the sampling frequency is
referred to as the Nyquist frequency. For more information on the Nyquist
frequency, refer to the section Sampling Considerations in Chapter 11, 
Introduction to Analysis in LabVIEW of the LabVIEW User Manual.

What Is Your Signal Referenced To?
Signals come in two forms: referenced and non-referenced signal sources. 
More often, referenced sources are said to be grounded signals, and 
non-referenced sources are called floating signals.

Grounded Signal Sources
Grounded signal sources have voltage signals that are referenced to a
system ground, such as earth or a building ground. Devices that plug in
building ground through wall outlets, such as signal generators and po
supplies, are the most common examples of grounded signal sources
shown in Figure 5-2.

Figure 5-2.  Grounded Signal Sources
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Floating Signal Sources
Floating signal sources contain a signal, such as a voltage, that is not
connected to an absolute reference, such as earth or a building groun
Some common examples of floating signals are batteries, battery-pow
sources, thermocouples, transformers, isolation amplifiers, and any 
instrument that explicitly floats its output signal. Notice that in Figure 5
neither terminal of the floating source is connected to the electrical ou
ground.

Figure 5-3.  Floating Signal Sources

Now that you know how your signal is referenced, read on to learn abo
the different systems available to acquire these signals.
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Choosing Your Measurement System
Now that you have defined your signal, you must choose a measurem
system. You have an analog signal, so you must convert the signal wit
ADC measurement system, which converts your signal into informatio
the computer can understand. Some of the issues you must resolve b
choosing a measurement system are your ADC bit resolution, device ra
and signal range. 

Resolution
The number of bits used to represent an analog signal determines the
resolution of the ADC. You can compare the resolution on a DAQ devi
to the marks on a ruler. The more marks you have, the more precise y
measurements. Similarly, the higher the resolution, the higher the num
of divisions into which your system can break down the ADC range, a
therefore, the smaller the detectable change. A 3-bit ADC divides the 
range into 23 or 8 divisions. A binary or digital code between 000 and 11
represents each division. The ADC translates each measurement of th
analog signal to one of the digital divisions. Figure 5-4 shows a sine w
digital image as obtained by a 3-bit ADC. Clearly, the digital signal do
not represent the original signal adequately, because the converter ha
few digital divisions to represent the varying voltages of the analog sig
By increasing the resolution to 16 bits, however, the ADC’s number of
divisions increases from 8 to 65,536 (216). The ADC can now obtain an 
extremely accurate representation of the analog signal.

Figure 5-4.  The Effects of Resolution on ADC Precision
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Device Range
Range refers to the minimum and maximum analog signal levels that 
ADC can digitize. Many DAQ devices feature selectable ranges, so you
match the ADC range to that of the signal to take best advantage of th
available resolution. For example, in Figure 5-5, the 3-bit ADC, as sho
in the left chart, has eight digital divisions in the range from 0 to 10 vo
If you select a range of –10.00  to 10.00  volts, as shown in the right chart,
the same ADC now separates a 20 volt range into eight divisions. The
smallest detectable voltage increases from 1.25  to 2.50  volts, and you 
now have a much less accurate representation of the signal.

Figure 5-5.  The Effects of Range on ADC Precision
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Signal Limit Settings
Limit settings are the maximum and minimum values of the signal you 
measuring. A more precise limit setting allows the ADC to use more 
digital divisions to represent the signal. Figure 5-6 shows an example 
this theory. Using a 3-bit ADC and a device range setting of 0.00  to 
10.00 volts, Figure 5-6 shows the effects of a limit setting between 0 a
5 volts and 0 and 10 volts. With a limit setting of 0 to 10 volts, the ADC
uses only four of the eight divisions in the conversion. But using a limi
setting of 0 to 5 volts, the ADC now has access to all eight digital divisio
This makes the digital representation of the signal more accurate.

Figure 5-6.  The Effects of Limit Settings on ADC Precision
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Considerations for Selecting Analog Input Settings
The resolution and device range of a DAQ device determine the small
detectable change in the input signal. You can calculate the smallest 
detectable change, called the code width, using the following formula.

For example, a 12-bit DAQ device with a 0 to 10 V input range detects
2.4 mV change, while the same device with a –10 to 10 V input range
detects only a change of 4.8 mV.

A high resolution A/D converter provides a smaller code width given a
device voltage ranges shown above.

The smaller your code width, the more accurate your measurements 
will be.

There are times you must know whether your signals are unipolar or 
bipolar. Unipolar signals are signals that range from 0 value to a posit
value (i.e., 0 to 5 V). Bipolar signals are signals that range from a nega
to a positive value (i.e., –5 to 5 V). To achieve a smaller code width if 
your signal is unipolar, specify that the device range is unipolar, as sho
previously. If your signal range is smaller than the device range, you sho
set your limit settings to values that more accurately reflect your signa
range. Table 5-1 shows how the code width of the 12-bit DAQ devices v
with device ranges and limit settings, because your limit settings 
automatically adjust the gain on your device.

codewidth device range

2resolution
----------------------------------=

device range

2resolution
---------------------------------- 10

212
------- 2.4 mV==

device range

2resolution
----------------------------------  

20

212
------- 4.8 mV==

device range

2resolution
----------------------------------  10

216
------- .15 mV==

device range

2resolution
----------------------------------  20

216
------- .3 mV==
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For more information on the device range and limit settings for your dev
refer to the tables in Appendix B, Hardware Capabilities, in the LabVIEW 
Function and VI Reference Manual, or to the LabVIEW Online Reference, 
available by selecting Help»Online Reference…. In these tables, there is
information on gain settings for each device. For more information on ga
refer to the Limit Settings section of Chapter 3, Basic LabVIEW Data 
Acquisition Concepts.

Now that you know which kind of ADC to use and what settings to use
for your signal, you can connect your signals to be measured. On mos
DAQ devices, there are three different ways to configure your device t
read the signals: Differential, Referenced Single-Ended (RSE), and 
Non-Referenced Single-Ended (NRSE).

Table 5-1.  Measurement Precision for Various Device Ranges and Limit Settings

Device Voltage Range Limit Settings Precision1

0 to 10V 0 to 10 V
0 to 5 V
0 to 2.5 V
0 to 1.25 V
0 to 1 V
0 to 0.1 V
0mV to 20 mV

2.44mV
1.22 mV
610 µV
305 µV
244 µV
24.4 µV
4.88 µV

–5 to 5V –5 to 5V
–2.5 to 2.5 V
–1.25 to 1.25 V
–0.625 to 0.625 V
–0.5 to 0.5 V
–50mV to 50 mV
–10mV to 10 mV

2.44 mV
1.22 mV
610 µV
305 µV
244 µV
24.4 µV
4.88 µV

–10 to 10V –10 to 10 V
–5 to 5 V
–2.5 to 2.5 V
–1.25 to 1.25 V
–1 to 1 V
–0.1 to 0.1 V
–20mV to 20 mV

4.88 mV
2.44 mV
1.22 mV
610 µV
488 µV
48.8 µV
9.76 µV

1The value of 1 LSB of the 12-bit ADC. In other words, the voltage increment correspond
to a change of 1 count in the ADC 12-bit count.
LabVIEW Data Acquisition Basics Manual 5-8 © National Instruments Corporation
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Differential Measurement System
In a differential measurement system, you do not need to connect eith
input to a fixed reference, such as earth or a building ground. DAQ dev
with instrumentation amplifiers can be configured as differential 
measurement systems. Figure 5-7 depicts the 8-channel differential 
measurement system used in the MIO series devices. Analog multiple
increase the number of measurement channels while still using a sing
instrumentation amplifier. For this device, the pin labeled AIGND 
(the analog input ground) is the measurement system ground.

Figure 5-7.  8-Channel Differential Measurement System

+

+

CH0–

CH2–

CH1–

CH7–

CH0+

CH2+

CH1+

CH7+

MUX

MUX

Vm

Instrumentation Amplifier

AIGND

–

–
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In general, a differential measurement system is preferable because it
rejects not only ground loop-induced errors, but also the noise picked u
the environment to a certain degree. Use differential measurement sys
when all input signals meet the following criteria:

• Low-level signals (i.e., less than 1 V)

• Long or non-shielded cabling/wiring traveling through a noisy 
environment 

• Any of the input signals require a separate ground-reference poin
return signal

An ideal differential measurement system reads only the potential 
difference between its two terminals—the (+) and (–) inputs. Any 
voltage present at the instrumentation amplifier inputs with respect to 
amplifier ground is called a common-mode voltage. An ideal differential 
measurement system completely rejects (does not measure) common-
voltage, as shown in Figure 5-8.

Figure 5-8.  Common-Mode Voltage

While a differential measurement system is often the best choice, a 
single-ended configuration uses twice as many measurement channe
A single-ended measurement system is acceptable when the magnitu
the induced errors is smaller than the required accuracy of the data.

+

+
+
–

+

Vs

Vcm

Instrumentation Amplifier

Measured Voltage
Grounded Signal Source

Common Mode Voltage,
Ground Potential, Noise, etc. –

– –
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Referenced Single-Ended Measurement System
A referenced single-ended (RSE) measurement system, is used to me
a floating signal, because it grounds the signal with respect to building
ground. Figure 5-9 depicts a 16-channel RSE measurement system. Y
only should use this measurement system when you need a single-en
system and your device does not work with nonreferenced single-end
measurement.

Figure 5-9.  16-Channel RSE Measurement System

Nonreferenced Single-Ended Measurement System
DAQ devices often use a variant of the RSE measurement technique,
known as the nonreferenced single-ended (NRSE) measurement syste
an NRSE measurement system, all measurements are made with resp
a common reference, because all of the input signals are already groun

+

+

CH0

CH2

CH1

CH15

MUX

Vm

Instrumentation Amplifier

AIGND

–

–
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Figure 5-10 depicts an NRSE measurement system where AISENSE i
common reference for taking measurements and AIGND is the system
ground. All signals must share a common reference at AISENSE.

Figure 5-10.  16-Channel NRSE Measurement System

In general, a differential measurement system is preferable because it
rejects not only ground loop-induced errors, but also the noise picked u
the environment to a certain degree. On the other hand, the single-en
configuration allows for twice as many measurement channels and is 
acceptable when the magnitude of the induced errors is smaller than t
required accuracy of the data. You can use single-ended measuremen
systems when all input signals meet the following criteria:

• High Level Signals (normally, greater than 1 V)

• Short or Properly-Shielded Cabling/Wiring Traveling through a 
Noise-Free Environment (normally, less than 15 ft.)

• All Signals Can Share a Common Reference Signal at the Source

Use differential connections when your system violates any of the abo
criteria.

+

+

CH0+

CH1+

CH2+

CH15+

MUX

Vm

Instrumentation Amplifier

AISENSE

AIGND

–

–

LabVIEW Data Acquisition Basics Manual 5-12 © National Instruments Corporation



Chapter 5 Things You Should Know about Analog Input

ress 

r, 
ng 

 

ty 
Channel Addressing with the AMUX-64T
An AMUX-64T external multiplexer device expands the number of 
analog input signals a plug-in DAQ device can measure. You can add
AMUX-64T channels when you attach one, two, or four AMUX-64T 
devices to a plug-in DAQ device. With this device, you can multiplex fou
eight, or 16 AMUX-64T channels into one device channel. The scanni
order of these AMUX-64T channels is fixed. To specify a range of 
AMUX-64T channels, enter the device channel into which the range is
multiplexed in the channel list. For example, if you have no AMUX-64T 
devices, a channel list element of 0 specifies device channel 0. If you have 
a AMUX-64T device, a channel list element of 0 specifies channels 0 
through 3 on each AMUX-64T device. Table 5-2 shows the number of 
channels available on a DAQ device with an external multiplexer.

You specify the number of AMUX devices through the configuration utili
or the AI Hardware Config VI. Refer to the LabVIEW Function and VI 
Reference Manual or the LabVIEW Online Reference, available by 
selecting Help»Online Reference…, for more information on this VI.

Table 5-2.  Analog Input Channel Range

Number of 
AMUX-64Ts

Channel Range 
(Single-Ended)

Channel Range 
(Differential)

0 0 through 15 0 through 7

1 AM1!0  through AM1!63 AM1!0  through AM1!31

2 AM1!0  through AM1!63 ,
AM2!0  through AM2!63

AM1!0  through 
AM1!31 , 
AM2!0  through AM2!31

4 AM1!0  through AM1!63 , 
AM2!0  through AM2!63 , 
AM3!0  through AM3!63 , 
AM4!0  through AM4!63

AM1!0  through 
AM1!31 , 
AM2!0  through 
AM2!31 , 
AM3!0  through 
AM3!31 , 
AM4!0  through AM4!31
© National Instruments Corporation 5-13 LabVIEW Data Acquisition Basics Manual
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The AMUX-64T Scanning Order
This section explains how LabVIEW scans channels from the AMUX-64
You must know this scanning order so that you can determine which an
input channel LabVIEW scanned during a data acquisition operation.

The scanning counters on the AMUX-64T and on the DAQ device 
perform automatic scanning of the AMUX-64T analog input channels. 
When you perform a multiple-channel scanned data acquisition with a
AMUX-64T, a counter on the DAQ device switches the DAQ device 
multiplexers.

When you connect a single AMUX-64T device to the DAQ device, you
must scan four AMUX-64T input channels for every DAQ device chann
If you attach two AMUX-64T devices to the DAQ device, LabVIEW 
scans eight AMUX-64T channels for every DAQ device input channel.
For example, assume that channels 0 through 3 on AMUX-64T device
and channels 0 through 3 on AMUX-64T device 2 are multiplexed toget
into DAQ device channel 0. In this case, LabVIEW scans the first four 
channels on AMUX-64T device 1, followed by the first four channels o
AMUX-64T device 2.

If you attach four AMUX-64T devices to the DAQ device, LabVIEW 
scans 16 AMUX-64T channels for every DAQ device input channel. 
For example, channels 0 through 3 on AMUX-64T device 1, 2, 3, and 4
multiplexed together into DAQ device channel 0. In this case, LabVIEW
scans the first four channels on device 1, followed by the first four chann
on device 2, the first four channels on device 3, and then the first four 
channels on device 4.

The order in which LabVIEW scans channels depends on the channel
you specify in the AI Group Config VI. You specify this channel list as 
an array of DAQ device channel numbers indicating the order in which
LabVIEW scans the DAQ device channels. When scanning multiple 
channels, list only the device channels—not the AMUX-64T channels.
(You only use the AMy!x  syntax in your channel list when you sample 
a single AMUX-64T channel.) LabVIEW then scans four, eight, or 
16 channels for every device channel for one, two, or four AMUX-64T 
devices, respectively. However, the AMUX-64T has a fixed scanning ord
LabVIEW Data Acquisition Basics Manual 5-14 © National Instruments Corporation
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Table 5-3 shows the order in which LabVIEW scans the AMUX-64T 
channels for every DAQ device input channel when you use one or tw
AMUX-64T devices. Table 5-3 shows the order in which LabVIEW sca
the AMUX-64T channels for every DAQ device input channel when yo
use four AMUX-64T devices.

If you want to scan more than one AMUX-64T channel, you must enter
device channels in your scan list.

 
Table 5-3.  Scanning Order for Each DAQ Device Input Channel 

with One or Two AMUX-64Ts

DAQ
Device 

Channel

AMUX-64T Channels

One Device Two Devices

Device 1 Device 1 Device 2

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63
© National Instruments Corporation 5-15 LabVIEW Data Acquisition Basics Manual
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To determine which AMUX-64T channels LabVIEW scans and the 
scanning order, perform the following steps. 

1. Locate the channel for each DAQ device channel in your channel 
in the DAQ Device Channel column in Table 5-3 or 5-4. Start with th
first device channel and continue through the list in your specified
channel order.

2. Read from left to right along the table row where you located the 
channel number to find the AMUX-64T scanning order.

To read a single AMUX-64T channel, use channel specifier AMy!x . This 
specifier returns data from channel x  of the AMUX-64T with IDy. To read 
more than one AMUX-64T channel, use channel specifier OBx:y . This 
specifier returns data from the AMUX-64T channels that correspond to
device channel x  through device channely.

When the channel list contains a single AMUX-64T channel, you must 
also specify the number of the AMUX-64T device, as shown in the 
following table.

Table 5-4.  Scanning Order for Each DAQ Device Input Channel with Four AMUX-64Ts

DAQ 
Device 

Channel

AMUX-64T Channels

Device 1 Device 2 Device 3 Device 4

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63
LabVIEW Data Acquisition Basics Manual 5-16 © National Instruments Corporation



Chapter 5 Things You Should Know about Analog Input

el 
h 
er to 

 

 

that 

nel 

s 

le 

s 

els 
 
r 

4, 
You refer to AMUX-64T channels only when a single AMUX-64T chann
comprises the entire list. Otherwise, you refer to them indirectly throug
the device channels that you use to scan the AMUX-64T channels. Ref
Appendix B, Hardware Capabilities, of the LabVIEW Function and VI 
Reference Manual, or the LabVIEW Online Reference, available by 
selecting Help»Online Reference…, for more information on addressing
AMUX-64T channels.

Refer to the AMUX-64T User Manual for more information on the external
multiplexer device.

Important Terms You Should Know
The following are some definitions of common terms and parameters 
you should remember when acquiring your data.

• A scan is one acquisition or reading from each channel in your chan
string.

• Number of scans to acquire refers to the number of data acquisition
or readings to acquire from each channel in the channel string. 
Number of samples is the number of data points you want to samp
from each channel.

• The scan rate determines how many times per second LabVIEW 
acquires data from channels. scan rate enables interval scanning 
(a longer interval between scans than between individual channel
comprising a scan) on devices that support this feature. channel clock 
rate defines the time between the acquisition of consecutive chann
in your channel string. For more information on scan and channel
clock rates, refer to Chapter 9, Letting an Outside Source Control You
Acquisition Rate.

For specific information about the Analog Input VIs, refer to Chapter 1
Introduction to the LabVIEW Data Acquisition VIs, in the LabVIEW 
Function and VI Reference Manual, or to the LabVIEW Online Reference, 
available by selecting Help»Online Reference….

Channel List Parameter Channel Specified

AMy!x Channel x  on AMUX-64T device y. 

AM4!8 Channel 8 on AMUX-64T device 4. 
© National Instruments Corporation 5-17 LabVIEW Data Acquisition Basics Manual
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One-Stop Single-Point 
Acquisition

This chapter shows you how to acquire one data point from a single cha
and then one data point from each of several channels using LabVIEW

Single-Channel, Single-Point Analog Input
A single-channel, single-point analog input is an immediate, non-buffe
operation. In other words, the software reads one value from an input 
channel and immediately returns the value to you. This operation doe
not require any buffering or timing. You should use single-channel, 
single-point analog input when you need one data point from one chan
An example of this would be if you periodically needed to monitor the flu
level in a tank. You can connect the transducer that produces a voltag
representing the fluid level to a single channel on your DAQ device an
initiate a single-channel, single-point acquisition whenever you want to
know the fluid level.

For most basic operations, use the AI Sample Channel VI, located in 
theFunctions»DAQ»Analog Input palette. The Easy Analog Input VI, 
AI Sample Channel, measures the signal attached to the channel you
specify on your DAQ device and returns the scaled value. Figure 6-1 sh
how to wire this VI.

Figure 6-1.  AI Sample Channel VI

Note If you set up your channel in the DAQ Channel Wizard, you do not need to ent
the device or input limits. Instead, enter a channel name in the channel input, and 
the value returned is relative to the physical units you specified for that channel 
the DAQ Channel Wizard. If you specify the input limits, they are treated as bein
relative to the physical units of the channel. LabVIEW ignores the device input
when channel names are used. This principal applies throughout this manual.
on Basics Manual
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Figure 6-2 shows how you program the Acquire 1 Point from 1 Chann
VI, located in labview\examples\daq\anlogin\anlogin.llb , 
using the AI Sample Channel VI to acquire data.

Figure 6-2.  Acquiring Data Using the Acquire 1 Point from 1 Channel VI

The Acquire 1 Point from 1 Channel VI initiates an A/D conversion on t
DAQ device and returns the scaled value as an output. The high limit  is the 
highest expected level of the signals you want to measure. The low limit  is 
the lowest expected level of the signals you want to measure. If you w
to acquire multiple point from a single channel, see Chapter 7, Buffering 
Your Way through Waveform Acquisition.

Single-channel acquisition makes acquiring one channel very basic, b
what if you need to take more than one channel sample? For instance
you might need to monitor the temperature of the fluid as well as the fl
level of the tank. In this case, two transducers must be monitored. You
monitor both transducers using a multiple-channel, single-point acquisi
in LabVIEW.
LabVIEW Data Acquisition Basics Manual 6-2 © National Instruments Corporation
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Multiple-Channel Single-Point Analog Input
With a multiple-channel, single-point read (or scan), LabVIEW returns t
value on several channels at once. Use this type of operation when you
multiple transducers to monitor and you want to retrieve data from eac
transducer at the same time. Your DAQ device executes a scan across
of the specified channels and returns the values when finished. Refer 
Appendix B, Hardware Capabilities, in the LabVIEW Function and VI 
Reference Manual, for the number of channels your device can scan at o
time. You also can refer to the LabVIEW Online Reference, available by 
selecting Help»Online Reference….

The Easy I/O VI, AI Sample Channels, acquires single values from 
multiple channels. The AI Sample Channels VI performs a single A/D 
conversion on the specified channels and returns the scaled values in
1-dimensional (1D) array. The expected range for all the signals, speci
by high limit  and low limit inputs, applies to all the channels. Figure 6-3
shows how to acquire a signal from multiple channels with this VI.

Note Remember to use commas to delimit individual channels in the channel string
or use a colon to indicate an inclusive list of channels.

Figure 6-3.  Acquiring a Voltage from Multiple Channels with the AI Sample Channels VI

You can benefit from using the Easy Analog Input VIs because you on
need one icon in your diagram to perform the task, there are only a fe
basic inputs to the VIs, and the VIs have built-in error checking; howev
the lack of programming flexibility with these VIs can be a limitation. 
Because Easy VIs have only a few inputs, you cannot implement som
the more detailed features of DAQ devices, such as triggering or inter
scanning. In addition, these VIs always reconfigure at start-up. When 
need a hi-speed or efficiently-run program, these configurations can s
down processing time. When you need speed and more efficiency, us
the Intermediate VIs, which configure an acquisition only once and the
continually acquire data without ever re-configuring. The Intermediate V
© National Instruments Corporation 6-3 LabVIEW Data Acquisition Basics Manual
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also offer more error handling control, more hardware functionality, an
efficiency in developing your application than the Easy VIs. You typica
use the Intermediate VIs to perform buffered acquisitions. You can rea
more about buffered acquisitions in Chapter 7, Buffering Your Way 
through Waveform Acquisition. The Intermediate Analog Input VI, AI 
Single Scan VI, does multiple-channel, single-point acquisitions, as sho
in Figure 6-4.

Figure 6-4.  The AI Single Scan VI Help Diagram

The AI Single Scan VI returns one scan of data. You can also use this
to read only one point if you specify one channel. Use this VI only in 
conjunction with the AI Config VI. 

Figure 6-5 shows a simplified block diagram for non-buffered applicatio
LabVIEW calls the AI Config VI, which configures the channels, select
the input limits  (the high limit  and low limit inputs in the Easy VIs), and 
generates a taskID. The program passes the taskID and the error cluster to 
the AI Single Scan VI, which returns the data in an array (one point for e
channel specified).

Figure 6-5.  Using the Intermediate VIs for a Basic Non-Buffered Application

Figure 6-6 shows how you can program the AI Config and AI Single 
Scan VIs to perform a series of single scans by using software timing 
(a While Loop) and processing each scan. This example shows the 
Cont Acquire&Chart (immediate) VI, which you can find in 
labview\examples\daq\anlogin\anlogin.llb . 
LabVIEW Data Acquisition Basics Manual 6-4 © National Instruments Corporation
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The advantage to using the intermediate-level VIs is that you do not h
to configure the channels every time you want to acquire data as you 
when using the Easy VIs. To call the AI Config VI only once, put it outsi
of the While Loop in your program. The AI Config VI configures channe
selects a high/low limit, and generates a taskID. Then, the AI Config VI 
passes the taskID and error cluster into the While Loop, where LabVIEW
calls the AI Single Scan VI to retrieve a scan. The program then passe
returned data to the My Single-Scan Processing VI. With this VI, you c
program whatever processing needs your application calls for, such a
looking for a limit to be exceeded. The VI then passes the data throug
the build array function to a waveform chart for display on the front pan
The Wait Until Next ms Multiple (metronome) function controls the 
loop timing. You enter a scan rate, the application converts the value i
milliseconds and passes the converted value to the Wait Until Next ms
Multiple function. The loop then executes at the rate of scanning. The l
ends when you press the stop button or an when error occurs. Once the
finishes, the Simple Error Handler VI displays any errors that occurred
the screen.

Figure 6-6.  The Cont Acq&Chart (Immediate) VI Block Diagram

The previous examples use software-timed acquisition. With this type 
acquisition, the CPU system clock controls the rate at which you acqu
data. Your system clock can be interrupted by user interaction, so if you
not need a precise acquisition rate, use software-timed analog input.
© National Instruments Corporation 6-5 LabVIEW Data Acquisition Basics Manual
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Using Analog Input/Output Control Loops
When you want to output analog data after receiving some analog inp
data, use analog input/output (I/O) control loops. With control loops, th
process is repeated over and over again.

The single-point analog input and output VIs support several analog 
I/O control loops at once because you can acquire analog inputs from
several different channels in one scan, and write all the analog output
values with one update. You perform a single analog input call, process
analog output values for each channel and then perform a single anal
output call to update all the output channels. 

The following sections describe the two different types of analog I/O 
control loop techniques: software-timed and hardware-timed analog I/O.

Using Software-Timed Analog I/O Control Loops
With software-timed analog control loops the analog acquisition rate a
subsequent control loop rate are controlled by a software timer such a
Wait Until Next Millisecond multiple timer. The acquisition is performe
during each loop iteration when the AI Single Scan VI is called and the
control loop is executed once for each time interval. Your loop timing c
be interrupted by any user interaction, which means your acquisition ra
not as consistent as that which can be achieved through hardware-tim
control loops. Generally, if you do not need a precise acquisition rate 
your control loop, software timing is appropriate.

Besides user interaction, a large number or large-sized front panel 
indicators, like charts and graphs, affect control loop rates. Refreshing
monitor screen interrupts the system clock, which controls loop rates. 
Therefore, you should keep the number of charts and graphs to a minim
when you are using software-timed control loops.

An example of software-timed control loops is the Analog IO Control Lo
(immed) VI located in labview\examples\daq\anlog_io\

anlog_io.llb .
LabVIEW Data Acquisition Basics Manual 6-6 © National Instruments Corporation
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The following diagram shows how to perform software-timed analog I/
using the AI Read One Scan and AO Write One Update VIs.

Figure 6-7.  Software-Timed Analog I/O

The AI Read One Scan VI configures your DAQ device to acquire dat
from analog input channels 0 and 1. Once your program acquires a da
point from channels 0 and 1, it performs calculations on the data and 
outputs the results through analog output channels 0 and 1. Because 
iteration count is connected to the AI Read One Scan and AO Write O
Update VIs, the application configures the DAQ device for analog inpu
and output only on the first iteration of the loop. The loop rate as well 
the acquisition rate is specified by loop rate. The reason why the actual 
loop period is important is because user interaction affects the loop an
acquisition rate. For example, pressing the mouse button interrupts th
system clock, which controls the loop rate. If your analog acquisition r
for control loops does not need to be consistent, then use software-tim
control loops.

For more control examples, refer to the VIs located in 
examples\daq\solution\control.llb .

Using Hardware-Timed Analog I/O Control Loops
For a more precise timing of your control loops, and more precise ana
input scan rate, use hardware-timed control loops. 

An example of hardware-timed, non-buffered control loops is the Anal
IO Control Loop (hw timed) VI located in labview\examples\daq\ 

anlog_io\anlog_io.llb . 
© National Instruments Corporation 6-7 LabVIEW Data Acquisition Basics Manual
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With hardware-timed control loops, your acquisition is not interrupted 
user interaction. Hardware-timed analog input automatically places th
data in your DAQ device FIFO buffer at an interval determined by the 
analog input scan rate. You can synchronize your control loop diagram
this precise analog input scan rate by repeatedly calling the AI Single S
VI to read the oldest data in the FIFO.

The AI Single Scan VI returns as soon as the next scan has been acq
by the DAQ Device. If more than one scan is stored in the DAQ device
FIFO when the AI Single Scan VI is called, then the LabVIEW diagram
was not able to keep up with the acquisition rate. You can detect this 
monitoring the data remaining output of the AI Single Scan VI. In othe
words, you have missed at least one control loop interval. This indicat
that your software overhead is preventing you from keeping up with yo
hardware-timed loop rate. In Figure 6-8, the loop too slow Boolean 
indicator is set to TRUE whenever this occurs.

Figure 6-8.  Analog IO Control Loop (HW-Timed) VI Block Diagram

In this diagram, the AI Config VI configures the device to acquire data
channels 0 and 1. The application does not use a buffer created in CP
memory, but instead uses the DAQ device FIFO. input limits (also known 
as limit settings) affects the expected range of the input signals. For mo
information on input limits (limit settings), refer to Chapter 3, Basic 
LabVIEW Data Acquisition Concepts. The AI Start VI begins the analog 
LabVIEW Data Acquisition Basics Manual 6-8 © National Instruments Corporation
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acquisition at the loop rate (scan rate) parameter. On the first iteration o
the loop, the AI Single Scan VI reads the newest data in the FIFO. So
data may have been acquired between the execution of the AI Start an
AI Single Scan VIs. On the first iteration of the loop, the application rea
the latest data acquired between the AI Start and the AI Single Scan V
On every subsequent iteration of the loop, the application reads the ol
data in the FIFO, which is the next acquired point in the FIFO. 

If more than one value was stored in the DAQ device FIFO when you r
it, your application was not able to keep up with the control loop acquisit
and you have not responded with one control loop interval. This eventu
leads to an error condition, which makes the loops complete. After the
application completes analog acquisition and generation, then the AI C
VI clears the analog input task. 

Figure 6-8 also includes a waveform chart in the control loop. This redu
your maximum loop rate. You can speed up the maximum rate of the 
control loop by removing this graph indicator.

You easily can add other processing to your analog I/O control loop b
putting the analog input, control loop calculations and analog output in
the first frame of a sequence inside the loop, and additional processin
subsequent frames of the sequence. Keep in mind that this additional 
processing must be less than your control loop interval. Otherwise, you
not be able to keep up with your control loop rate.

Improving Control Loop Performance
There are some performance issues you should take into account if you
to have other VIs or loops execute in parallel with your hardware-time
control loop. When you call the AI Single Scan VI in a hardware-timed
control loop, the VI waits until the next scan is acquired before returnin
which means that the CPU is waiting inside the NI-DAQ driver until the
scan is acquired. Consequently, if you try to run other LabVIEW VIs o
while loops in the same diagram in parallel with your hardware-timed 
control loop, they may run more slowly or intermittently. You can redu
this problem by putting a software delay (with the Wait (ms) VI) at the e
of your loop after you write your analog output values. Your other 
LabVIEW VIs and loops can then execute during this time.

Another good technique is to poll for your analog input without waiting
in the driver. You can set the AI Single Scan VI time limit in sec to 
zero. Then, the VI reads the DAQ Device FIFO and returns immediate
regardless of whether the next scan was acquired. The AI Single Scan
scaled data output array is empty if the scan was not yet acquired. Poll 
© National Instruments Corporation 6-9 LabVIEW Data Acquisition Basics Manual
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your analog input by using a Wait (ms) or Wait Until Next ms Multiple 
function together with the AI Single Scan VI in a while loop within your
control loop diagram. Set the wait time smaller than your control loop 
interval (at least half as small). If the scaled data output array is not empty, 
exit the polling loop passing out the scaled data array and execute the res
of your control loop diagram. This method does not return data as soo
the scan has been acquired, as in the example described previously, 
provides ample time for other VIs and loops to execute. This method i
good technique for balancing the CPU load between several loops and
running in parallel.

In the previously described techniques, if you are using software delays
control loop speeds greater than 1 Hz turn the Use Default Timer option 
off in the Performance dialog box in your LabVIEW Preferences. Turning
this off gives you approximately 1 ms software timer resolution, instead
the default 55 ms timer resolution.

For more control examples, refer to the VIs located in 
examples\daq\solution\control.llb .
LabVIEW Data Acquisition Basics Manual 6-10 © National Instruments Corporation
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Buffering Your Way through 
Waveform Acquisition

If you want to take more than one reading on one or more channels, th
are two techniques you can use depending on what you want to do with
data after you acquire it. This chapter reviews these different methods
explains how LabVIEW stores the acquired data with each method. Y
will discover which method you should use by answering the following
questions. 

• Do you want to analyze your data as it is being acquired or after it 
been acquired?

• Do you want to acquire a predetermined or indefinite number of d
points?

If you want to analyze your data as it is being measured and the numb
data points does not matter, read the Do You Need To Access Your Data 
during Acquisition? section in this chapter. If you acquire a predetermin
number of data points and you want to analyze the data after it has be
acquired, refer to the Can You Wait for Your Data? section in this chapter. 
Also, throughout the chapter there are some basic examples of some 
common data acquisition (DAQ) applications that use these two meth

Can You Wait for Your Data?
One way to acquire multiple data points for one or more channels is to
the non-buffered methods described in the previous chapter in a repet
manner. For example, you could compare this method to a trip to the 
grocery store. You need to get 20 items from the store, but because y
can’t carry all 20 items at once, you decide you must make 20 separate
to the store. Grocery shopping in this manner would be very inefficient 
time consuming. The same applies for when you are acquiring a single
point from one or more channels over and over. Also, with this method
acquisition, you do not have accurate control over the time between e
sample or channel. Going back to the example of grocery shopping, it
would be much more efficient to use a shopping bag to hold all 20 foo
items at once, so that you only have to make one trip. In the same sen
on Basics Manual
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you can use a data buffer in computer memory as your shopping bag 
which you acquire data. 

With buffered I/O, LabVIEW transfers data taken at timed intervals fro
a DAQ device to a data buffer in memory. Figure 7-1 illustrates how th
data fills up the buffer only once, however the overall size of the buffe
specified in your VI. In this illustration, think of N as the number of scans
or updates the buffer can hold, and T as the trigger occurrence whether 
the trigger is because of an external signal or the start of the execution
your VI. Refer to Chapter 8, Controlling Your Acquisition with Triggers, 
for more descriptions on triggering your acquisition from another signa

Figure 7-1.  How Buffers Work

In your VI, you must specify the number of samples to be taken and th
number of channels from which LabVIEW will take the samples. From t
information, LabVIEW allocates a buffer in memory to hold a number o
data points equal to the number of samples per channel multiplied by 
number of channels. As the data acquisition continues, the buffer fills w
the data; however, the data may not actually be accessible until LabVI
acquires all the samples (N). Once the data acquisition is complete, the
that is in the buffer can be analyzed, stored to disk, or displayed to the
screen by your VI.

Acquiring a Single Waveform
You can acquire a waveform from a single channel by using the 
AI Acquire Waveform VI, shown in Figure 7-2. You can find this VI in 
Functions»DAQ»Analog Input. Because AI Acquire Waveform is an 
Easy Analog Input VI, it has the minimal number of inputs needed to 
acquire a waveform from a single channel. These minimal inputs are t
device, channel string, number of samples from the channel, and the 
sample rate. You can programmatically set the gain by setting the 
high limit  and the low limit . Using only the minimal set of inputs makes
programming the VI easier, but the VI lacks more advanced capabilitie
such as triggering. Built-in error handling is another useful feature of t
Easy VIs. If an error occurs, the program stops running and notifies yo
with a dialog box explaining the error.

writing and reading

T

N
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Note If you set up your channel in the DAQ Channel Wizard, you do not need to ent
the device or input limits. Instead, enter a channel name in the channel input, and 
the value returned is relative to the physical units you specify for that channel 
the DAQ Channel Wizard. If input limits are specified, they also are treated as 
relative to the physical units of the channel. LabVIEW ignores the device input
when channel names are used. This principal applies throughout this manual.

Figure 7-2.  The AI Acquire Waveform VI

Acquiring Multiple Waveforms
You can acquire more than one waveform at a time with another of the E
Analog Input VIs, AI Acquire Waveforms, shown in Figure 7-3. This VI
also has a minimal set of inputs, but it allows inputs of more than one 
channel to read and returns data from all channels read.

Figure 7-3.  The AI Acquire Waveforms VI

The channel input for this VI is a string where you can enter a list of 
channels. Refer to Chapter 3, Basic LabVIEW Data Acquisition Concepts, 
for more information on channel specification in LabVIEW. LabVIEW 
outputs a two-dimensional (2D) array in the waveforms output for this VI, 
where each channel has a different column and the samples are in ea
row. See Chapter 3, Basic LabVIEW Data Acquisition Concepts, for more 
information on how data is organized for analog applications. You can
set the high limit  and low limit  inputs for all the channels to the same 
value. For more information on gain specifications, refer to Chapter 3,
Basic LabVIEW Data Acquisition Concepts. Like the other Easy VIs, 
you cannot use any advanced programming features with the AI Acqu
Waveforms VI. The built-in error checking of this VI alerts you to any 
errors that occur in the program.
© National Instruments Corporation 7-3 LabVIEW Data Acquisition Basics Manual
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You also can acquire multiple waveforms using the Intermediate VIs. 
The Intermediate VIs provide more control over your data acquisition 
processes, like being able to read any part of the buffer. An example sim
to Figure 7-4 is the Acquire N Scans VI, located in labview\examples\

daq\anlogin\anlogin.llb . With these Intermediate Analog Input VIs
you must wire a taskID to identify the DAQ operation and the set of 
channels used in the acquisition and to make sure the VIs execute in 
correct order.

Figure 7-4.  Using the Intermediate VIs to Acquire Multiple Waveforms

With these VIs, not only can you configure triggering, coupling, 
acquisition timing, retrieval, and additional hardware, but you also can
control when each step of the data acquisition process occurs. With 
the AI Config VI, you can configure the different parameters of the 
acquisition, such as the channels to be read and the size of the buffer to
In the AI Start VI, you specify parameters used in your program to start
acquisition, such as number of scans to acquire, the rate at which you
takes the data, and the trigger settings. In the AI Read VI, you specify
parameters to retrieve the data from the data acquisition buffer. Then,
your application calls the AI Clear VI to deallocate all buffers and othe
resources used for the acquisition by invalidating the taskID. If an error 
occurs in any of these VIs, your program passes the error through the
remaining VIs to the Simple Error Handler VI, which notifies you of 
the error.
LabVIEW Data Acquisition Basics Manual 7-4 © National Instruments Corporation
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For many DAQ devices, the same ADC samples many channels instea
only one. The maximum sampling rate per channel is

The scan rate input in all the VIs described above is the same as the 
sampling rate per channel. To figure out your maximum scan rate, you
must divide the maximum sampling rate by the number of channels. 
In Appendix B, Hardware Capabilities, in the LabVIEW Function 
and VI Reference Manual, maximum sampling rates are listed for each 
DAQ device. You also can refer to the LabVIEW Online Reference, 
available by selecting Help»Online Reference….

Note When using the NB-A2100 or the NB-A2150 boards, specifying an odd buffer si
or an odd number of samples when acquiring data with one channel results in 
–10089 badTotalCountErr . To avoid this error, specify an even number of 
samples and throw away the extra sample.

Simple-Buffered Analog Input Examples
Following are several different examples of simple-buffered analog inp

Simple-Buffered Analog Input with Graphing
Figure 7-5 show how you can use the AI Acquire Waveforms VI to acqu
two waveforms from channels 0 and 1 and then display the waveform
separate graphs. This type of VI is useful in comparing two or more 
waveforms, or in analyzing how a signal looks before and after going 
through a system. In this illustration, 1,000 scans of channels 0 and 1
taken at the rate of 5,000 scans per second. The Actual Scan Period output 
displays in the actual timebase on the x-axis of the graphs. Remember
each column of the 2D array contains the information for each channe

maximum sampling rate
number of channels

-----------------------------------------------------------------
© National Instruments Corporation 7-5 LabVIEW Data Acquisition Basics Manual
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Figure 7-5.  Simple Buffered Analog Input Example

If you want to display the data on the same graph, look again at the Acq
N Scans example VI, found in labview\examples\daq\anlogin\

anlogin.llb . Figure 7-6 shows a simple buffered input application th
uses graphing.

Figure 7-6.  Simple Buffered Analog Input with Graphing

For a 2D array to be displayed on a waveform graph, each row of data m
represent a single plot. This is because waveform graphs are in row-m
order. Because the channel data is in each column, you must transpos
2D array. Transposing the array can be done easily by popping-up on
front panel of the graph and choosing Transpose Array. 
LabVIEW Data Acquisition Basics Manual 7-6 © National Instruments Corporation
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Simple-Buffered Analog Input with Multiple Starts
In some cases, you might not want to acquire contiguous data, like in 
oscilloscope application. In this case, you would only want to take a 
specified number of samples as a snapshot of what the input looks lik
periodically. For an example using the Intermediate VIs, open the Acqu
N-Multi-Start VI found in labview\examples\daq\anlogin\

anlogin.llb . The Acquire N-Multi-Start VI, shown in Figure 7-7, is 
similar to the Acquire N Scans example, except the acquisition only occ
each time the start button on the front panel is pressed.

Figure 7-7.  Taking a Specified Number of Samples with the Intermediate VIs

This example is similar to the standard simple buffered analog input VI,
now both the AI Start and AI Read VIs are in a While Loop, which mea
the program takes a number of samples every time the While Loop iter

Note The AI Read VI returns 1,000 samples, taken at 5,000 samples per second, ev
time the While Loop iterates; however, the duration of the iterations of the Whi
Loop can vary greatly. This means that, with this VI, you can control the rate a
which samples are taken, but you may not be able to designate exactly when y
application starts acquiring each set of data. If this start-up timing is important t
© National Instruments Corporation 7-7 LabVIEW Data Acquisition Basics Manual
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your program, read the Do You Need To Access Your Data during Acquisition? 
section in this chapter to see how to control acquisition start-up times.

Simple-Buffered Analog Input with a Write to Spreadsheet File
If you want to write the acquired data to a file, there are many file form
in which you can store the data. The spreadsheet file format is used m
often because you can read it using most spreadsheet applications for
data graphing and analysis. In LabVIEW, you can use VIs to send data
file in spreadsheet format or read back data from such a file. You can lo
these VIs in Functions»File I/O. The VI used in this example is the 
Write to Spreadsheet File VI, shown in Figure 7-8. In this exercise, the
Intermediate analog input VIs acquire an array of data, graph the data u
the actual sample period for the x-axis timebase, and create a spread
file containing the data.

Figure 7-8.  Writing to a Spreadsheet File after Acquisition

Triggered Analog Input
For information on starting your acquisition with triggers, refer to 
Chapter 8, Controlling Your Acquisition with Triggers.

Do You Need To Access Your Data during Acquisition?
You can apply the simple buffering techniques in many DAQ applicatio
but there are some applications where these techniques are not approp
If you need to acquire more data than your computer’s memory can ho
or if you want to acquire data over long periods of time, you should not 
these simple-buffered techniques. For these types of applications, you
should set up a circular buffer to store acquired data in memory. In the
previous section, buffered input was compared to shopping for grocer
You typically use a cart or bag (your buffer) to hold as many groceries
LabVIEW Data Acquisition Basics Manual 7-8 © National Instruments Corporation
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(your acquired data) as possible, so that you only have to make one tr
the store. In this case, imagine that you must prepare a meal and you
unable to go shopping—yet periodically you need things from the store
your recipe. If you send someone else to the store for you, you can con
to prepare dinner while someone else retrieves the other items you ne
You can compare this scenario to circular-buffered data acquisition, sh
in Figure 7-9. Using a circular buffer, you can set up your device to 
continuously acquire data in the background while LabVIEW retrieves 
acquired data.

Figure 7-9.  How a Circular Buffer Works

A circular buffer differs from a simple buffer only in how LabVIEW place
the data into it, and retrieves data from it. A circular buffer is filled with
data, just as a simple buffer; however, when it gets to the end of the bu
it returns to the beginning and fills up the same buffer again. This mea
data can read continuously into computer memory, but only a defined
amount of memory can be used. Your VI must retrieve data in blocks, fr
one location in the buffer, while the data enters the circular buffer at a
different location, so that unread data is not overwritten by newer data

Incoming Data
from the Board

to the PC
(AI Start.vi)

End of Data Current Read Mark End of Data

Data transferred from PC
buffer to LabVIEW
(AI Read.vi)

Current Read Mark End of Data End of Data Current Read Mark
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Because of the buffer maintenance, you can only use the Intermediate
Advanced VIs with this type of data acquisition.

While a circular buffer works well in many applications, there are two 
possible problems that can occur with this type of acquisition: your VI 
could try to retrieve data from the buffer faster than data is placed into
or your VI might not retrieve data from the buffer fast enough before 
LabVIEW overwrites the data into the buffer. When your VI tries to rea
data from the buffer that has not yet been collected, LabVIEW waits for
data your VI requested to be acquired and then returns the data. If you
does not read the data from the circular buffer fast enough, the VI sen
back an error, advising you that the data that you retrieved from the bu
is overwritten data. 

Continuously Acquiring Data from Multiple Channels
You can acquire time-sampled data continuously from one or more 
channels with the Intermediate VIs. An example using these VIs is the
Acquire & Process N Scans VI, found in labview\examples\daq\

anlogin\anlogin.llb . This example is shown in Figure 7-10. There 
are inputs for setting the channels, size of the circular buffer, scan rate,
the number of samples to retrieve from the circular buffer each time. T
VI defaults to a input buffer size of 2,000 samples and 1,000number of 
scans to read at a time, which means the VI reads in half of the buffer’s
data while the VI fills the second half of the buffer with new data. 

Note The number of scans to read can be any number less than the input  buffer size. 

If you do not retrieve data from the circular buffer fast enough, your unre
data will be overwritten by newer data. You can resolve this problem in 
of three ways: by adjusting the input buffer size, scan rate, or the number 
of scans to read at a time parameters. If your program overwrites data i
the buffer, then data is coming into the buffer faster than your VI can r
all of the previous buffer data, and LabVIEW returns an error code –10846 

overWriteError . You can increase the size of the buffer so that it tak
longer to fill up, which leaves your VI with more time to read data from 
If you slow down the scan rate, you reduce the speed at which the buffe
fills up, which also leaves more time for your program to retrieve data.
You can also increase the number of scans to read at a time, which will 
retrieve more data out of the buffer each time and effectively reduce th
number of times to access the buffer before it becomes full. Check the
output scan backlog to see how many data values remain in the circula
buffer after the read.
LabVIEW Data Acquisition Basics Manual 7-10 © National Instruments Corporation



Chapter 7 Buffering Your Way through Waveform Acquisition

such 

ate 

ta, 

I 
Figure 7-10.  Continuously Acquiring Data with the Intermediate VIs

Because this uses Intermediate VIs, you also can control parameters 
as triggering, coupling, and additional hardware.

Asynchronous Continuous Acquisition Using DAQ Occurrences
The main advantage of the last section is that you are free to manipul
your data between calls to AI Read.vi . One limitation, however, 
is that the acquisition is synchronous. This means that once you call 
AI Read.vi , you cannot perform any other tasks until AI Read.vi  
returns your acquired data. If your DAQ device is still busy collecting da
you will have to sit idle until it finishes.

If you need the efficiency of not having to wait for AI Read.vi , then 
asynchronous acquisition is for you. You can acquire asynchronous 
continuous data from multiple channels using the same intermediate 
DAQ VIs by adding DAQ Occurrences. Figure 7-11 shows an 
example of how to do this. This is the diagram of the Cont Acq&Chart 
(Async Occurrence) VI, located in labview\examples\daq\

anlogin\anlogin.llb . Notice that it is very similar to Figure 7-10.

The difference is that here you will use the DAQ Occurrence Config V
and the Wait on Occurrence function to control the reads. The first 
DAQ Occurrence Config VI sets the DAQ Event. In this example the 
DAQ Event is to set the occurrence every time a number of 

scans is acquired equal to the value of general value A , 
© National Instruments Corporation 7-11 LabVIEW Data Acquisition Basics Manual
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where general value A is the number of scans to read at a time. Inside 
the while loop, the Wait on Occurrence function sleeps in the backgrou
until the chosen DAQ Event takes place. Notice that the timed out outpu
from the Wait on Occurrence function is wired to the selection termina
the case structure that encloses the AI Read VI. This means that AI R
will not be called until the number of scans to read at a time have 
been acquired. The result is that the while loop is effectively put to sle
because you do not try to read the data until you know it has been acqu
This frees up processor time to do other tasks while you are waiting fo
the DAQ Event. If the DAQ Occurrence times out, the timed out outpu
value would be TRUE, and AI Read would never be called. When you
acquisition is complete, DAQ Occurrence is called again to clear all 

occurrences .

Figure 7-11.  Continuous Acq&Chart (Async Occurrence) VI

Circular-Buffered Analog Input Examples
The only differences between the simple-buffered applications and 
circular-buffered applications in the block diagram is the number of scans 
to acquire input of the AI Start VI is set to 0, and now we must call the
LabVIEW Data Acquisition Basics Manual 7-12 © National Instruments Corporation
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AI Read VI repeatedly to retrieve your data. These changes can be ap
to many of the examples in the previous section on simple buffered an
input, however we will review the basic circular-buffered analog input 
here, and describe some other example VIs that are included with 
LabVIEW. 

Basic Circular-Buffered Analog Input
Figure 7-12 shows an example VI that brings data from channel 0 at a
of 1,000 samples/s into a buffer that can hold 4,000 samples. This typ
example might be handy if you wanted to watch the data from a chann
over a long period of time, but you could not store all the data in mem
at once. The AI Config VI sets up the channel specification and buffer s
then the AI Start VI initiates the background data acquisition and speci
the rate. Inside the While Loop, the AI Read VI repeatedly reads block
data from the buffer of a size equal to either 1,000 scans or the size o
scan backlog—whichever one is larger. The VI does this by using the 
Max & Min function to determine the larger of the two values. You do n
have to use the Max & Min function in this way for the application to wor
but the function helps control the size of the scan backlog, which is how 
many samples that are left over in the buffer. This VI continuously rea
and displays the data from channel 0 until an error occurs or until you press
the Stop button.

Figure 7-12.  Basic Circular-Buffered Analog Input Using the Intermediate VIs

Other Circular-Buffered Analog Input Examples
There are many other circular-buffered analog input VIs that are includ
with your LabVIEW application. The following sections briefly explain 
some of these VIs. You can find the first two VIs in labview\examples\ 
© National Instruments Corporation 7-13 LabVIEW Data Acquisition Basics Manual
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daq\anlogin\anlogin.llb  and the rest of the example VIs in 
labview\examples\daq\anlogin\strmdsk.llb . For information on 
how these examples work and how to modify them, open Windows»Show 
VI Information  or open the Help window by choosing Help»Show Help.

Cont Acq&Chart (buffered).vi
The Cont Acq&Chart (buffered).vi  demonstrates circular-buffered
analog input similarly to the previous example, but this VI includes oth
front panel inputs.

Cont Acq&Graph (buffered).vi
The Cont Acq & Graph (buffered).vi  is similar to the 
Cont Acq&Chart (buffered).vi , except this VI displays data in a 
waveform graph.

Cont Acq to File (binary).vi
In the Cont Acq to File (binary).vi , your program acquires data 
through circular-buffered analog input and stores it in a specified file a
binary data. This process is more commonly called streaming to disk.

Cont Acq to File (scaled).vi
The Cont Acq to File (scaled).vi  is similar to the previous binary 
VI, with the exception that this VI writes the acquired data to a file as sca
voltage readings rather than binary values.

Cont Acq to Spreadsheet File.vi
The Cont Acq to Spreadsheet File.vi  continuously reads data that
LabVIEW acquires in the circular buffer, and stores this data to a speci
file in spreadsheet format. You can view the data stored in a spreadsh
file by this VI in any spreadsheet application.

Simultaneous Buffered Waveform Acquisition 
and Waveform Generation

You might discover that along with your analog input acquisition, you a
would like to output analog data. If so, see Chapter 14, Simultaneous 
Buffered Waveform Acquisition and Generation.
LabVIEW Data Acquisition Basics Manual 7-14 © National Instruments Corporation
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Controlling Your Acquisition 
with Triggers

The single-point and waveform acquisitions described in the previous 
sections start at random times relative to the data. But, there are times
you may need to be able to set your analog acquisition to start at a ce
time. An example of this would be if you wanted to measure the 
temperature of an object after applying heat to it. An electrical thermom
sends a step voltage to your data acquisition (DAQ) device after the hea
process completes. If you have no way to begin measuring data 
immediately after your device receives the step voltage, then you mus
acquire more points, some before the step voltage and some after it in o
to capture the data you need. As you can see, this solution is an ineffic
use of computer memory and disk space, because you must allocate an
more than is necessary. Sometimes the data you need may be closer 
front of the buffer and other times it may be closer to the end of the bu

However, there is a way to start an acquisition based on the condition
state of an analog or digital signal. This technique is commonly called
triggering. Generally, a trigger is any event that causes or starts some for
of data capture. There are two basic types of triggering—hardware an
software triggering. In LabVIEW, you can use software triggering to sta
acquisitions or use it with an external device to perform hardware 
triggering.

Hardware Triggering
Hardware triggering lets you set the start time of an acquisition and ga
data at a known position in time relative to a trigger signal. External dev
produce hardware trigger signals. In LabVIEW, you specify the triggeri
conditions that must be reached before acquisition begins. Once the 
conditions are met, the acquisition begins immediately. You can also 
analyze the data before trigger.

There are two specific types of hardware triggers: digital and analog. In
following two sections, you will learn about the necessary conditions to
start an acquisition with a digital or an analog signal.
on Basics Manual
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Digital Triggering
A digital trigger is usually a transistor-transistor logic (TTL) level signa
having two discrete levels—a high and a low level. When moving from
high to low or low to high, a digital edge is created. There are two type
edges: rising and falling. You can set your analog acquisition to start a
result of the rising or falling edge of your digital trigger signal.

In Figure 8-1, the acquisition begins after the falling edge of the 
digital trigger signal. Usually digital trigger signals are connected to 
STARTTRIG*, EXTTRIG*, DTRIG, or PFI pins on your DAQ device. 
If you want to know which pin your device has, check your hardware 
manual, or refer to the AI Trigger Config VI description in Chapter 18, 
Advanced Analog Input VIs, of the LabVIEW Function and VI Reference 
Manual. You also can refer to the LabVIEW Online Reference, available by 
selecting Help»Online Reference….The STARTTRIG* and EXTTRIG* 
pins, which have and asterisk after their names, regard a falling edge s
as a trigger. Make sure you account for this when specifying your trigge
conditions.

Figure 8-1.  Diagram of a Digital Trigger

TTL Signal

Connect to STARTTRIG*, EXTTRIG*, 
or DTRIG Pins

Falling Edge of Signal
Data Capture Initiated
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Figure 8-2 shows a timeline of how digital triggering works for 
post-triggered data acquisition. In this example, an external device sen
trigger, or TTL signal, to your DAQ device. As soon as your DAQ devic
receives the signal, and your trigger conditions are met, your device be
acquiring data.

Figure 8-2.  Digital Triggering with Your DAQ Device

External DAQ  Digital Trigger
Signal

Analog Data

DAQ Device waits for digital trigger conditions.
Then …

Device Device

DAQ  
Device

External 
Device
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Digital Triggering Examples
A common example of digital triggering in LabVIEW is the Acquire N 
Scans Digital Trig VI, found in labview\examples\daq\anlogin\

anlogin.llb . This VI, as shown Figure 8-3, uses the Intermediate VIs
perform a buffered acquisition, where LabVIEW stores data in a memo
buffer during acquisition. After the acquisition completes, the VI retriev
all the data from the memory buffer and displays it. Figure 8-3 shows 
block diagram of this example VI.

Figure 8-3.  Block Diagram of the Acquire N Scans Digital Trig VI

For more information on buffered acquisitions, refer to Chapter 7, 
Buffering Your Way through Waveform Acquisition. 

You must tell your device the conditions on which to start acquiring da

For this example, the choose trigger type Boolean should be set to START 

OR STOP TRIGGER. You should only use the START & STOP TRIGGER 
when you have two triggers: start and stop. In addition, if you use a 
DAQ device with PFI lines (e.g., E-series 5102 devices), you can spec
the trigger signal condition in the trigger channel control in the analog 
chan & level cluster. For more information on valid trigger channel name
refer to the AI Trigger Config VI description, in Chapter 18, Advanced 
Analog Input VIs, of the LabVIEW Function and VI Reference Manual, or 
to the LabVIEW Online Reference, available by selecting Help»Online 
Reference…. This chapter only describes applications that use one dig
trigger. For more information on two-triggered applications, look at the
description for the AI Trigger Config VI, found in Chapter 18, Advanced 
Analog Input VIs, in the LabVIEW Function and VI Reference Manual, or 
LabVIEW Data Acquisition Basics Manual 8-4 © National Instruments Corporation
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to the LabVIEW Online Reference, available by selecting Help»Online 
Reference….

In LabVIEW, you can acquire data both before and after a digital trigge
signal. If the pretrigger scans is greater than 0, your device acquires da
before the triggering conditions are met and subtract the pretrigger scans 
value from the number of scans to acquire value to determine the number
of scans to collect after the triggering conditions are met. If pretrigger 
scans is 0, you acquire the number of scans to acquire after the triggering 
conditions are met.

Before you start acquiring data, you must specify in the trigger edge input 
whether the acquisition should be triggered on the rising or falling edge
the digital trigger signal. You also can specify a value for the time limit , the 
maximum amount of time the VI waits for the trigger and requested da

Digital Triggering Examples
The Acquire N Scans Digital Trig VI example holds the data in a memo
buffer until your device completes the acquisition. The number of data
points you need to acquire must be small enough to fit in memory. This
only views and processes the information after the acquisition. If you n
to view and process information during the acquisition, use the Acquir
& Proc N Scans-Trig VI, found in labview\examples\daq\anlogin\

anlogin.llb . If you expect multiple digital trigger signals that will star
multiple acquisitions, use the example VI, Acquire N-Multi-Digital Trig,
located in labview\examples\daq\anlogin\anlogin.llb .

Analog Triggering
You connect analog trigger signals to the analog input channels—the s
channels where you connect analog data. Your DAQ device monitors 
analog trigger channel until trigger conditions are met. You configure t
DAQ device to wait for a certain condition of the analog input signal, li
the signal level or slope (either rising or falling). Once the device identif
the trigger conditions, it starts an acquisition.

Note If you are using channel names configured in the DAQ Channel Wizard, the 
signal level is treated as being relative to the physical units specified for the 
channel. For example, if you configure a channel called temperature  to have a 
physical unit of Deg. C , the value you specify for the trigger signal level is relative
to Deg. C . If you are not using channel names, the signal level is treated as vo
© National Instruments Corporation 8-5 LabVIEW Data Acquisition Basics Manual
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In Figure 8-4, the analog trigger is set to start the data acquisition on t
rising slope of the signal, when the signal reaches 3.2.

Figure 8-4.  Diagram of an Analog Trigger

Figure 8-5 explains analog triggering for post-triggered data acquisitio
using a timeline. You configure your DAQ hardware in LabVIEW to beg
taking data when the incoming signal is on the rising slope and when 
amplitude reaches 3.2. Your DAQ device begins capturing data when 
specified analog trigger conditions are met.

Figure 8-5.  Analog Triggering with Your DAQ Device

— — — — — — — — — — — — — — — — — — — — — 

Level and Slope of
Signal Initiates Data Capture

3.2

0

Analog Trigger
Signal

Analog Data

DAQ Device waits until analog trigger
conditions are met. Then …

DAQ  
Device

External 
Device

DAQ  
Device

External 
Device
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Analog Triggering Examples
A common example of analog triggering in LabVIEW is the Acquire 
N Scans Analog Hardware Trig VI, located in labview\examples\

daq\anlogin\anlogin.llb . This VI, as shown in Figure 8-6, uses the
Intermediate VIs to perform buffered acquisition, where data is stored 
memory buffer during acquisition. After the acquisition completes, the 
retrieves all the data from the memory buffer and displays it. 

Figure 8-6.  Block Diagram of the Acquire N Scans Analog Hardware Trig VI

For more information on buffered acquisition, read Chapter 7, Buffering 
Your Way through Waveform Acquisition.

You must tell your device the conditions on which to start acquiring da

In LabVIEW, you can acquire data both before and after an analog trig
signal. If the pretrigger scans is greater than 0, your device acquires da
before the triggering conditions and subtracts the pretrigger scans value 
from the number of scans to acquire value to determine the number of 
scans to collect after the triggering conditions are met. If pretrigger scans 
is 0, then the number of scans to acquire will be acquired after the 
triggering conditions are met.

Before you start acquiring data, you must specify in the trigger slope input 
if the acquisition is going to be triggered on the rising or falling edge of 
analog trigger signal. Aside from specifying the slope, you must enter 
© National Instruments Corporation 8-7 LabVIEW Data Acquisition Basics Manual
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trigger channel where the analog triggering signal will be connected 
as well as the trigger level on the triggering signal needed to begin 
acquisition. In other words, once you specify the channel of the trigger
signal, LabVIEW will wait until the slope and trigger level conditions ar
met before starting a buffered acquisition. If you use channel names 
configured in the DAQ Channel Wizard, trigger level is treated as being 
relative to the physical units specified for the channel in the DAQ Chan
Wizard. Otherwise, trigger level is treated as volts.

The Acquire N Scans Analog Hardware Trig VI example, located in 
labview\examples\daq\anlogin\anlogin.llb , holds the data in a 
memory buffer until the device completes data acquisition. The numbe
of data points you want to acquire must be small enough to fit in memo
This VI only views and processes the information after the acquisition.
If you need to view and process information during the acquisition, use
Acquire & Proc N Scans-Trig VI, located in labview\examples\daq\

anlogin\anlogin.llb . If you expect multiple analog trigger signals tha
will start multiple acquisitions, use the example Acquire N-Multi-Analo
Hardware Trig VI, located in labview\examples\daq\anlogin\

anlogin.llb .

Software Triggering
With software triggering, you can simulate an analog trigger using 
software. This form of triggering is often used in situations where hardw
triggers are not available. Another name for software triggering signals
specifically analog signals, is conditional retrieval. With conditional 
retrieval, you set up your DAQ device to collect data, but the device do
not return any data to LabVIEW unless the data meets your retrieval 
conditions. LabVIEW scans the input data and performs a comparison 
the conditions, but does not store the data until it meets your specificati
Figure 8-7 shows a timeline of events that typically occur when you 
perform conditional retrieval.

The read/search position pointer traverses the buffer until it finds the s
location where the data has met the retrieval conditions. Offset indicat
the scan location from which the VI begins reading data relative to the
read/search position. A negative offset indicates that you need pretrigg
data (data prior to the retrieval conditions). If offset is greater than 0, y
need posttrigger data (data after retrieval conditions).
LabVIEW Data Acquisition Basics Manual 8-8 © National Instruments Corporation
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Figure 8-7.  Timeline of Conditional Retrieval
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The conditional retrieval  cluster of the AI Read VI specifies the analog
signal conditions of retrieval, as shown in Figure 8-8.

Figure 8-8.  The AI Read VI Conditional Retrieval Cluster

Note Remember that the actual data acquisition is started by running your VI and th
the conditional retrieval just controls the returning of data already being acquired

When acquiring data with conditional retrieval, you typically store the d
in a memory buffer, similar to hardware triggering applications. After yo
start running the VI, the data is placed in the buffer. Once the retrieval
conditions have been met, the AI Read VI searches the buffer for the 
desired information. As with hardware analog triggering, you specify th
analog channel of the triggering signal by specifying its channel index, an 
index number corresponding to the relative order of a single channel in
channel list. You also specify the slope (rising or falling) and the level of 
the trigger signal.

Note The channel index might not be equal to the channel value. The Channel to 
Index.vi can be used to get the channel index for a channel. You can find this V
in Data Acquisition»Calibration and Configuration.

The AI Read VI begins searching for the retrieval conditions in the buf
at the read/search position, another input of the AI Read VI. The offset, a 
value of the conditional retrieval input cluster, is where you specify the 
scan locations from which the VI begins reading data relative to the 
read/search position. A negative offset indicates data prior to the retrieval
condition pretrigger data, and a positive offset indicates data after the 
retrieval condition posttrigger data. The skip count input is where you 
specify the number of times the trigger conditions are met. The hysteresis 
input is where you specify the range you will use to meet retrieval 
conditions. Once the slope and level conditions on channel index have 
been found, the read/search position indicates the location where the 
retrieval conditions were met.
LabVIEW Data Acquisition Basics Manual 8-10 © National Instruments Corporation
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If you are using channel names configured in the DAQ Channel Wizar
level and hysteresis are treated as being relative to the physical units 
specified for the channel. If you are not using channel names, these in
are treated as volts.

For more information on the conditional retrieval input cluster, look at t
AI Read VI description in Chapter 16, Intermediate Analog Input VIs, in 
the LabVIEW Function and VI Reference Manual, or the LabVIEW Online 
Reference, available by selecting Help»Online Reference….

Conditional Retrieval Examples
The Acquire N Scans Analog Software Trig VI example, located in 
labview\examples\daq\anlogin\anlogin.llb , uses the 
Intermediate VIs, as shown in Figure 8-9.

Figure 8-9.  Block Diagram of the Acquire N Scans Analog Software Trig VI

The main difference between this software triggering example and 
hardware triggering is the use of the conditional retrieval input for the 
AI Read VI. You set up the trigger channel, trigger slope, and trigger 
level the same way for both triggering methods. The pretrigger scans 
value will be negated and connected to the offset value in the conditional 
retrieval cluster of the AI Read VI. When the trigger conditions are me
the VI will return the requested number of scans.
© National Instruments Corporation 8-11 LabVIEW Data Acquisition Basics Manual
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Letting an Outside Source 
Control Your Acquisition Rate

Typically, a data acquisition (DAQ) device uses internal counters to 
determine the rate to acquire data, but sometimes you might need to ca
your data at the rate of particular signals in your system. For example
you can also read temperature channels every time a pulse occurs wh
represents pressure rising above a certain level. In this case, internal 
counters are inefficient for your needs. You must control your acquisit
rate by some other, external source.

You can compare a scan of your channels to taking a snapshot of the 
voltages on your analog input channels. If you set your scan rate to 10 s
per second, you are taking 10 snapshots each second of all the chann
your channel list. In this case, an internal clock within your device (the s
clock) sets the scan rate, which controls the time interval between sca

Also, remember that most DAQ devices (those that do not sample 
simultaneously) proceed from one channel to the next depending on th
channel clock rate. Therefore, the channel clock is the clock controllin
the time interval between individual channel samples within a scan, wh
means the channel clock proceeds at a faster rate than the scan clock

The faster the channel clock rate, the more closely in time your system
samples the channels within each scan, as shown in Figure 9-1.

Note For devices with both a scan and channel clock, lowering the scan rate does n
change the channel clock rate. 

Figure 9-1.  Channel and Scan Intervals Using the Channel Clock

channel interval

0 1 2 3 0 1 2 3 0 1 2 3

scan interval
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Some DAQ devices do not have scan clocks, but rather use round-robin 
scanning. Figure 9-2 shows an example of round-robin scanning.

Figure 9-2.  Round-Robin Scanning Using the Channel Clock

The devices that always perform round-robin scanning include, but are
limited to, the following:

• NB-MIO-16

• PC-LPM-16

• PC-LPM-16PnP

• PC-516

• DAQCard-500

• DAQCard-516

• DAQCard-700

• Lab-NB, Lab-SE

• Lab-LC

With no scan clock, the channel clock is used to switch between each
channel at an equal interval. The same delay exists between all chann
samples, as well as between the last channel of a scan and the first ch
in the next scan. (For boards with scan and channel clocks, round-rob
scanning occurs when you disable the scan clock by setting the scan ra
zero and using the interchannel delay of the AI Config VI to control your 
acquisition rate.)

Finally, remember that LabVIEW is scan-clock oriented. In other words, 
when you select a scan rate, LabVIEW automatically selects the chan
clock rate for you. LabVIEW selects the fastest channel clock rate tha
allows adequate settling time for the Analog-to-Digital Converter (ADC

LabVIEW adds an extra 10-µs to the interchannel delay to compensate f
any unaccounted factors. However, LabVIEW does not consider this 
additional delay for purposes of warnings. If you have specified a scan 
that is adequate for acquisition but too fast for LabVIEW to apply the 
10-µs delay, it configures the acquisition but does not return a warning

channel interval

0 1 2 3 0 1 2 3 0 1 2 3
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You can set your channel clock rate with the interchannel delay input of 
the AI Config VI, which calls the Advanced AI Clock Config VI to actually
configure the channel clock. The simplest method to select an intercha
delay is to gradually increase the delay, or clock period, until the data 
appears consistent with data from the previous delay setting.

Refer to your hardware manuals for the required settling time for your 
channel clock. You can also find the interchannel delay by running the
low-level AI Clock Config VI for the channel clock with no frequency 
specified.

Externally Controlling Your Channel Clock
There are times when you might need to control the channel clock 
externally. The channel clock rate is the same rate at which analog 
conversions occur. For instance, suppose you need to know the strain v
at an input, every time an infrared sensor sends a pulse. Most DAQ dev
have an EXTCONV* pin or a PFI pin on the I/O connector for providing
your own channel clock. This external signal must be a TTL level sign
The asterisk on the signal name indicates that the actual conversion oc
on the falling edge of the signal, as shown in Figure 9-3. For devices w
PFI lines, you can select either the rising edge of falling edge using 
LabVIEW. With devices that have a RTSI connector, you can get your
channel clock from other National Instruments DAQ devices.

Figure 9-3.  Example of a TTL Signal

TTL Signal

rising edge falling edge
© National Instruments Corporation 9-3 LabVIEW Data Acquisition Basics Manual
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Figure 9-4 shows you the Acquire N Scans-ExtChanClk VI, located in 
labview\examples\daq\anlogin\anlogin.llb . This example 
demonstrates how to set up your acquisition for an externally controlle
channel clock. The VI includes the AI Clock Config VI and the clock 
source was connected to the I/O connector.

Figure 9-4.  Getting Started Analog Input Example VI

You can enable external conversions by calling the Advanced-level 
AI Clock Config VI. Remember that the AI Clock Config VI, which is 
called by the AI Config VI, normally sets internal channel delay 
automatically or manually with the interchannel delay control. However, 
calling the AI Clock Config VI after the AI Config VI resets the channe
clock so that it comes from an external source for external conversion
Also, notice that the scan clock is set to 0 to disable it, allowing the chan
clock to control the acquisition rate.

Note The 5102 devices do not support external channel clock pulses, because there
no channel clock on the device.
LabVIEW Data Acquisition Basics Manual 9-4 © National Instruments Corporation
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On most devices, external conversions occur on the falling edge of the
EXTCONV* line. Consult your hardware reference manual for timing 
diagrams. On devices with PFI lines (e.g., E-series devices), you can se
Clock Source Code input of AI Clock Config VI to the PFI pin with either 
falling or rising edge or use the default PFI2/Convert* pin where the 
conversions occur on the falling edge, as shown in Figure 9-5.

Figure 9-5.  Setting the Clock Source Code for External Conversion Pulses 
for E-Series Devices

Note The AT-MIO-16, AT-MIO-16D, NB-MIO-16, and NB-MIO-16X cannot support 
both an external channel clock and a digital trigger signal at the same time. Yo
must choose one or the other. 

Because LabVIEW determines the length of time before the AI Read V
times out based on the interchannel delay and scan clock rate, you may 
need to force a time limit for the AI Read VI, as shown previously in 
Figure 9-4.

Note On the Lab-PC+ and 1200 devices, the first clock pulse on the EXTCONV* pin
configures the acquisition but does not cause a conversion. However, all 
subsequent pulses cause conversions.
© National Instruments Corporation 9-5 LabVIEW Data Acquisition Basics Manual
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Externally Controlling Your Scan Clock
External scan clock control may be more useful than external channel c
control if you are sampling multiple channels, but may not be as obviou
find because it does not have the input on the I/O connector labeled 
ExtScanClock , the way the EXTCONV* pin does. 

Note Some MIO devices have an output on the I/O connector labeled SCANCLK. 
This cannot be used as an input.

The appropriate pin to input your external scan clock can be found in t
Table 9-1.

 

Note Some devices do not have internal scan clocks and therefore do not support 
external scan clocks. These devices include, but are not limited to the followin
NB-MIO-16, PC-LPM-16, PC-LPM-16PnP, PC-516, DAQCard-500, 
DAQCard-516, DAQCard-700, Lab-NB, Lab-SE, and Lab-LC.

After connecting your external scan clock to the correct pin, set up 
the external scan clock in software. In Figure 9-6, the example 
Acquire N Scans-ExtScanClk VI located in labview\examples\daq\ 

anlogin\anlogin.llb  shows how to do this. Two advanced VIs, 
AI Clock Config and AI Control, are used in place of the intermediate 
AI Start VI. This allows access to the clock source input. This is necessary 
because it allows access to the clock source string which is used to identify 
the PFI pin to be used for the scan clock for E-series boards. The clock 
source also includes the clock source code (on the front panel) which is set
to I/O connector. The 0 wired to the Clock Config VI disables the intern
clock.

Table 9-1.  External Scan Clock Input Pins

Device External Scan Clock Input Pin

AT-MIO-16
AT-MIO-16F-5
AT-MIO-16X
AT-MIO-16D
AT-MIO-64F-5

OUT2

All E-Series Devices Any PFI Pin 

Lab-PC+
1200 devices

OUT B1
LabVIEW Data Acquisition Basics Manual 9-6 © National Instruments Corporation
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Figure 9-6.  Externally Controlling Your Scan Clock with the Getting Started 
Analog Input Example VI

The NB-MIO-16X cannot support external scan clocks as the other dev
can. The device layout does not allow you to directly provide an extern
scan clock. Instead, you can offer a timebase to the internal counter, 
counter 5, that generates the scan clock. Do this by sending a timebase
the source 5 pin and calling the Advanced VIs used by the AI Clock Con
VI. In addition, you need to wire the alternate clock rate specifications as 
shown below into the AI Clock Config VI. Remember that the which clock 
input of the AI Clock Config VI should be set to scan clock (1) .

Note You must divide the timebase by some number between 2 and 65,535 or you 
get a bad input value error.

Because LabVIEW determines the length of time before AI Read times
based on the interchannel delay and scan clock rate, you may need to 
a time limit into AI Read. In Figure 9-6, the time limit is 5 seconds.
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Externally Controlling the Scan and Channel Clocks
You can control the scan and channel clocks simultaneously by combin
the two previous sections. However, make sure that you follow the pro
timing. Figure 9-7 demonstrates how you can set up your application t
control both clocks.

Figure 9-7.  Controlling the Scan and Channel Clock Simultaneously
LabVIEW Data Acquisition Basics Manual 9-8 © National Instruments Corporation
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Making Waves with Analog Output

This section contains basic information about generating data with 
LabVIEW, including generating a single point or multiple points.

Part III, Making Waves with Analog Output, contains the following 
chapters:

• Chapter 10, Things You Should Know about Analog Output, explains 
how to use LabVIEW to produce all of the different types of analog
output signals.

• Chapter 11, One-Stop Single-Point Generation, shows you which VIs 
to use in LabVIEW to perform single-point updates.

• Chapter 12, Buffering Your Way through Waveform Generation, 
shows you which VIs to use in LabVIEW to perform buffered analo
updates.

• Chapter 13, Letting an Outside Source Control Your Update Rate, 
shows you which VIs to use in LabVIEW to control your update ra
with an external source.

• Chapter 14, Simultaneous Buffered Waveform Acquisition 
and Generation, describes how to perform buffered waveform 
acquisition and generation simultaneously on the same DAQ devic
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Things You Should Know 
about Analog Output

Some measuring systems require that analog signals be generated by 
acquisition (DAQ) device. Each of these analog signals can be a stead
slowly changing signal, or a continuously changing waveform. The ne
few sections show you how to use LabVIEW to produce all of these 
different types of signals. First, you should learn about the various 
situations in which you might need to produce an analog signal.

Single-Point Output
When the signal level at the output is more important than the rate at w
the output value changes, you need to generate a steady DC value. Yo
use the single-point analog output VIs to produce this type of output. W
single-point analog output, any time you want to change the value on 
analog output channel, you must call one of the VIs that produces a si
update (a single value change). Therefore, you can change the output v
only as fast as LabVIEW calls the VIs. This technique is called software 
timing. You should use software timing if you do not need high speed 
generation or very accurate timing. Refer to Chapter 11, One-Stop 
Single-Point Generation, for more information on single-point output.

Buffered Analog Output
Sometimes in performing analog output, the rate that your updates occ
just as important as the signal level. This is called waveform generation, or 
buffered analog output. For example, you might want your DAQ device to
act as a function generator. You can do this by storing one cycle of sin
wave data in an array, and programming the DAQ device to generate 
values continuously in the array one point at a time at a specified rate. 
is known as single-buffered waveform generation. But what if you want to 
 Data Acquisition Basics Manual
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generate a continually changing waveform? For example, you might h
a large file stored on disk that contains data you want to output. Becau
LabVIEW cannot store the entire waveform in a single buffer, you mus
continually load new data into the buffer during the generation. This 
process requires the use of circular-buffered analog output in LabVIEW. 
To learn more about single or circular buffering, read Chapter 12, Buffering 
Your Way through Waveform Generation.
LabVIEW Data Acquisition Basics Manual 10-2 © National Instruments Corporation
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One-Stop Single-Point 
Generation

In the preceding chapter, you learned the appropriate time to use 
single-point updates. This chapter shows you which VIs to use in 
LabVIEW to perform these updates.

Single-Immediate Updates
The most basic way to program single-point updates in LabVIEW is by
using the Easy Analog Output VI, AO Update Channels. Figure 11-1 
shows a diagram of a VI that writes values to one or more output Channels 
on the output data acquisition (DAQ) Device.

Figure 11-1.  Single Immediate Update Using the AO Update Channels VI

Notice that an array of values is passed as an input to the VI. The first
element in the array corresponds to the first entry in the channel string
and the second array element corresponds to the second channel ent
If you use channel names configured in the DAQ Channel Wizard in yo
channel string, values is relative to the physical units you specify in the 
DAQ Channel Wizard. Otherwise, values is relative to volts. For more 
information on channel string syntax, refer to Chapter 3, Basic LabVIEW 
Data Acquisition Concepts. Remember that Easy VIs already have built-i
error handling.
 Data Acquisition Basics Manual
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While Figure 11-1 shows how to write values for multiple channels, 
Figure 11-2 shows the diagram of the Generate 1 Point on 1 Channel 
located in labview\examples\daq\anlogout\anlogout.llb , which 
generates one value for one channel.

Figure 11-2.  Single Immediate Update Using the AO Update Channel VI

If you want more control over the limit settings for each channel, you a
can program a single-point update using the Intermediate Analog Outp
VI, AO Write One Update. Figure 11-3 shows an example of using this

Figure 11-3.  Single Immediate Update Using Intermediate VI

In this example, your program passes the error information to the Sim
Error Handler VI. The iteration  input optimizes the execution of this VI 
if you want to place it in a loop. For more information, look at the next 
section. With Intermediate VIs, you gain more control over when you c
check for errors.
LabVIEW Data Acquisition Basics Manual 11-2 © National Instruments Corporation
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Multiple-Immediate Updates
Figure 11-4 shows the block diagram of a VI that performs 
multiple updates. The Write N Updates example VI, located in 
labview\examples\daq\anlogout\anlogout.llb , is similar to 
Figure 11-4. The diagram shown in Figure 11-4 resembles the one sh
in Figure 11-3, except that the While Loop executes the subVI repeate
until either the error status or the stop Boolean is TRUE. You can use
Easy Analog Output VI, AO Write One Update, in a loop, but this is 
inefficient because the Easy I/O VIs configure the device every time th
execute. The AO Write One Update VI configures the device only when
value of the iteration  input is set to 0.

Figure 11-4.  Multiple Immediate Updates Using Intermediate VI

Figure 11-4 shows an immediate, software-timed analog output VI 
application. This means that software timing in a loop controls the upd
rate. One good reason to use immediate, software-timed output is that
application calculates or processes output values one at a time; howe
remember that software timing is not as accurate as hardware-timed an
output. For more information on hardware-timed analog output, refer t
Chapter 12, Buffering Your Way through Waveform Generation.
© National Instruments Corporation 11-3 LabVIEW Data Acquisition Basics Manual
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Buffering Your Way through 
Waveform Generation

In Chapter 10, Things You Should Know about Analog Output, you learned 
when to use buffered analog updates. This chapter shows you which V
use in LabVIEW to perform these updates.

Buffered Analog Output
You can program single-buffered analog output in LabVIEW using an E
Analog Output VI, AO Generate Waveforms VI, as shown in Figure 12
This VI writes an array of output values to the analog output channels
a rate specified by update rate. For example, if channels consists of 
two channels and the waveforms two-dimensional array consists of 
two columns containing data for the two channels, LabVIEW writes valu
from each column to the corresponding channels at every update inte
After LabVIEW writes all the values in the two-dimensional array to the
channels, the VI stops. The signal level on the output channels mainta
the value of the final value row in the two-dimensional array until 
another value is generated. If you use channel names configured in th
DAQ Channel Wizard in channels, waveforms is relative to the units 
specified in the DAQ Channel Wizard. Otherwise, waveforms is relative 
to volts.

Easy VIs contain error handling. If an error occurs in the AO Generate
Waveforms VI, a dialog box appears displaying the error number and 
description, and the VI stops running.
 Data Acquisition Basics Manual
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Figure 12-1.  Waveform Generation Using the AO Generate Waveforms VI

As with single-point analog output, you can use the Analog Output Util
VI, AO Waveform Gen VI, for most of your programming needs. This V
has several inputs and outputs that the Easy I/O VI does not have. You 
the option of having the data array generated once, several times, or 
continuously through the generation count input. Figure 12-2 shows an 
example diagram of how to program this VI. 

Figure 12-2.  Waveform Generation Using the AO Waveform Gen VI

In this example, LabVIEW generates the data in the array two times be
stopping.

The Generate N Updates example VI, located in labview\examples\ 

daq\anlogout\anlogout.llb , uses the AO Waveform Gen VI. Placing
this VI in a loop and wiring the iteration terminal of the loop to the iterati
input on the VI optimizes the execution of this VI. When iteration is 0, 
LabVIEW configures the analog output channels appropriately. If iterat
is greater than 0, LabVIEW uses the existing configuration, which 
improves performance. With the AO Waveform Gen VI, you also can 
specify the limit settings input for each analog output channel. For mo
LabVIEW Data Acquisition Basics Manual 12-2 © National Instruments Corporation
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information on limit settings, refer to Chapter 3, Basic LabVIEW Data 
Acquisition Concepts.

If you want even more control over your analog output application, use
set of Intermediate DAQ VIs, as shown in Figure 12-3.

Figure 12-3.  Waveform Generation Using Intermediate VIs

With these VIs, you can set up an alternate update clock source (such 
external clock or a clock signal coming from another device) or return 
update rate. The AO Config VI sets up the channels you specify for ana
output. The AO Write VI places the data in the buffer, the AO Start VI 
begins the actual generation at the update rate, and the AO Wait VI waits 
until the waveform generation completes. Then, the AO Clear VI 
unconfigures the analog channels.

The Generate Continuous Sinewave VI, located in labview\examples\ 

daq\anlogout\anlogout.llb , is similar in structure to Figure 12-3. 
This example VI continually outputs a sine waveform through the chan
you specify.
© National Instruments Corporation 12-3 LabVIEW Data Acquisition Basics Manual
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Changing the Waveform during 
Generation: Circular-Buffered Output

When the waveform data is too large to fit in a memory buffer or is 
constantly changing, use a circular buffer to output the data. You also can
use the Easy Analog Output VIs in a loop to create a circular-buffered
output; but this sacrifices efficiency because Easy VIs configure, alloc
and deallocate a buffer every time they execute, which causes time ga
between the data output. Figures 12-4 and 12-5 show two different way
perform circular-buffered analog output using the Intermediate VIs in 
LabVIEW. Figure 12-4 shows the AO Continuous Gen VI, which is mo
efficient than the Easy Analog Output VIs in that it configures and alloca
a buffer when its iteration  input is 0 and deallocates the buffer when the
clear generation input is TRUE.

Figure 12-4.  Circular Buffered Waveform Generation Using the AO Continuous Gen VI

With the AO Continuous Gen VI, you can configure the size of the dat
buffer and the limit settings of each channel. For more information on h
to set limit settings, refer to Chapter 3, Basic LabVIEW Data 
Acquisition Concepts.

The Continuous Generation example VI, located in labview\examples\ 

daq\anlogout\anlogout.llb , uses the AO Continuous Gen VI. In this
example, the data completely fills the buffer on the first iteration. On 
subsequent iterations, new data is written into one half of the buffer w
the other half continues to output data.
LabVIEW Data Acquisition Basics Manual 12-4 © National Instruments Corporation
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To gain more control over your analog output application, use the 
Intermediate VIs shown in Figure 12-5. With these VIs, you can set up
alternate update clock source and you can monitor the update rate the
actually uses. The AO Config VI sets up the channels you specify for 
analog output. The AO Write VI places the data in a buffer. The AO St
VI begins the actual generation at the update rate. The AO Write VI in the 
while loop writes new data to the buffer until you press the stop button
Then, the AO Clear VI unconfigures the analog channels. 

Figure 12-5.  Circular Buffered Waveform Generation Using Intermediate VIs

The Function Generator VI, located in labview\examples\daq\ 

anlogout\anlogout.llb , is a more advanced example than the one 
shown in Figure 12-5. This VI changes the output waveform on-the-fly
responding to changing signal types (sine or square), amplitude, offse
update rate, and phase settings on the front panel.
© National Instruments Corporation 12-5 LabVIEW Data Acquisition Basics Manual
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Eliminating Errors from Your 
Circular-Buffered Application

If you get error number –10843 underFlowErr , while performing 
circular-buffered output, it means your program can not write data fas
enough to the buffer to output the data at the update rate. To solve thi
problem, decrease the speed of the update rate. If adjusting the updat
does not get rid of the error in your application, increase the buffer siz

Buffered Analog Output Examples
You can find the example VIs mentioned in this chapter—Generate 
N Updates, Generate Continuous Sinewave, Continuous Generation, 
and Function Generator—in labview\examples\daq\anlogout\ 

anlogout.llb . Another example VI in this library you might find 
helpful, Display and Output Acq’d File (scaled) VI, is shown in 
Figure 12-6.

Figure 12-6.  Display and Output Acq’d File (Scaled) VI
LabVIEW Data Acquisition Basics Manual 12-6 © National Instruments Corporation
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You can use this VI in conjunction with the Cont Acq to File (scaled) V
located in labview\examples\daq\anlogin\anolgin.llb . The 
Display and Output Acq’d File (scaled) VI also is described in Chapter
Buffering Your Way through Waveform Generation. After running the 
Cont Acq to File (scaled) VI and saving your acquired data to disk, you 
run the Display and Output Acq’d File (scaled) VI to generate your dat
from the file you created. This example uses circular buffered output. If y
want to generate the data at the same rate at which it was acquired, y
must know the rate at which your data was acquired, and use that as 
update rate.
© National Instruments Corporation 12-7 LabVIEW Data Acquisition Basics Manual
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Letting an Outside Source 
Control Your Update Rate

Data acquisition (DAQ) devices use internal counters and timers to 
determine the rate of data generation. However, you might encounter ti
when you need to generate data in synch with other signals in your sys
For example, you might need to output data to a test circuit every time 
test circuit emits a pulse. In this case, internal counter/timers are ineffic
for your needs. You need to control the update rate with your own exte
source of pulses.

Externally Controlling Your Update Clock
Chapter 12, Letting an Outside Source Control Your Update Rate, 
mentions that for more control over your analog output applications, y
can use the Intermediate DAQ VIs. This chapter explains how to use th
Intermediate VIs to generate data using an external update clock.

The update clock controls the rate digital to analog conversions occur.
To control your data generation externally, you must supply this clock 
signal to the appropriate pin on the I/O connector of your DAQ device.
The clock source you supply must be a TTL signal. Figure 13-1 shows
Generate N Updates-ExtUpdateClk VI, located in labview\examples\

daq\anlogout\anlogout.llb , which applies this process.
 Data Acquisition Basics Manual
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Figure 13-1.  Generate N Updates-ExtUpdateClk VI

To use an external update clock, you must set the clock source of the 
AO Start VI to I/O connector . When you connect your external clock,
you find that different DAQ devices use different pins for this input. 
However, if you select Show VI Info… in the Windows menu of the 
example VI, you find that all the I/O connections are explained for you
These input pins also are described in Table 13-1.

For waveform generation, you must supply an array of waveform data
The example VI in Figure 13-1 uses data created in the Compute Wave
VI. When you run the example VI, the data is output on channel 0 
(the DAC0OUT pin) of your DAQ device.

Table 13-1.  External Update Clock Input Pins

Device Input External Update Clock Pin

All E-Series Devices 
with analog output

PFI5/UPDATE*

Non E-Series MIO type devices OUT2

Lab-PC+
1200 devices
AT-AO-6/10

EXTUPDATE*
LabVIEW Data Acquisition Basics Manual 13-2 © National Instruments Corporation
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Supplying an External Test Clock from Your DAQ Device
Suppose you want to use this external update clock approach, but you
not have your external clock available. You can create an external test c
using outputs from a counter/timer on your DAQ device, and then wire 
output to your external update clock source.

If your DAQ device has an FOUT or FREQ_OUT pin, you can generat
a 50% duty cycle TTL pulse train using the Generate Pulse Train 
on FOUT or FREQ_OUT VI, located in labview\examples\daq\ 

counter\DAQ-STC.llb . The advantage of this VI is that it does not us
one of the available counters, which you might need for other reasons

You can also use the Pulse Train VIs to create an external test clock. 
These VIs are located in examples\daq\counter\DAQ-STC.llb , 
examples\daq\counter\Am9513.llb , and 
examples\daq\counter\8253.llb .
© National Instruments Corporation 13-3 LabVIEW Data Acquisition Basics Manual
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Simultaneous Buffered 
Waveform Acquisition 
and Generation

In Chapter 7, Buffering Your Way through Waveform Acquisition, you 
learned how to acquire multiple data points via an intermediate softwa
buffer. In Chapter 12, Buffering Your Way through Waveform Generation, 
you learned how to generate multiple points of data by first writing the
to a software buffer. This chapter describes how to perform buffered 
waveform acquisition and generation simultaneously on the same 
DAQ device.

Using E-Series MIO Boards
E-series devices, such as the PCI-MIO-16E-1, have separate counter
dedicated to analog input and analog output timing. For this reason, th
are the easiest choice for simultaneous input/output.
 Data Acquisition Basics Manual
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Software Triggered
Figure 14-1 shows the diagram of the Simul AI/AO Buffered 
(E-series MIO) VI located in labview\examples\daq\anlog_io\ 

anlog_io.llb .

Figure 14-1.  Simultaneous Input/Output Using the
Simul AI/AO Buffered (E-series MIO) VI

This example VI uses familiar Intermediate DAQ VIs. This example VI
uses the same VIs you used for analog input in Chapter 7—AI Config,
AI Start, AI Read, and AI Clear—for waveform acquisition here. This 
example VI also uses the same VIs you used for analog output in 
Chapter 12—AO Config, AO Write, AO Start, and AO Clear—for 
waveform generation here. By following the error  cluster wire, which 
enters each DAQ VI on the bottom left and exits on the bottom right, y
can see that because of data dependency, the waveform generation s
before the waveform acquisition, and each task is configured to run 
continuously. This example VI is considered software triggered becaus
starts via software when you push the Run button.
LabVIEW Data Acquisition Basics Manual 14-2 © National Instruments Corporation
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Once you call the AO Start and AI Start VIs, the While Loop executes.
Inside the While Loop, the AI Read VI returns acquired data from the 
analog input buffer. There is not a call to the AO Write VI inside the Wh
Loop because it is not needed if the same data from the first AO Write
is regenerated continuously. If you want to generate new data each tim
While Loop iterates, you could add an AO Write VI inside the While Loo
The While Loop stops when an error occurs or you press the Stop button. 
Your DAQ device resources are cleared by calling the AI Clear and 
AO Clear VIs after the loop stops.

For a complete description, instructions, and I/O connections for this V
select Windows»Show VI Info… from the front panel of the VI.

Hardware Triggered
Figure 14-2 shows the diagram of the Simul AI/AO Buffered Trigger 
(E-series MIO) VI located in labview\examples\daq\anlog_io\

anlog_io.llb .

Figure 14-2.  Simultaneous Input/Output Using the
Simul AI/AO Buffered Trigger (E-series MIO) VI
© National Instruments Corporation 14-3 LabVIEW Data Acquisition Basics Manual
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Although this VI is similar to the example in Figure 14-1, it is more 
advanced because it uses a hardware trigger. The waveform acquisiti
trigger is set up with the trigger type input to the AI Start VI set to 
digital A  (start), and by default this trigger is expected on the PFI0 p
Hardware triggering for waveform generation requires an additional V
The AO Trigger and Gate Config VI is an advanced analog output VI f
E-series boards only. The trigger parameters are set using three inputs
trigger or gate source is used to choose the source of your trigger, suc
as a PFI pin or a RTSI pin. The trigger or gate source specification is 
used in conjunction with the trigger or gate source to choose which PFI 
or RTSI pin number to use, such as 0 through 9 for a PFI pin. The 
trigger or gate condition is used to select a rising or falling trigger edge
The default analog output trigger for this example is a rising edge on P
Because this is the same pin as the analog input trigger, the waveform
acquisition and generation starts simultaneously. However, they are n
controlled by independent counter/timers, so you can run them at diffe
rates.

For a complete description, instructions, and I/O connections for this V
select Windows»Show VI Info… from the front panel of the VI.

Using Legacy MIO Boards
Legacy MIO devices, such as the AT-MIO-16, have a total of five counte
of which two or more can be used for data acquisition and generation.
However, certain counters are dedicated to certain tasks, and you mu
aware of this as you design your system.

Software Triggered
Figure 14-3 shows the diagram of the Simul AI/AO Buffered (legacy MIO
VI located in labview\examples\daq\anlog_io\anlog_io.llb .
LabVIEW Data Acquisition Basics Manual 14-4 © National Instruments Corporation
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Figure 14-3.  Simultaneous Input/Output Using the
Simul AI/AO Buffered (Legacy MIO) VI

Because legacy MIO-type boards have only one clock available for sig
acquisition (scan timing) and generation (update timing), the same clo
is used for both. The acquisition uses counter 2  by default. The 
generation is set up to use the I/O connector at the clock source input to the 
AO Start VI. Because the I/O connector scan clock input is the OUT2 pin, 
which already has the acquisition timing signal on it, no external clock
wiring is required. The result is that the waveform acquisition and 
generation start simultaneously and occur at the same rate using the 
clock. Your waveform generation occurs at the same rate as the scan 
you choose for waveform acquisition.

For a complete description, instructions, and I/O connections for this V
select Windows»Show VI Info… from the front panel of the VI.
© National Instruments Corporation 14-5 LabVIEW Data Acquisition Basics Manual
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Hardware Triggered
Figure 14-4 shows the diagram of the Simul AI/AO Buffered Trigger 
(legacy MIO) VI located in labview\examples\daq\anlog_io\ 

anlog_io.llb .

Figure 14-4.  Simultaneous Input/Output Using the
Simul AI/AO Buffered Trigger (Legacy MIO) VI

The only difference between this example VI and the example in 
Figure 14-3 is the trigger type input to the AI Start VI is set to digital A  
(start) trigger. This sets up the waveform acquisition for a digital trigge
Because the waveform generation uses the same counter/timer as the
waveform acquisition, it also is dependent on the digital trigger.

For a complete description, instructions, and I/O connections for this V
select Windows»Show VI Info… from the front panel of the VI.
LabVIEW Data Acquisition Basics Manual 14-6 © National Instruments Corporation



Chapter 14 Simultaneous Buffered Waveform Acquisition and Generation

so 

ples 
 

d.
Using Lab/1200 Boards
Lab/1200 boards, such as the Lab-PC-1200 or the DAQCard-1200, al
can perform simultaneous waveform acquisition and generation. The 
approach is very similar to the previous descriptions. Refer to the exam
Simul AI/AO Buffered (Lab/1200) VI and Simul AI/AO Buffered Trigger
(Lab/1200) VI located in labview\examples\daq\anlog_io\ 

anlog_io.llb  to see how this acquisition and generation is performe
© National Instruments Corporation 14-7 LabVIEW Data Acquisition Basics Manual
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Getting Square with Digital I/O

This section describes basic concepts about how to use digital sign
with data acquisition in LabVIEW, including immediate and 
handshaked digital I/O.

Part IV, Getting Square with Digital I/O, contains the following chapters:

• Chapter 15, Things You Should Know about Digital I/O, explains basic 
concepts on digital I/O.

• Chapter 16, When You Need It Now— Immediate Digital I/O, explains 
how to use digital lines to acquire and generate data immediately.

• Chapter 17, Shaking Hands with a Digital Partner, shows you how 
you can synchronize digital data transfers between your DAQ devi
and instruments.
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Things You Should Know 
about Digital I/O

Digital I/O interfaces are often used to control processes, generate pat
for testing, and communicate with peripheral equipment like heaters, 
motors, and lights. Digital I/O components on DAQ devices and 
SCXI modules consist of hardware parts that generate or accept binar
on/off signals. As shown in the diagram below, all digital lines are group
into ports on DAQ devices and banks on SCXI modules. The number 
digital lines per port or bank is specific to the particular device or mod
used, but most ports or banks consist of four or eight lines. Except for
TIO-10 and E-Series devices, all lines within the same port or bank mus
be of the same direction (either input or output), as shown in Figure 15
By writing to or reading from a port, you can set or retrieve simultaneou
the states of multiple digital lines. Refer to Appendix B, Hardware 
Capabilities, of the LabVIEW Function and VI Reference Manual, your 
hardware user manual, or refer to the LabVIEW Online Reference, by 
selecting Help»Online Reference…, for port information on your device.

Figure 15-1.  Digital Ports and Lines

Data latches
and drivers

Data latches
and drivers

Device or Module

Output Port

Input Port

Output Lines

Input Lines
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Types of Digital Acquisition/Generation
There are two types of digital acquisition/generation—nonlatched 
(or immediate) and latched (or handshaked). With nonlatched or 
immediate digital I/O, your system updates the digital lines immediate
Latched or handshaked digital I/O is when a device or module accepts
transfers data after a digital pulse has been received. There are two ty
of latched (handshaked) digital I/O: non-buffered and buffered. Not all
devices and modules support latched (handshaked) digital I/O. Refer to
hardware tables in Appendix B, Hardware Capabilities, of the LabVIEW 
Function and VI Reference Manual, your hardware manual, or refer to the
LabVIEW Online Reference, by selecting Help»Online Reference…, to 
see if your device or module supports it.

For specific information about the Digital I/O VIs, refer to Chapter 14, 
Introduction to the LabVIEW Data Acquisition VIs, in the LabVIEW 
Function and VI Reference Manual, or refer to the LabVIEW Online 
Reference, by selecting Help»Online Reference….
LabVIEW Data Acquisition Basics Manual 15-2 © National Instruments Corporation
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When You Need It Now—
Immediate Digital I/O

This chapter focuses on transferring data across a single port. The mo
common way to use digital lines is with nonlatched (immediate) digital I/
All DAQ devices and SCXI modules with digital components support 
this mode.

When your program calls a function in nonlatched digital I/O mode, 
LabVIEW immediately updates the digital line or port output state or 
returns the current digital value of an input line, depending on the digit
line direction. LabVIEW inputs or outputs only one value on each digit
line in this mode. You can completely configure port (and sometimes li
direction in software, and you can switch directions repeatedly in a 
program if necessary. 

A typical example of when you might use nonlatched (immediate) digi
I/O is in controlling or monitoring relays. You can also use multiple por
or groups of ports to perform digital I/O functions. In order to group digi
ports, you must use Intermediate or Advanced VIs in LabVIEW. You ca
read more about grouping multiple digital ports in the next chapter, 
Chapter 17, Shaking Hands with a Digital Partner.
 Data Acquisition Basics Manual
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You can use the Easy Digital VIs for nonlatched digital I/O. Figure 16-1
shows the Easy VIs and their various inputs and outputs. The four Easy
can read data from or write data to a single digital line or to an entire p
immediately. For an example of how to use the Easy Digital VIs, refer 
the Read 1 Point from Digital Line and Write 1 Point to Digital Line VIs i
labview\examples\daq\digital\digio.llb . Use the Easy Digital 
VIs for most digital testing purposes. All of the Easy Digital VIs have err
reporting. 

Figure 16-1.  The Easy Digital VIs

If you have configured channels using the DAQ Channel Wizard, 
digital channel can consist of a digital channel name. The channel nam
may refer to either a port or a line in a port. You do not need to specify
device, line, or port  width  as these inputs are not used by LabVIEW if a
channel name is specified in digital channel. For more information about 
using the DAQ Channel Wizard to configure your channels, refer to the
Configuring Your Channels in NI-DAQ 5.x, 6.0 section of Chapter 2, 
Installing and Configuring Your Data Acquisition Hardware. For more 
information about using channel names, refer to the Channel Name 
Addressing section of Chapter 3, Basic LabVIEW Data 
Acquisition Concepts.
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As an alternative, digital  channel can consist of a port number. The port
number specifies the port of digital lines that you will use during your 
digital operation. In this case, you must also specify device, line, and 
port width  where applicable to further define your digital operation. 
Thedevice input identifies the DAQ device you are using. The line input is 
an individual port bit or line in the port specified by digital channel. The 
port  width  input specifies the number of lines that are in the port you a
using.

The pattern or line state is the value(s) you want to read from or write to
a device. Pattern values can be displayed in decimal (default), hexadec
octal, or binary form. Refer to Chapter 9, Numeric Controls and Indicators, 
in the G Programming Reference Manual for instructions on how to change
the display of a numeric control or indicator. The iteration  input optimizes 
your digital operation. When iteration  is zero (the default value), 
LabVIEW calls the DIO Port Config VI (an Intermediate VI) to configur
the port. If iteration  is greater than zero, LabVIEW uses the existing 
configuration, which improves performance. You can wire this input to
an iteration terminal of a loop. Every time iteration  is zero, you call the 
DIO Port Config VI, which resets the digital line values to their default 
values. If you want to use the same digital values from one loop iteratio
another, only set iteration  to zero for the first iteration of the loop, then 
change it to a value greater than zero.

If you are using an SCXI module for nonlatched digital I/O and are not
using channel names, refer to the SCXI Channel Addressing section in 
Chapter 20, Special Programming Considerations for SCXI, for 
instructions on how to specify port numbers.
© National Instruments Corporation 16-3 LabVIEW Data Acquisition Basics Manual
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Shaking Hands with 
a Digital Partner

You have just learned that in LabVIEW using non-latched (immediate)
digital I/O, you can use digital lines to acquire and generate data. But w
if you want to pass a digital pattern after receiving a digital pulse? In th
case, you should use latched digital I/O, also called handshaking. For 
example, you may want to acquire an image from a scanner. The sca
sends a pulse to your DAQ device after the image has been scanned 
is ready to transfer the data. Then, your DAQ device reads a digital pat
which can be 8, 16, or 32 bits in length. Your DAQ device then sends 
pulse to the scanner to let it know the digital pattern has been read. T
scanner sends out another pulse when it is ready to send another digi
pattern. After your DAQ device receives this digital pulse, it reads the d
This process repeats until all the data is transferred. As you can see, 
ability to handshake gives you the ability to synchronize digital data 
transfer between your DAQ device and instrument.

The following list shows the DAQ devices that support digital handshak

• AT-MIO-16D

• AT-MIO-16DE-10

• 1200 Series devices

• DIO-24 (DAQCard, NB, and PC, including PnP)

• DIO-32F (NB and AT)

• DIO-32HS (AT and PCI)

• DIO-96 (PCI, NB, PCI, and PC, including PnP)

• Lab Series devices (NB, LC, and PC)

Note Combining channel names configured in the DAQ Channel Wizard and 
handshaking are not supported in LabVIEW 5.0.
 Data Acquisition Basics Manual
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Another example of when you can use handshaking is if you wanted t
test the durability of a product prototype. Each durability test would be
performed with a different piece of machinery for the same amount of 
time. For each test, you can turn the machinery on and off with a spec
variation of handshaked digital I/O, known as pattern generation. Internal 
counters would serve to generate the handshaking signal that initiates
a digital transfer. Counters output digital pulses at a steady frequency.
Thus, you can generate and retrieve patterns at a constant rate becau
handshaking signal would be produced at a constant rate. However, y
can use this rate only if the instrument or external hardware does not w
with or require communication signals for its data transfers. Only the 
DIO-32 Series devices support pattern generation.

If you have an external signal controlling your digital I/O operation, 
you should connect the outside signal to the I/O connector or the 
RTSI connector. For more information on these connectors, refer to yo
hardware manual for your device. The names and functions of handsha
signals vary. For the DIO-32 Series devices, there are two handshakin
lines—the REQ (request) line and the ACK (acknowledge) line. Use th
REQ line as the handshaking line to trigger digital input. You can use 
ACK line as the handshaking line to trigger digital output. 

For all other 8255-based DAQ devices that perform handshaking, there
four handshaking signals: Strobe Input (STB), Input Buffer Full (IBF), 
Output Buffer Full (OBF), and Acknowledge Input (ACK). You use the 
STB and IBF signals for digital input operations and the OBF and ACK
signals for digital output operations. When the STB line is low, LabVIE
loads data into the DAQ device. After the data has been loaded, IBF is h
which tells the external device that the data has been read. For digital
output, OBF is low while LabVIEW sends the data to an external devic
After the external device receives the data, it sends a low pulse back o
ACK line. Check your DAQ device hardware manual for information on
which digital port(s) can be configured for handshaking signals.

For all the DAQ devices that support handshaking, there are separate
handshaking lines for each digital port.
LabVIEW Data Acquisition Basics Manual 17-2 © National Instruments Corporation
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Sending Out Multiple Digital Values
You can group multiple ports together so you can send more digital va
out at a time. The order of grouped ports affects which handshaking li
you use. If you want to group ports 0 and 1 and you list the ports in the o
of 0:1 , then you should use the handshaking lines associated with po
In other words, always use the handshaking lines associated with the 
port in the list. So, if the ports are listed 1:0 , then you should use the 
handshaking lines associated with port 0. 

For 8255-based devices that perform handshaking, you must connect a
STB lines together if you are using more than one port or grouping po
for digital input, as shown in Figure 17-1. Connect only the IBF line of t
last port in the port list to the other device. No connection is needed for
IBF signals for the other ports in the port list.

Figure 17-1.  Connecting Signal Lines for Digital Input

Port x 1

STB*

IBF

External Device

(last port in portList)

Port x n

STB*

IBF

Port x 2

STB*

IBF
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If you use more than one port or grouping ports for digital output on 
DAQ devices other than DIO-32 Series devices, connect only the 
handshaking signals of the last port in the port list, as shown in Figure 1

Figure 17-2.  Connecting Digital Signal Lines for Digital Output

There are two types of digital handshaking: non-buffered and buffered
Non-buffered handshaking is similar to nonlatched digital I/O because
LabVIEW updates the digital lines immediately after every digital or 
handshaked pulse.

Note For the DIO-32HS devices, LabVIEW returns immediately after storing data in
its FIFO.

With buffered handshaking, LabVIEW stores digital values in memory 
be transferred after every handshaked pulse. Both non-buffered and 
buffered handshaking transfer only one digital value after each handsh
pulse. For basic digital applications, use non-buffered handshaking. U
buffered handshaking when your application requires multiple 
handshaking pulses to be created. By using a buffer with multiple 
handshaking pulses, the software spends less time reading or writing 
leaving more time for other operations.

Note On the DIO-32 Series devices with non-buffered handshaking, you can group
2, or 4 ports together. For buffered handshaking on the DIO-32 Series devices
you can group only 2 or 4 ports together.

Port x 1

ACK*

External Device

(last port in portList)

Port x n

Port x 2

ACK*

ACK*

OBF*

OBF*

OBF*
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You can use only Intermediate or Advanced Digital VIs for digital 
handshaking in LabVIEW. The Intermediate VIs work for most all 
non-buffered and buffered digital handshaking applications. However, 
some DAQ devices, you may need to use a combination of Intermediate
Advanced VIs.

Non-Buffered Handshaking
Non-buffered handshaking takes place when your program transfers o
digital value after receiving a digital pulse on the handshaking lines. 
LabVIEW does not store these digital values in computer memory. Yo
should only use non-buffered handshaking when you expect only a fe
digital handshaking pulses. For multiple-pulsed applications, you shou
use buffered handshaking, which you can learn about in the next sectio
this chapter, Buffered Handshaking. Figure 17-3 shows an example of 
non-buffered handshaking using the Intermediate VI, DIO Single 
Read/Write. In this example, LabVIEW reads the data from the digital 
port(s).

Figure 17-3.  Non-Buffered Handshaking Using the DIO Single Read/Write VI

Typically, you want to put the DIO Single Read/Write VI inside a loop.
You can use the iteration  input (the terminal where the loop iteration is 
connected) to optimize your digital operation. When iteration  is 0 
(default), LabVIEW calls the Advanced VI, DIO Group Config, to 
configure the port(s). If iteration  is greater than zero, LabVIEW uses the
existing configuration, which improves performance. Every time your 
program calls the DIO Group Config VI, the digital line values are rese
their default values. If you want to set the digital line values once and k
the same values from one loop iteration to the next, set iteration  to 0 on the 
first iteration of the loop, then set iteration  to 1. When group direction is 
© National Instruments Corporation 17-5 LabVIEW Data Acquisition Basics Manual
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equal to 1 (default), all the ports listed in port list  are treated as inputs. 
The number of elements in the data read input will be the same as the 
product of the number of ports in the group and the number to read input. 

Figure 17-4 shows how you can use non-buffered handshaking to 
write data. The programming flow resembles the read operation above
Theupdates to write array must contain as many elements as the num
of ports multiplied by the number of values to write. 

Figure 17-4.  Non-Buffered Handshaking Using the DIO Single Read/Write VI

Buffered Handshaking
Buffered handshaking allows you to store multiple points in computer 
memory. Use this technique if multiple pulses are expected on the 
handshaking lines. Buffered handshaking comes in two forms: simple 
circular. You can use simple-buffered handshaking on all DAQ device
that support handshaking; but you can perform circular-buffered 
handshaking only on the AT-DIO-32F and DIO-32HS devices. You ca
think of a simple buffer as a storage place in computer memory, wher
buffer size equals the number of updates multiplied by the number of po
A circular buffer differs from a simple buffer only in the way your progra
places the data into it and retrieves data from it. A circular buffer fills 
with data the same as a simple buffer, but when it gets to the end of th
buffer LabVIEW returns to the beginning of the buffer and fills up the 
same buffer again. You should use simple-buffered handshaking whe
you have a predetermined number of values to acquire or generate. U
circular-buffered handshaking when you want to acquire or generate d
continuously.
LabVIEW Data Acquisition Basics Manual 17-6 © National Instruments Corporation
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Simple Buffered Examples
The block diagram in Figure 17-5 uses the Intermediate VIs to perform
pattern generation using the DIO-32 Series devices. An example VI 
included with LabVIEW similar to the diagram below is the Digital 
Buffered Handshaking VI, found in labview\examples\daq\ 

digital\digio.llb . Notice the port list  contains more than one port 
number, which means the ports are grouped together. 

Figure 17-5.  Pattern Generation Using the DIO-32 Series Devices

The For Loop generates the digital data to output. The amount of data
generated equals the number of ports in the port list  multiplied by the 
number of updates. The direction input specifies whether the ports 
are configured for input or output. The DIO Wait VI waits until the digita
buffered input or output operation completes before returning to the 
main VI. The DIO Clear VI halts any transfers and clears the group po
configuration. If you want an external source to supply the handshakin
signals, you can specify the handshake source to be an external signal 
entering through the I/O connector (handshake source = 2 which is the 
default value) or the RTSI connector (handshake source = 3). You only 
need to use the clock frequency if you are performing pattern generation
(having an internal handshake source).
© National Instruments Corporation 17-7 LabVIEW Data Acquisition Basics Manual
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For DAQ devices other than the DIO-32 Series devices, you can use a
similar to the one above to output digital data. The main difference is t
you use an Advanced Digital VI, DIO Buffer Control, instead of the 
DIO Start VI, as shown in Figure 17-6. You should use the DIO Buffer 
Control VI because the DIO Start VI contains Digital Clock Config and
Digital Mode Config VIs that work only with the DIO-32 Series devices
You do not need to use the Handshake source and clock frequency inputs, 
because of the external handshaking signal source.

Figure 17-6.  Pattern Generation Using DAQ Devices 
(Other Than DIO-32 Series Devices)

Reading information is similar to writing data when using digital 
handshaking. In the example shown in Figure 17-7, the VI is reading d
into the DIO-32 Series devices while using external handshaking. For 
the DIO-32 Series devices, the DIO Config VI can set or change the 
handshaking mode, for instance whether you trigger digital communica
on an edge or at a certain level.

Figure 17-7.  Reading Data with the Digital VIs Using Digital Handshaking 
(DIO-32 Series Devices)
LabVIEW Data Acquisition Basics Manual 17-8 © National Instruments Corporation
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For the other devices that support digital handshaking, the example w
be the same as above except the handshaking mode input would be deleted 
from the DIO Config VI and the DIO Start VI would be replaced with th
DIO Buffer Control VI. Also, you do not need the handshake source 
andclock frequency inputs for most devices, because of the external 
handshaking signal source. Figure 17-8 shows the VI used for all 
DAQ devices other than the DIO-32 Series.

Figure 17-8.  Reading Data with the Digital VIs Using Digital Handshaking

Circular-Buffered Examples
Circular-buffered handshaking is similar to simple-buffered handshaki
in that both types of handshaking place data in a buffer; however, a circ
buffer application returns to the beginning of the buffer when it reaches
end, and fills the same buffer again. 

Note Remember that circular-buffered handshaking works only on the AT-DIO-32F 
and DIO-32HS devices. 
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Figure 17-9 shows an example of a circular-buffered application. In thi
example, you are reading or writing digital values continually until you st
the VI or an error occurs. In order to create a circular buffer, you must cr
a buffer that is at least twice as large as the number of scans/updates
want to read at a time. You can have an internal or external handshake 
source. If your handshake source is internal, remember to specify the rat
at which you read values with the clock frequency. Scan backlog specifies 
how many values are left in the buffer after you read. The number read 
input indicates the total number of values that have been read from th
buffer because the VI started executing. 

Figure 17-9.  Digital Handshaking Using a Circular Buffer

Digital handshaking, whether non-buffered or buffered, inputs or outpu
digital patterns only after your computer receives a digital pulse. Not a
DAQ devices support digital handshaking. The DIO-32 Series devices
have internal as well as external handshaking signals and support 
circular-buffered I/O. Other DAQ devices that support handshaking acc
only external handshaking signals. You should use digital handshaking
when you need to generate or retrieve a digital pattern after a digital ev
or pulse, is detected. 
LabVIEW Data Acquisition Basics Manual 17-10 © National Instruments Corporation
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SCXI—Getting Your Signals 
in Great Condition

This section contains basic information about setting up and using 
SCXI modules with your data acquisition application, special 
programming considerations, common SCXI applications, and 
calibration information.

Part V, SCXI—Getting Your Signals in Great Condition, contains the 
following chapters:

• Chapter 18, Things You Should Know about SCXI, includes basic 
concepts on how to use SCXI modules with LabVIEW for data 
acquisition.

• Chapter 19, Hardware and Software Setup for Your SCXI System, 
explains how to set up your SCXI hardware to work with data 
acquisition in LabVIEW.

• Chapter 20, Special Programming Considerations for SCXI, describes 
special programming considerations for SCXI in LabVIEW which 
include channel addressing, gains (limit settings), and settling time

• Chapter 21, Common SCXI Applications, cover example VIs for 
analog input, analog output, and digital SCXI module.

• Chapter 22, SCXI Calibration—Increasing Signal Measurement 
Precision, teaches you how to calibrate SCXI modules and shows y
where LabVIEW stores your calibration constants.
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Things You Should Know 
about SCXI

Signal Conditioning eXtensions for Instrumentation (SCXI) is a 
highly-expandable signal conditioning system. The next few chapters 
describe the basic concepts of signal conditioning, the setup procedur
SCXI hardware, the hardware operating modes, the procedure for softw
installation and configuration, the special programming considerations
SCXI in LabVIEW, and some common SCXI applications.

Note For a better understanding of signal conditioning concepts, the chapters in
Part V refer to SCXI. However, the concepts and techniques discussed in thes
chapters also apply to VME eXtension for Instrumentation Signal Conditioning
(VXI-SC).

What Is Signal Conditioning?
Electrical signals can be generated by transducers to measure physic
phenomena, such as temperature, force, sound, or light. Table 18-1 lis
some common transducers.

Table 18-1.  Phenomena and Transducers

Phenomena Transducer

Temperature Thermocouples
Resistance temperature detectors (RTDs)
Thermistors
Integrated circuit sensor

Light Vacuum tube photosensors
Photoconductive cells

Sound Microphone

Force and pressure Strain gauges
Piezoelectric transducers
Load cells
 Data Acquisition Basics Manual
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To measure signals from transducers, you must convert them into a fo
that a data acquisition (DAQ) device can accept. For example, the out
voltage of most thermocouples is very small and susceptible to noise.
Therefore, you may need to amplify and/or filter the thermocouple out
before digitizing it. The manipulation of signals to prepare them for 
digitizing is called signal conditioning. The following are some common 
types of signal conditioning.

• Amplification

• Isolation

• Filtering

• Transducer excitation

• Linearization

Figure 18-1 shows some common types of transducers/signals and th
required signal conditioning for each.

Position 
(displacement)

Potentiometers
Linear voltage differential transformer 
(LVDT)
Optical encoder

Fluid flow Head meters
Rotational flowmeters
Ultrasonic flowmeters

pH pH electrodes

Table 18-1.  Phenomena and Transducers (Continued)

Phenomena Transducer
LabVIEW Data Acquisition Basics Manual 18-2 © National Instruments Corporation
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Figure 18-1.  Common Types of Transducers/Signals and Signal Conditioning

Amplification
The most common type of signal conditioning is amplification. The two 
advantages to amplifying electrical signals are that it improves the accu
of the resulting digitized signal and that it reduces noise.

For the highest possible accuracy, amplify the signal so the maximum
voltage swing equals the maximum input range of the analog-to-digita
converter (ADC) (otherwise known as a digitizer). Your system should
amplify low-level signals at the DAQ device or at the SCXI module loca
nearest to the signal source, as shown in Figure 18-2.

Figure 18-2.  Amplifying Signals near the Source to Increase Signal-to-Noise Ratio

Transducers/Signals

Thermocouples

RTDs

Strain Gauges

Common Mode
or High Voltages

Loads Requiring AC Switching
or Large Current Flow

Signals with High
Frequency Noise

Signal Conditioning

Current Excitation, Four Wire
and Three Wire Configuration,

Linearization

Amplification, Linearization, and
Cold-Junction Compensation

Voltage Excitation Bridge
Configuration, and Linearization

Isolation Amplifiers
(Optical Isolation)

Electromechanical Relays
or Solid-State Relays

Lowpass Filters

DAQ Board

+
- ADC

DAQ Board

Instrumentaion
Amplifier

MUX

Low-Level Signal
External
Amplifier

Lead Wires

Noise
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Note You can minimize noise that lead wires pick up by using shielded cables or a 
twisted pair of cables, and by minimizing wire length. Also, keeping signal wire
away from AC power cables and monitors will help reduce 50 Hz or 60 Hz nois

If you amplify the signal at the DAQ device, the signal is measured an
digitized with noise that may have entered the lead wires. However if y
amplify the signal close to the signal source with an SCXI module, no
has a less destructive effect on the signal. In other words, the digitized
representation is a better reflection of the original low-level signal. For
more information, consult Application Note 025, Field Wiring and Noise 
Considerations for Analog Signals. You can access this note from the 
NI Fax-on-Demand system as well as the BBS, World Wide Web, or 
FTP site, the numbers for which are located in the front of this manual

Isolation
Another common way to use SCXI is to isolate the transducer signals f
the computer for safety purposes. When the signal being monitored 
contains large voltage spikes that could damage the computer or harm
operator, you should not directly connect the signal to a DAQ device 
without some type of isolation. Another reason for isolation is to make s
that the measurements from the DAQ device are not affected by differe
in ground potentials. When the DAQ device and the signal are not 
referenced to the same ground potential, a ground loop may occur. Gro
loops can cause an inaccurate representation of the measured signal.
potential difference between the signal ground and the DAQ device gro
is large, then damage may even occur to the measuring system. Usin
isolated SCXI modules will eliminate the ground loop and ensure that 
signals are accurately measured.

Filtering
Signal conditioning systems can filter unwanted signals or noise from 
signal you are trying to measure. You can use a noise filter on low-rat
(or slowly-changing) signals, like temperature, to eliminate 
higher-frequency signals that can reduce the accuracy of the digitized
signal. A common use of a filter is to eliminate the noise from a 60 Hz
AC power line. A lowpass filter of 4 Hz, which exists on several SCXI 
modules, is suitable for removing the 60 Hz AC noise from signals samp
at low rates. A lowpass filter eliminates all signal frequency componen
above the cutoff frequency. The SCXI-1141 module has lowpass filters 
have software-selectable cutoff frequencies from 10 Hz to 25 kHz. 
LabVIEW Data Acquisition Basics Manual 18-4 © National Instruments Corporation
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Transducer Excitation
Signal conditioning systems can generate excitation for some transdu
Strain gauges and RTDs require external voltage and currents, respect
to excite their circuitry into measuring physical phenomena. This type 
excitation is similar to a radio which needs power to receive and deco
audio signals. Some plug-in DAQ devices and SCXI modules, includin
the SCXI-1121 and SCXI-1122 modules, provide the necessary excita
for transducers.

Linearization
Many transducers, such as thermocouples, have a nonlinear response
changes in the physical phenomena being measured. LabVIEW can 
linearize the voltage levels from transducers, so the voltages can be sc
to the measured phenomena. LabVIEW provides simple scaling functi
to convert voltages from strain gauges, RTDs, thermocouples, and 
thermistors. 

For specific information about the VIs you can use with your SCXI modu
in LabVIEW, refer to Chapter 29, Calibration and Configuration VIs, in 
the LabVIEW Function and VI Reference Manual, or refer to the LabVIEW 
Online Reference, by selecting Help»Online Reference….
© National Instruments Corporation 18-5 LabVIEW Data Acquisition Basics Manual
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Hardware and Software Setup 
for Your SCXI System

SCXI hardware provides signal conditioning close to the signal source 
increases the number of analog and digital signals that can be analyze
a data acquisition (DAQ) device. With PC compatible computers, SCX
can be configured in two ways—a front-end signal conditioning system
plug-in DAQ devices, or an external data acquisition and control syste
Furthermore, when SCXI is configured as an external data acquisition
control system, it can be connected to the computer’s parallel port usin
SCXI-1200, or the computer’s serial port using either an SCXI-2000 
remote chassis or an SCXI-2400 remote communications module in a
SCXI-100x chassis. For Macintosh computers, SCXI hardware can onl
used as a front-end signal conditioning system for plug-in DAQ device
Figure 19-1 demonstrates these configurations.

Figure 19-1.  SCXI System
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Figure 19-2 shows the components of an SCXI system. An SCXI syste
consists of an SCXI chassis that houses signal conditioning modules, 
terminal blocks that plug directly into the front of the modules, and a ca
assembly that connects the SCXI system to a plug-in DAQ device or t
parallel or serial port of a computer. If you are using SCXI as an exter
DAQ system where there are no plug-in DAQ devices, you can use the
SCXI-1200 module, which is a multifunction analog, digital, and timing
I/O (counters) module. The SCXI-1200 can control several SCXI signa
conditioning modules installed in the same chassis. The functionality of
SCXI-1200 module is similar to the plug-in 1200 series devices.

Figure 19-2.  Components of an SCXI System

Refer to the SCXI tables in Appendix B, Hardware Capabilities, of the 
LabVIEW Function and VI Reference Manual, for tables containing 
specifications for all the SCXI modules, or refer to the LabVIEW Online 
Reference, by selecting Help»Online Reference…. This appendix also 
includes a list of all the SCXI modules and the compatible terminal blo

How do you connect the transducers to the SCXI modules? How do you
the jumpers on the SCXI modules before they are placed in the chassis
information on how to set up each module and transducer, consult you
hardware user manuals and the Getting Started with SCXI manual. 

How do you transfer data from the SCXI chassis to the DAQ device or
parallel or serial port? Figure 19-3 shows a diagram of an SCXI chass
When you use SCXI as a front-end signal conditioning system, the ana
and digital bus backplane, also known as the SCXIbus, transfers anal
and/or digital data to the DAQ device. Some of the analog and digital li
on the DAQ device are reserved for SCXI chassis communication. To f
out which lines are reserved on your device, refer to the tables in 

SCXI

1140 

SCXI

1140 

SCXI-1001

MAINFRAME 

SCXI

Terminal
Blocks

Signal
Conditioning

and/or
Data Acquisition

Modules

SCXI Chassis SCXI
Cable Assembly
(or Parallel Port
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Plug-in
DAQ Board
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Personal Computer
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Appendix B, Hardware Capabilities, in the LabVIEW Function and VI 
Reference Manual, or refer to the LabVIEW Online Reference, by selecting 
Help»Online Reference….

Figure 19-3.  SCXI Chassis

When you use SCXI as an external DAQ system, only some of the dig
I/O lines of the DAQ device are reserved for SCXI chassis communica
when other modules are present. The DAQ device digitizes any analo
input data and transfers it back to the computer through the parallel or
serial port.

Note When using Remote SCXI, be aware of the sampling rate limitations due to th
fact that the data is sent over the serial port. To reduce delays in serial port 
communication, National Instruments recommends that you use the fastest ba
rate possible for your computer’s serial port. If you have a 16550 or compatibl
universal asynchronous receiver-transceiver (UART), you can use baud rates 
to 57,600 baud. If you have an 8250 or compatible UART, you can only use up
19,200 baud.

SCXI-1000

SCXI
MAINFRAME

Unconditioned Signals
from Transducers

Analog and Digital
Bus Backplane

Conditioned Signals to
DAQ Board or 

Parallel Port
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SCXI Operating Modes
The SCXI operating mode determines the way that DAQ devices 
access signals. There are two basic operating modes for SCXI module
multiplexed and parallel. You designate the mode in the operating mode 
input in the configuration utility. Also, you may have to set up jumpers 
the module for the correct operating mode. Check your SCXI module u
manual for more information.

Note National Instruments recommends that you use the multiplexed mode for mos
purposes.

Multiplexed Mode for Analog Input Modules
When an analog input module operates in multiplexed mode, all of its 
input channels are multiplexed to one module output. When you cable
DAQ device to a multiplexed analog input module, the DAQ device ha
access to that module's multiplexed output, as well as all other module
in the chassis through the SCXIbus. The analog input VIs route the 
multiplexed analog signals on the SCXIbus for you transparently. So, 
you operate all modules in the chassis in multiplexed mode, you only n
to cable one of the modules directly to the DAQ device.

Note MIO/AI devices, and Lab-PC+ and 1200 devices support multiple-channel and
multiple-scan acquisitions in multiplexed mode. The Lab-NB and Lab-LC, 
LPM devices, and DAQCard-700 support only single-channel or single-scan 
acquisitions in multiplexed mode. 

When you cable a DAQ device to a multiplexed module, the multiplexe
output of the module (and all other multiplexed modules in the chassis
appears at analog input channel 0 of the DAQ device by default.

Multiplexed Mode for the SCXI-1200 (Windows)
In multiplexed mode, the SCXI-1200 can access the analog signals on
SCXI bus. The DAQ VIs can multiplex the channels of analog input 
modules and send them on the SCXI bus.This means that if you config
the SCXI-1200 for multiplexed mode, you can read the multiplexed out
from other SCXI analog input modules in the chassis.

Note The SCXI-1200 only reads analog input module channels configured in 
multiplexed mode, not in parallel mode.
LabVIEW Data Acquisition Basics Manual 19-4 © National Instruments Corporation
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Make sure that you change the jumper in the SCXI-1200 to the ground
position to connect the SCXI-1200 and SCXIbus grounds together. Refe
the SCXI-1200 User Manual for more details.

Multiplexed Mode for Analog Output Modules
Because LabVIEW communicates with the multiplexed modules over 
SCXIbus backplane, you must only cable one multiplexed module in e
chassis to a DAQ device to communicate with any multiplexed module
the chassis.

Multiplexed Mode for Digital and Relay Modules
Multiplexed mode is referred to as serial mode in the digital and relay 
module hardware manuals. When you operate your digital or relay mod
in multiplexed mode, LabVIEW communicates the module channel sta
serially over the SCXIbus backplane.

Parallel Mode for Analog Input Modules
When an analog input module operates in parallel mode, the module 
sends each of its channels directly to a separate analog input channel 
DAQ device cabled to the module. You cannot multiplex parallel outputs 
of a module on the SCXIbus. You must cable a DAQ device directly to
module in parallel mode to access its input channels. In this configurat
the number of channels available on the DAQ device limits the total 
number of analog input channels. In some cases, however, you can c
more than one DAQ device to separate modules in an SCXI chassis. 
example, you can use two NB-MIO-16X or AT-MIO-16E-2 devices 
operating in parallel mode and cable each one to a separate SCXI-11
module in the chassis. For more information on how to configure the cab
device, refer to the NI-DAQ Configuration Utility Online Help file in 
Windows, or the Installing and Configuring Your SCXI Chassis section in 
Chapter 2, Installing and Configuring Your Data Acquisition Hardware, 
for the Macintosh.

By default, when a module operates in parallel mode, the module send
channel 0 output to differential analog input channel 0 of the DAQ devi
the channel 1 output to analog input channel 1 of the DAQ device, and
so on.
© National Instruments Corporation 19-5 LabVIEW Data Acquisition Basics Manual
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When you use the analog input VIs, specify the correct onboard channe
each parallel SCXI channel. If you are using a range of SCXI channel
LabVIEW assumes the onboard channel numbers match the SCXI cha
numbers. Refer to the SCXI Channel Addressing section in Chapter 20, 
Special Programming Considerations for SCXI, for the proper SCXI 
channel syntax.

Parallel Mode for the SCXI-1200 (Windows)
In parallel mode, the SCXI-1200 reads only its own analog input chann
The SCXI-1200 does not have access to the analog bus on the SCXI 
backplane in parallel mode. You should use parallel mode if you are n
using other SCXI analog input modules in the chassis with the SCXI-12

Parallel Mode for Digital Modules
When you operate a digital module in parallel mode, the digital lines o
your DAQ device directly drive the individual digital channels on your 
SCXI module. You must cable a DAQ device directly to every module 
operated in parallel mode.

You may want to use parallel mode instead of multiplexed mode for fas
updating or reading of the SCXI digital channels. For the fastest 
performance in parallel mode, you can use the appropriate onboard p
numbers instead of the SCXI channel string syntax in the digital VIs. Re
to the hardware tables in Appendix B, Hardware Capabilities, in the 
LabVIEW Function and VI Reference Manual for the digital ports used in 
parallel mode on each DAQ device, or refer to the LabVIEW Online 
Reference, by selecting Help»Online Reference….

Note If you are using a DIO-96, an AT-MIO-16D, or an AT-MIO-16DE-10 device, you
can also operate a digital module in parallel mode using the digital ports on th
second half of the NB5 or R1005050 ribbon cable (lines 51 – 100). Therefore, the 
DIO-96 can operate two digital modules in parallel mode, one module using th
first half of the ribbon cable (lines 1 – 50), and another module using the second
half of the ribbon cable (lines 51 – 100). 

SCXI Software Installation and Configuration
After you assemble your SCXI system, you must run the configuration
utility to enter your SCXI configuration. LabVIEW needs the configuratio
information to program your SCXI system correctly. Refer to Chapter 2
Installing and Configuring Your Data Acquisition Hardware.
LabVIEW Data Acquisition Basics Manual 19-6 © National Instruments Corporation
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Special Programming 
Considerations for SCXI

When you want LabVIEW to acquire data from SCXI analog input 
channels, you use the analog input VIs in the same way that you acqu
data from onboard channels. You also read and write to your SCXI re
and digital channels using the digital VIs in the same way that you read
write to onboard digital channels. You can write voltages to your SCX
analog output channels using the analog output VIs. The following sect
describe special programming considerations for SCXI in LabVIEW wh
include channel addressing, gains (limit settings), and settling time.

Note This chapter does not apply if you use the DAQ Channel Wizard to configur
your channels. If you use the DAQ Channel Wizard, you address SCXI 
channels the same way you address on-board channels—by specifying the
channel name(s). LabVIEW configures your hardware by selecting the bes
input limits and gain for the named channel based on the channel 
configuration. For more information about using the DAQ Channel Wizard to 
configure your channels, see the Configuring Your Channels in NI-DAQ 5.x, 6.0 
section of Chapter 2, Installing and Configuring Your Data Acquisition Hardware. 
For more information about using channel names, refer to the Channel Name 
Addressing section of Chapter 3, Basic LabVIEW Data Acquisition Concepts.

SCXI Channel Addressing
If you operate a module in parallel mode, you can specify an SCXI chan
either by specifying the corresponding onboard channels or by using t
SCXI channel syntax described in this section. If you operate the mod
in multiplexed mode, you must use the SCXI channel syntax. 

An SCXI channel number has four parts: the onboard channel (option
the chassis ID, the module number, and the module channel.

In the following table of examples, x  is any chassis ID, y  is any module 
number, a is any module channel, and b is any module channel greater 
thana. z is the onboard channel from which the conditioned data is 
retrieved. If you operate in multiplexed mode, analog input channel 0 re
 Data Acquisition Basics Manual
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the data from the first cabled chassis. If you use VXI-SC submodules,
LabVIEW ignores the onboard channel, since VXI-DAQ provides a spec
channel for retrieving data from submodules.

The channel input for DAQ VIs is either a string (with the Easy I/O VIs)
or an array of strings. Each string value can only list the channels for o
module. With the array structure for channel values, you can list the 
channels for several modules. In other words for one scanning operati
you can scan several modules. You can scan an arbitrary number of 
channels for each module, but the channels of each module must be 
scanned in consecutive, ascending order.

Note You do not need the SCXI channel string syntax to access channels on the 
SCXI-1200 module. Use 0 for channel 0, 1 for channel 1, and so on. The 
SCXI-1200 module is identified by its logical device number.

Note When you connect any type of SCXI module to a DAQ device, certain analog inp
and digital lines on the DAQ device are reserved for SCXI control. On MIO Serie
devices, lines 0, 1, and 2 are unavailable. On MIO-E Series devices, lines 0, 1
and 4 are unavailable. For more channel information refer to the LabVIEW 
Online Reference, by selecting Help»Online Reference….

For the fastest performance in parallel mode on digital modules, you c
use the appropriate onboard port numbers instead of the SCXI chann
string syntax in the digital VIs.

Channel List Element Channel Specified

OBz!SCx!MDy!a Channel a on the module in slot y  of the 
chassis with ID x  is multiplexed into 
onboard channel z . 

OBz!SCx!MDy!a:b Channels a through b inclusive on the 
module in slot y  of the chassis with ID x  
are multiplexed into onboard channel z .
LabVIEW Data Acquisition Basics Manual 20-2 © National Instruments Corporation
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SCXI Gains
SCXI modules provide higher analog input gains than those available 
most DAQ plug-in devices.

Note Before reading this section, you should have already read the Limit Settings 
section in Chapter 3, Basic LabVIEW Data Acquisition Concepts.

Enter the gain jumper settings in the NI-DAQ Configuration utility for ea
channel on each module with jumpered gains. LabVIEW stores these 
settings and uses them to scale the input data. When you use the input 
limits  control of the analog input VIs, LabVIEW chooses onboard gain
that complement the jumpered SCXI gains to achieve the given input lim
as closely as possible.

For analog input modules with programmable gains, LabVIEW uses th
gain setting you enter in the NI-DAQ Configuration utility for each modu
as the default gain for that module. LabVIEW uses the default gain for th
module whenever you leave the input limits  terminal to the analog input 
VIs unwired, or if you enter 0 for your upper and lower input limits.

You can experiment with the default gain setting by using the original 
Getting Started Analog Input VI found in labview\examples\daq\ 

run_me.llb . This VI does not use input limits. After you execute the V
you can open the NI-DAQ Configuration utility while LabVIEW is open
and change the default gain setting there. Be sure to save your chang
choosing File»Save (for the NI-DAQ 4.8.x, save changes by closing the 
utility) before switching back to LabVIEW to run the VI again. Rememb
that the larger the gain setting, the more precise your measurements w
as long as the signal is within the resulting range of the channel.

When you use the input limits  to specify non-zero limits for a module with
programmable gains, LabVIEW chooses the most appropriate SCXI g
for the given limits. LabVIEW selects the highest SCXI gain possible f
the given limits, and then selects additional DAQ device gain if necess

If your module has programmable gains and only one gain for all chan
and you are using an MIO/AI DAQ device, you can specify different inp
limits for channels on the same module by splitting up your channel ra
over multiple elements of the channel array, and using a different set 
of input limits for each element. LabVIEW selects one module gain 
suitable for all of the input limits for that module, then chooses differen
MIO/AI gains to achieve the different input limits. The last three examp
© National Instruments Corporation 20-3 LabVIEW Data Acquisition Basics Manual
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in Table 20-1 illustrate this method. The last example shows a channe
with two modules.

You can open the advanced VI, AI Hardware Config, to see the gain 
selection. After running this VI, the group channel settings cluster array 
at the right side of the panel shows the settings for each channel. The gain 
indicator displays the total gain for the channel, which is the product of
SCXI gain and the DAQ device gain, and the actual limit settings. The
group channel settings cluster array also shows the input limits for each
channel.

LabVIEW always scales the input data as you specified, unless you se
binary data only. Therefore, the gains are transparent to the applicatio
You can specify the input signal limits and let LabVIEW do the rest. 

Table 20-1.  SCXI-1100 Channel Arrays, Input Limits Arrays, and Gains

Array
Index

SCXI-1100
Channel List Array

Input Limits
Array

LabVIEW 
Selected

SCXI Gain

LabVIEW 
Selected 

MIO/AI Gain

0 ob0!sc1!md1!0:7 –0.01 to 0.01 1000 1

0 ob0!sc1!md1!0:7 –0.001 to 0.001 2000 51

0 sc1!md1!0:7 –0.001 to 0.001 2000 1

0
1

ob0!sc1!md1!0:3
ob0!sc1!md1!4:15

–0.1 to 0.1
–0.01 to 0.01

100
100

1
10

0
1

ob0!sc1!md1!0:15
ob0!sc1!md1!16:31

–0.01 to 0.01
–1.0 to 1.0

10
10

1002

1

0
1
2

ob0!sc1!md1!0:3
ob0!sc1!md1!4:15
ob0!sc1!md2!0:7

–1.0 to 1.0
–0.1 to 0.1
–0.01 to 0.01

10
10

1000

1
10
1

1Applies if the MIO/AI device supports a gain of 5 (some MIO/AI devices do not).

2 This case forces a smaller gain at the SCXI module than at the MIO/AI device, because the input limits for the next ch
range on the module require a small SCXI gain. This type of gain distribution is not recommended because it defeats
purpose of providing amplification for small signals at the SCXI module. The small input signals are only amplified by
a factor of 10 before they are sent over the ribbon cable, where they are very susceptible to noise. To use the optimu
gain distribution for each set of input signals, do not mix very small input signals with larger input signals on the sam
SCXI-1100 module, unless you are sampling them at different times.
LabVIEW Data Acquisition Basics Manual 20-4 © National Instruments Corporation
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SCXI Settling Time
The filter and gain settings of your SCXI modules affect the settling tim
of the SCXI amplifiers and multiplexers. You should always enter your
jumpered filter settings and your jumpered gain settings (if applicable)
the configuration utility. LabVIEW uses the gain and filter settings to 
determine a safe interchannel delay that allows the SCXI amplifiers an
multiplexers to settle between channel switching before sampling the n
channel.

LabVIEW calculates the delay for you. If you set a scan rate that is too 
to allow for the default interchannel delay, LabVIEW shrinks the 
interchannel delay and returns a warning from the AI Start or AI Contr
VIs. You can refer to your hardware manuals for SCXI settling times.

You can open the advanced-level AI Clock Config VI to retrieve the 
channel clock selection. Set the which clock control to channel clock 1, 
and set the clock frequency to –1.00  (no change). Now run the VI. The 
actual clock rate specification cluster is on the right side of the panel. 
© National Instruments Corporation 20-5 LabVIEW Data Acquisition Basics Manual
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Common SCXI Applications

Now that you have your SCXI system set up and you are aware of the
special SCXI programming considerations, you should learn about so
common SCXI applications. This section will cover example VIs for 
analog input, analog output, and digital modules. For analog input, you 
learn how to measure temperature (with thermocouples and RTDs) an
strain (with strain gauges) using the SCXI-1100, SCXI-1102, SCXI-112
SCXI-1122, and SCXI-1141 modules. If you are not measuring 
temperature or pressure, you can still gain basic conceptual informatio
how to measure voltages with an analog input module. Read these sec
and then apply the information to measuring your transducer.

Another analog input module, the SCXI-1140, is a simultaneous samp
module. All the channels acquire voltages at the same time, which me
you can preserve interchannel phase relationships. After all channel 
voltages are sampled by going into hold mode, the software will read o
channel at a time. When a scan of channels is done, the SCXI-1140 mo
returns to track mode until the next scan period. Both of these operatio
are performed by the analog input VIs. You can use any of the data 
acquisition (DAQ) VIs, located in the labview\examples\daq\

anlogin\anlogin.llb,  or the Getting Started Analog Input VI, found
in labview\examples\daq\run_me.llb , to acquire data from the 
SCXI-1140 module. 

For analog output, you will learn how to output voltage or current value
using the SCXI-1124 module. For digital I/O, you will learn how to inpu
values on the SCXI-1162/1162HV modules and output values on the 
SCXI-1160, SCXI-1161, and SCXI-1163/1163R modules.
 Data Acquisition Basics Manual
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Analog Input Applications for 
Measuring Temperature and Pressure

Two common transducers for measuring temperature are thermocoup
and RTDs. A common transducer for measuring pressure is strain gau
Read the following sections on special measuring considerations nee
for each transducer.

If you use the DAQ Channel Wizard to configure your analog input 
channels, you can simplify the programming needed to measure your 
channels. This section describes methods of measuring data using na
channels configured in the DAQ Channel Wizard and using the 
conventional method.

Note For more information about using the DAQ Channel Wizard to configure your 
channels, refer to the Configuring Your Channels in NI-DAQ 5.x, 6.0 section of 
Chapter 2, Installing and Configuring Your Data Acquisition Hardware. For more 
information about using channel names, refer to the Channel Name Addressing 
section of Chapter 3, Basic LabVIEW Data Acquisition Concepts.

Measuring Temperature with Thermocouples
If you want to measure the temperature of the environment, you can us
temperature sensors in the terminal blocks. But if you want to measure
temperature of an object away from the SCXI chassis, you must use a
transducer, like a thermocouple. A thermocouple is a junction of two 
dissimilar metals that gives varying voltages based on the temperatur
However, when using thermocouples, you need to compensate for the
thermocouple voltages produced at the screw terminal because the jun
with the screw terminals itself forms another thermocouple. You can u
the resulting voltage from the temperature sensor on the terminal block
cold-junction compensation. The cold-junction compensation voltage i
used when linearizing voltage readings from thermocouples into 
temperature values.

The SCXI modules used to measure temperature in this section are 
SCXI-1100, SCXI-1102, SCXI-1120, SCXI-1120D, SCXI-1121, 
SCXI-1122, and SCXI-1141. All of the terminal blocks used with these
modules have temperature sensors which can be used as cold-junctio
compensation. 
LabVIEW Data Acquisition Basics Manual 21-2 © National Instruments Corporation
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In addition, the SCXI-1100, SCXI-1141, and SCXI-1122 offer a way fo
you to ground the module amplifier inputs so you can read the amplifie
offset. You can subtract the amplifier offset value to determine the actu
voltages. For more information on temperature sensors and amplifier 
offsets, continue on to the following two sections. 

Temperature Sensors for 
Cold-Junction Compensation
The temperature sensors in the terminal blocks for the analog input 
modules can be used for cold-junction compensation. If you are opera
your SCXI modules in multiplexed mode as recommended, you shoul
leave the cold-junction sensor jumper on the terminal block in the mtemp 
(factory default) position. If you are using parallel mode, you can use t
dtemp  jumper setting.

Note The SCXI-1102 only uses the cjtemp  string in multiplexed mode.

To read the temperature sensor, use the standard SCXI string syntax i
channels array with mtemp substituted for the channel number, as show
in the following table.

Channel List Element Channel Specified

ob0!scx!mdy!mtemp The temperature sensor configured in 
mtemp mode on the multiplexed module 
in slot y of the chassis with ID x. 

ob0!scx!mdy!cjtemp The temperature sensor configured in 
cjtemp  mode on the multiplexed module 
of the SCXI-1102 in slot y  of the chassis 
with ID x .
© National Instruments Corporation 21-3 LabVIEW Data Acquisition Basics Manual
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If you want to read the cold-junction temperature sensor in dtemp  mode, 
you can read the following onboard channels for these modules.

For example, you can run the Getting Started Analog Input VI, found i
labview\examples\daq\run_me.llb , with the channel string 
ob0!sc1!md1!mtemp  to read the temperature sensor on the terminal blo
that is connected to the module in slot 1 of SCXI chassis 1.

SCXI terminal blocks have two different kinds of sensors: an Integrate
Circuit (IC) sensor or a thermistor. For terminal blocks that have IC sens
such as the SCXI-1300 and the SCXI-1320, you can multiply the volta
read from the IC sensor by 100 to get the ambient temperature in deg
Centigrade at the terminal block. For terminal blocks that have thermist
such as the SCXI-1303, SCXI-1322, SCXI-1327, and SCXI-1328, use
Thermistor Conversion VI from Functions»Data Acquisition»Signal 
Conditioning to convert the raw voltage data into units of temperature.

You cannot sample other SCXI channels from the same module while 
are sampling the mtemp sensor. However, if you are in parallel mode, yo
can sample the dtemp  sensor along with other channels on the same 
module at the same time because you are not performing any multiple
on the SCXI module. You also can sample the cjtemp  sensor along with 
other channels on the SCXI-1102, but cjtemp  must be the first channel in 
the channel list.

For greater accuracy, take several readings from the temperature senso
average those readings to yield one value. If you do not want to avera
several readings, take a single reading using the Easy Analog Input VI
Sample Channel.

For more information, look at the SCXI Thermocouple example VIs, fou
in labview\examples\daq\scxi\scxi_ai.llb . These VIs use the 
mtemp string to read the temperature sensor and use the reading for 
thermocouple cold junction compensation.

Modules Channel

SCXI-1100 1

SCXI-1120/SCXI-1120 15 (use referenced single-ended mode)

SCXI-1121 4

SCXI-1122 1
LabVIEW Data Acquisition Basics Manual 21-4 © National Instruments Corporation
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Amplifier Offset
The SCXI-1100, SCXI-1122, and SCXI-1141 have a special calibratio
feature that enables LabVIEW to ground the module amplifier inputs s
that you can read the amplifier offset. For the other SCXI analog input
modules, you must physically wire your terminals to ground. The measu
amplifier offset is for the entire signal path including the SCXI module a
the DAQ device.

To read the grounded amplifier on the SCXI-1100 or SCXI-1122, use t
standard SCXI string syntax in the channels array with calgnd  substituted 
for the channel number. Refer to the following table for an example of t

For example, you can run the Getting Started Analog Input VI, found 
in the labview\examples\daq\run_me.llb , with the channel string 
ob0!sc1!md1!calgnd  to read the grounded amplifier of the module in
slot 1 of SCXI chassis 1. The voltage reading should be very close to 
The AI Start VI grounds the amplifier before starting the acquisition, an
the AI Clear VI removes the grounds from the amplifier after the 
acquisition completes.

The SCXI-1141 has a separate amplifier for each channel, so you mu
specify the channel number when you ground the amplifier. To specify 
channel number, attach the channel number to the end of the string calgnd . 
For example, calgnd2  grounds the amplifier inputs for channel 2 and rea
the offset. You can also specify a range of channels. The string calgnd0:7  
grounds the amplifier inputs for channels 0 through 7 and reads the of
for each amplifier.

Use the Scaling Constant Tuner VI from Functions»Data Acquisition»
Signal Conditioning to modify the scaling constants so that LabVIEW 
automatically compensates for the amplifier offset when scaling 
binary data to voltage. The SCXI-1100 Voltage example, found in 
labview\examples\daq\scxi\scxi_ai.llb , shows you a way to use
the Scaling Constant Tuner VI.

Channel List Element Channel Specified

ob0!scx!mdy!calgnd (SCXI-1100 and SCXI-1122 only) 
The grounded amplifier of the module 
in slot y  of the chassis with ID x . 
© National Instruments Corporation 21-5 LabVIEW Data Acquisition Basics Manual
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VI Examples
If you use the DAQ Channel Wizard to configure your channels, you 
can simplify the programming needed to measure your signal. LabVIE
configures the hardware with the appropriate input limits and gain, and
performs cold-junction compensation, amplifier offsets, and scaling fo
you. To measure a channel using a channel name, you can use the Ea
or the Continuous Transducer VI located in labview\examples\daq\ 

solution\transduc.llb , as shown in Figure 21-1. Enter the name o
your configured channel in the channels input. The device input value is 
not used by LabVIEW when you use channel names. The acquired da
in the physical units you specified in the DAQ Channel Wizard.

Figure 21-1.  Continuous Transducer Measurement VI 

The remainder of this section describes how to measure temperature 
the SCXI-1100 and SCXI-112x modules using thermocouples when you
not use the DAQ Channel Wizard. The temperature examples below u
both cold-junction measurements and amplifier offsets. In SCXI analog
input examples, you cannot set the scaling constants with the Easy VI
(determined by the amplifier offset). With the Intermediate VIs, you ca
change the scaling constants before acquisition begins, while the Adva
VIs include functions that are not necessary to accurately measure 
temperature with SCXI modules. The examples described in this secti
use Intermediate VIs along with transducer-specific VIs. 

First, you should learn how to measure temperature using the SCXI-1
with thermocouples. You can use the example SCXI-1100 Thermocou
VI located in labview\examples\daq\scxi\scxi_ai.llb . Open the 
VI and continue reading this section.

To reduce the noise on the slowly varying signals produced by 
thermocouples, you can average the data and then linearize it. For gre
accuracy, you can measure the amplifier offset, which helps scale the
and lets you eliminate the offset error from your measurement. The 
LabVIEW Data Acquisition Basics Manual 21-6 © National Instruments Corporation
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diagram below shows how you can program the Acquire and Average
to measure the amplifier offset. You can find this VI in vi.lib\daq\ 

zdaqutil.llb . This VI acquires 100 measurements from the amplifier
offset, designated in the offset channel input by calgnd , and then averages
the measurements. When you determine the amplifier offset, you mus
always use the same input limits and clock rates that you will be using
the acquisition. The Acquire and Average VI can measure the amplifie
offset of many modules at once, but in Figure 21-2, it only measures o
module.

Figure 21-2.  Measuring a Single Module with the Acquire and Average VI

After measuring the amplifier offset, measure the temperature sensor 
cold-junction compensation. Both the amplifier offset and cold-junction
measurements should be taken before any thermocouple measureme
are taken. To measure temperature sensors, you use the Acquire and
Average VI. The main differences between the amplifier offset 
measurement and temperature sensor measurement are the channel 
and the input limits. If have set the temperature sensor in mtemp mode 
(the most common mode), you access the temperature by using mtemp. 
If you have set the temperature sensor in dtemp  mode, you read the 
corresponding DAQ device onboard channel. Make sure you use the 
temperature sensor input limits which are different from your acquisitio
input limits. To read from a temperature sensor based on an IC senso
a thermistor, set the input limit range from +2 to –2 V.
© National Instruments Corporation 21-7 LabVIEW Data Acquisition Basics Manual
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Figure 21-3.  Measuring Temperature Sensors Using the Acquire and Average VI

After determining the average amplifier offset and cold-junction 
compensation, you can acquire data using the Intermediate VIs as show
Figure 21-4. This example continually acquires data until an error occur
the user stops the execution of the VI. In order to perform continuous,
hardware-timed acquisition, you need to set up a buffer. In this case, t
buffer is 10 times the number of points acquired for each channel. Bef
you initiate the acquisition with the AI Start VI, you need to set up the 
binary-to-voltage scaling constants by using the Scaling Constant Tun
VI. This VI, which you can find in Functions»Data Acquisition»Signal 
Conditioning, passes the amplifier offset to the DAQ driver so that 
LabVIEW accounts for the amplifier offset as the AI Read VI retrieves t
data. After the compensated voltage data from the AI Read VI is avera
the voltage values are converted to temperature and linearized by usin
Convert Thermocouple Reading VI in Functions»Data Acquisition» 
Signal Conditioning. After completing the acquisition, remember to 
always clear the acquisition by using the AI Clear VI.
LabVIEW Data Acquisition Basics Manual 21-8 © National Instruments Corporation



Chapter 21 Common SCXI Applications

e is 

s 
 limit.

on 
en 
 
e 

to 
is 

ay. 
el 

r to 
Figure 21-4.  Continuously Acquiring Data Using Intermediate VIs

Another temperature acquisition example using the SCXI-1100 modul
SCXI Temperature Monitor VI located in labview\examples\daq\ 

scxi\scxi_ai.llb . This VI continually acquires thermocouple reading
and sets an alarm if the temperature readings go above a user-defined

You can use the SCXI-1100 examples with the SCXI-1122 module. 
Both modules have the capability to programmatically measure the 
amplifier offsets and both modules need the cold-junction compensati
to linearize thermocouple measurements. The main differences betwe
the two modules include the type of temperature sensors available on
their terminal blocks and the way module channels are multiplexed. Th
SCXI-1100 uses a CMOS multiplexer, which is capable of fast-channel 
multiplexing, whereas the SCXI-1122 uses a electromechanical relay 
switch one of its 16 channels. Because the SCXI-1122 uses a relay, th
module imposes a minimum interchannel delay of 10 ms. Scanning 
multiple SCXI-1122 channels many times can quickly wear out the rel
To avoid this, acquire data from the SCXI-1122 module a single chann
at a time. For further information on reading SCXI-1122 channels, refe
the SCXI-1122 User Manual, or the SCXI-1122 Voltage example VI in 
labview\examples\ daq\scxi\scxi_ai.llb .
© National Instruments Corporation 21-9 LabVIEW Data Acquisition Basics Manual
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If you are measuring temperature with the SCXI-1120 and SCXI-1121
modules, refer to the example VI, SCXI-1120/1121 Thermocouple, loca
in labview\examples\daq\scxi\scxi_ai.llb . This VI is similar to 
the VI used to measure temperature on the SCXI-1100. Both VIs aver
and linearize temperature data using the Intermediate analog input VIs.
two main differences between the VIs are that the SCXI-1120/1121 VI d
not measure the amplifier offset, and the input limits for the module and
temperature sensor are different from the input limits for the SCXI-110
The SCXI-1120 and SCXI-1121 modules do not have the internal swit
used to programmatically ground the amplifiers as in the SCXI-1100 fo
the amplifier offset measurement. If you want to determine the amplifie
offset, you have to manually wire the amplifier terminals to ground and
use a separate VI to read the offset voltage. You can also manually 
calibrate the SCXI-1120 and SCXI-1121 to remove any amplifier offse
on a channel-by-channel basis. Refer to the SCXI-1120 or SCXI-1121
user manuals for specific instructions.

Measuring Temperature with RTDs
Resistance-Temperature Detectors (RTDs) are temperature-sensing 
devices whose resistance increase with temperature. They are known
their accuracy over a wide temperature range. RTDs require current 
excitation to produce a measurable voltage. RTDs are available in 2-w
3-wire, or 4-wire configuration. The lead wires in the 4-wire configuratio
are resistance-matched. If you use a 2-wire or 3-wire RTD, they are 
unmatched. Resistance in the lead wires that connect your RTD to the
measuring system will add error to your readings. If you are using lead
lengths greater than 10-feet, you will need to compensate for this lead
resistance. RTDs are also classified by the type of metal they use. The 
common metal is platinum.

For more information about how the lead wires affect 
RTD measurements as well as general RTD information, refer to the 
Measuring Temperature with RTDs application note. You can find this note
on the NI Fax-on-Demand system or by accessing the NI BBS, World W
Web, or FTP site, the numbers for which are in the front of this manua

Signal conditioning is needed to interface an RTD to a DAQ device or 
SCXI-1200 module. Signal conditioning required for RTDs include curre
excitation for the RTD, amplification of the measured signal, filtering o
the signal to remove unwanted noise, and isolation of the RTD and 
monitored system from the host computer. Typically, you would use th
SCXI-1121 module with RTDs because it easily performs all the signa
conditioning listed previously. You must set up the excitation level, gai
LabVIEW Data Acquisition Basics Manual 21-10 © National Instruments Corporation
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and filter settings on the SCXI-1121 module with jumpers as well as in
your system’s configuration utility. For information on how to connect a
configure the RTD with the SCXI-1121 module, look at the Getting Started 
with SCXI manual or the RTD application note mentioned previously.

The SC-2042 RTD is a signal conditioning device designed specifically
RTD measurement and can be used as an alternative to SCXI modules
more information, refer to the National Instruments catalog.

You do not have to worry about cold-junction compensation with RTDs
as you do when measuring thermocouples. To build an application in 
LabVIEW, you can use the Easy I/O analog input VIs. If you are measur
multiple transducers on several different channels, you will need to sc
the necessary channels with little overhead. Because the Easy I/O VIs
reconfigure your SCXI module every time your application performs an
acquisition, it is recommended that you use the Intermediate analog 
input VIs.

Using the DAQ Channel Wizard to configure your channels can simpli
the programming needed to measure your signal, as shown in Figure 2
LabVIEW configures the hardware with appropriate input limits and ga
measures the RTD, and scales the measurement for you. Enter the na
your configured channel in the channels input parameter. The acquired 
data is in the physical units you specify in the DAQ Channel Wizard.

Figure 21-5.  Measuring Temperature Using Information from the DAQ Channel Wizard
© National Instruments Corporation 21-11 LabVIEW Data Acquisition Basics Manual
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Figure 21-5 continually acquires data until an error occurs or you stop
VI from executing. To perform a continuous hardware-timed acquisitio
you must set up a buffer. In this example, the buffer is 10 times the num
of points acquired for each channel. For each acquisition, your device
averages the temperature data. After completing the acquisition, alwa
clear the acquisition by using the AI Clear VI.

If you are not using the DAQ Channel Wizard, you must use the 
RTD Conversion VI in addition to specifying additional input 
parameters, as shown in Figure 21-6. The Convert RTD Reading VI, in
Functions»Data Acquisition»Signal Conditioning, converts the voltage 
read from the RTD to a temperature representation. 

Note You should only use the RTD conversion function in LabVIEW for platinum 
RTDs. If you do not have a platinum RTD, the voltage-temperature relation wi
be different, so the LabVIEW conversion function cannot be used.

Figure 21-6.  Measuring Temperature Using the Convert RTD Reading VI

Figure 21-6 continually acquires data until an error occurs or you stop
the VI from executing. In order to perform a continuous hardware-time
acquisition, you need to set up a buffer. In this example, the buffer is 
LabVIEW Data Acquisition Basics Manual 21-12 © National Instruments Corporation
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10 times the number of points acquired for each channel. After your de
averages the voltage data from the AI Read VI, it converts the voltage
values to temperature. After completing the acquisition, remember to 
always clear the acquisition by using the AI Clear VI.

Measuring Pressure with Strain Gauges
Strain gauges give varying voltages in response to stress or vibrations
in materials. Strain gauges are thin conductors attached to the materia
to be stressed. Resistance changes in parts of the strain gauge to ind
deformation of the material. Strain gauges require excitation (generall
voltage excitation) and linearization of their voltage measurements. 
Depending on the strain gauge configuration, another requirement for
using strain gauges with SCXI is a configuration of resistors. As shown
Figure 21-7, the resistance from the strain gauges combined with the 
SCXI hardware form a diamond-shaped configuration of resistors, kno
as a Wheatstone bridge. When you apply a voltage to the bridge, the 
differential voltage (Vm) varies as the resistor values in the bridge chang
The strain gauge usually supplies the resistors that change value with s

Figure 21-7.  Half-Bridge Strain Gauge

Strain gauges come in full-bridge, half-bridge, and quarter-bridge 
configurations. For a full-bridge strain gauge, the four resistors of the 
Wheatstone bridge are physically located on the strain gauge itself. Fo
half-bridge strain gauge, the strain gauge supplies two resistors for th
Wheatstone bridge while the SCXI module supplies the other two resist
as shown above. For a quarter-bridge strain gauge, the strain gauge o
supplies one of the four resistors for a Wheatstone bridge. For more 
information on how to connect your strain gauge to SCXI, refer to the 
Getting Started with SCXI manual.
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The SCXI-1121 and the SCXI-1122 modules are commonly used with
strain gauges because they include voltage or current excitation and int
Wheatstone bridge completion circuits. You can also use the signal 
conditioning device SC-2043SG as an alternative to SCXI modules. T
device is designed specifically for strain gauge measurements. For mo
information on this device, refer to your National Instruments catalog.

You can set up your SCXI module to amplify strain gauge signals or fil
noise from signals. In order to set up the excitation level, gain, and filte
settings, consult your Getting Started with SCXI manual for the necessary
hardware configuration and Chapter 2, Installing and Configuring Your 
Data Acquisition Hardware, for software configuration.

To build a strain gauge application in LabVIEW, you can use the Easy 
analog input VIs. If you are measuring multiple transducers on severa
different channels, you need to scan the necessary channels as quick
possible. Because the Easy I/O VIs reconfigure your SCXI module eve
time the VI is called, you should use the Intermediate analog input VIs
well as the Strain Gauge Conversion VI, as shown in the following 
example. The Convert Strain Gauge Reading VI, located in 
Functions»DAQ»DAQ Utilities, converts the voltage read by the strain 
gauge to units of strain.

Using the DAQ Channel Wizard to configure your channels simplifies t
programming required to measure your signal, as shown in Figure 21-
LabVIEW configures the hardware with the appropriate input limits an
gain, measures the strain gauge, and scales the measurement for you.
the name of your configured channel in the channels input. You do not 
need to wire the device or input limits  input. The acquired data is in the 
physical units you specified in the DAQ Channel Wizard.
LabVIEW Data Acquisition Basics Manual 21-14 © National Instruments Corporation
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Figure 21-8.  Measuring Pressure Using Information from the DAQ Channel Wizard

Figure 21-8 continually acquires data until an error occurs or you stop
VI from executing. In order to perform continuous acquisition, you need
set up a buffer. In this example, the buffer is 10 times the number of po
acquired for each channel. After your device averages the voltage data 
the AI Read VI, it converts the voltage values to strain values. After 
completing the acquisition, remember to always clear the acquisition b
using the AI Clear VI.

When measuring strain gauge data, there are some parameters on the
Convert Strain Gauge Reading VI, shown in Figure 21-9, you should kn

Figure 21-9.  Convert Strain Gauge Reading VI

Vsg, the strain gauge value, is the only parameter wired in the previou
VI diagram. The other parameters for this VI have default values but th
values may not be correct for your strain gauge. You should check the
following parameters: Vinit , the voltage across the strain gauge before 
© National Instruments Corporation 21-15 LabVIEW Data Acquisition Basics Manual
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strain is applied (always measure at the beginning of the VI); Bridge 
Configuration ; Vex, the excitation voltage; Rl, the lead resistance; and Rg, 
the resistance of the strain gauge before strain is applied. You can usu
ignore the lead resistance, Rl, for strain gauges unless the leads are seve
feet. For more information on any of the parameters for this VI, refer to
Chapter 30, Signal Conditioning VIs, in the LabVIEW Function and VI 
Reference Manual, or refer to the LabVIEW Online Reference, by selecting 
Help»Online Reference….

Analog Output Application Example
You can output isolated analog signals using the SCXI-1124 analog ou
module. If you use the DAQ Channel Wizard to configure your analog
output channels, generating signals using the SCXI-1124 is no differe
from the techniques in Part III, Making Waves with Analog Output. 
The remainder of this section describes how to generate signals with 
SCXI-1124 when you do not use the DAQ Channel Wizard.

The SCXI-1124 can generate voltage and current signals. Refer to the
example analog output VI, SCXI-1124 Update Channels VI, located in
labview\examples\daq\scxi\scxi_ao.llb . This VI uses the analog 
output Advanced VIs because the output mode (whether you have vol
or current data) must be accessible in order to change the value, as s
in Figure 21-10. The program calls the AO Group Config VI to specify 
the device and output channels. The AO Hardware Config VI specifies
the output mode and the output range, or limit settings, for all the chan
specified in the channels string. This advanced-level VI is the only pla
where you can specify a voltage or current output mode. If you are 
going to output voltages only, you may want to use the AO Config VI 
(an Intermediate VI), instead of the AO Group Config and AO Hardwar
Config VIs. You can program individual output channels of the SCXI-11
for different output ranges by using the arrays for channels, output mo
and limit settings. The AO Single Update VI initiates the update of the 
SCXI-1124 output channels. To help debug your VIs, it is always helpfu
display any errors, in this case using the Simple Error Handler VI.
LabVIEW Data Acquisition Basics Manual 21-16 © National Instruments Corporation
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Figure 21-10.  SCXI-1124 Update Channels VI

Digital Input Application Example
To input digital signals through an SCXI chassis, you can use the 
SCXI-1162 and SCXI-1162HV modules and the Easy Digital VI, 
Read from Digital Port, as shown in Figure 21-11.

Figure 21-11.  Inputting Digital Signals through an SCXI Chassis Using Easy Digital VIs

If you configure channels using the DAQ Channel Wizard, digital channel 
can consist of a digital channel name. The channel name can refer to e
a port or a line in a port. You do not need to specify device, line, or port  
width , as theses inputs are not used by LabVIEW if a channel name is
specified in digital channel.

As an alternative, digital channel can be expressed in the SCx!MDy!0  
format, where you are trying to input from the digital input module on s
y  of chassis x . The last identifier is always port 0, because the whole 
module is considered one port. In this example, you must also specify
device and port width . The port width  should be the number of lines in 
a port on your SCXI module if you are operating in multiplexed mode. 
For the SCXI-1162 and SCXI-1162HV, the port width  is 32 lines. If you 
are operating in parallel mode, the port width  should be the number of 
© National Instruments Corporation 21-17 LabVIEW Data Acquisition Basics Manual
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lines on your DAQ device. The DIO-32F device can access all 32 lines
the SCXI modules at once by using the SCXI-1348 cable assembly. T
DIO-24 and the DIO-96 devices can only access the first 24 lines of th
modules when configured in parallel mode. For the fastest performanc
parallel mode, you can use the appropriate onboard port numbers inste
the SCXI channel string syntax.

Use the iteration input to optimize your digital operation. When iteration  
is 0 (default), LabVIEW calls the DIO Port Config VI (an Advanced VI) to
configure the port. If iteration  is greater than zero, LabVIEW bypasses 
reconfiguration and remembers the last configuration, which improves
performance. You can wire this input to an iteration terminal of a loop. W
the DIO-24 and DIO-96 devices, every time you call the DIO Port Con
VI, the digital line values are reset to default values. If you want to maint
the integrity of the digital values from one loop iteration to another, do n
set iteration  to 0 except for the first iteration of the loop.

For an example on SCXI digital input, refer to SCXI-1162/1162HV Digit
Input VI located in labview\examples\daq\scxi\scxi_dig.llb . 
Even though this VI uses Advanced VIs, it is functionally equivalent to t
Easy I/O Digital VI, Read from Digital Port.

Note The DIO Port Config VI resets output lines on adjacent ports on the same 
8255 chip for DIO-24, DIO-96, AT-MIO-16D, AT-MIO-16DE, and Lab and 
1200 Series devices.

Note If you are also using SCXI analog input modules, make sure your cabling 
DAQ device is cabled to one of them.
LabVIEW Data Acquisition Basics Manual 21-18 © National Instruments Corporation
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Digital Output Application Example
To output digital signals through an SCXI chassis, you can use the 
SCXI-1160, SCXI-1161, SCXI-1163, and SCXI-1163R modules and the 
digital Easy Digital VI, Write to Digital Port, as shown in Figure 21-12.

Figure 21-12.  Outputting Digital Signals through an SCXI Chassis 
Using Easy Digital VIs

If you configure channels using the DAQ Channel Wizard, digital channel 
can consist of a digital channel name. The channel name can refer to either 
a port or a line in a port. You do not need to specify device, line, or port  
width , as theses inputs are not used by LabVIEW if a channel name is 
specified in digital channel.

As an alternative, digital channel can be expressed in the scx!mdy!0  
format, where you are trying to output from the digital output module on 
slot y  of chassis x . The last identifier is always port 0, because the whole 
module is considered one port. In this case, you must also specify device 
and port width . The port width should be the number of lines on your 
SCXI module if you are operating in multiplexed mode. The SCXI-1160 
has 16 relays, the SCXI-1161 has 8 relays, and the SCXI-1163/1163R have 
32 relays. You can not use the SCXI-1160 or SCXI-1161 in parallel mode. 
For the SCXI-1163/1163R the port width  in parallel mode should be the 
number of lines on your DAQ device or SCXI-1200 module. The DIO-32F 
device can access all 32 lines of the SCXI-1163/1163R modules at once by 
using the SCXI-1348 cable assembly. The DIO-24 and the DIO-96 devices 
can only access the first 24 lines of the SCXI-1163/1163R when configured 
in parallel mode. For the fastest performance in parallel mode, you can use 
the appropriate onboard port numbers instead of the SCXI channel string 
syntax.
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Use the iteration  input to optimize your digital operation. When iteration  
is 0 (default), LabVIEW calls the DIO Port Config VI (an Advanced VI) 
to configure the port. If iteration  is greater than zero, LabVIEW bypasse
reconfiguration and remembers the last configuration, which improves
performance. You can wire this input to an iteration terminal of a loop.
Every time you call the DIO Port Config VI the digital line values are res
to default values. If you want to maintain the integrity of the digital valu
from one loop iteration to another, do not set iteration to 0 except for the 
first iteration of the loop.

For an example on SCXI digital output, refer to SCXI-116x Digital 
Output VI located in labview\examples\daq\scxi\scxi_dig.llb . 
Even though this VI uses Advanced VIs, it is functionally equivalent to
the Easy Digital VI, Write to Digital Port. 

Note If you also are using SCXI analog input modules, make sure your cabling 
DAQ device is cabled to one of them.

Multi-Chassis Applications
Multiple SCXI-1000, SCXI-1000DC, or SCXI-1001 chasses can be 
daisy-chained using the SCXI-1350 or SCXI-1346 multichassis cable 
adapters and an MIO Series DAQ device other than the 
DAQPad-MIO-16XE-50. Every module in each of the chassis must be
multiplexed mode. Only one of the chassis will be connected directly to
DAQ device. Also, if you are using Remote SCXI with RS-485, you ca
daisy chain up to 31 chasses on a single RS-485 port. Because you can
configure up to 16 devices on the NI-DAQ Configuration utility, you ca
only have up to 16 SCXI-1200s in your system.

Note Lab Series devices, LPM devices, DAQCard-500, 516 devices, DAQCard-700
1200 Series (other than SCXI-1200), and DIO-24 devices do not support 
multi-chassis applications.

If you use the DAQ Channel Wizard to configure your analog input 
channels, you simply address channels in multiple chasses by their cha
names. Channel names can be combined, separated by commas, to m
data from multiple modules in a daisy-chain configuration at the same ti
For example, if you have a named channel called temperature  on one 
module in the daisy-chain and pressure  on another module in the same
daisy-chain, your channels array could be temperature , pressure . You 
must enter the chasses in a sequential order in the NI-DAQ Configura
Utility, assigning the first chassis in the chain an ID number of 1, the sec
chassis an ID number of 2, and so forth.
LabVIEW Data Acquisition Basics Manual 21-20 © National Instruments Corporation
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If you are not using the DAQ Channel Wizard, there are special 
considerations for addressing the channels. When you daisy-chain mul
chasses to a single DAQ device (non-Remote SCXI), each chassis 
multiplexes all of its analog input channels into a separate onboard an
input channel. The first chassis in the chain uses onboard channel 0, t
second chassis in the chain uses onboard channel 1, and so on. To ac
channels in the second chassis, you must select the correct onboard ch
as well as the correct chassis ID. The string ob1!sc2!md1!0  means 
channel 0 on the module in slot 1 of SCXI chassis 2, multiplexed into 
onboard channel 1. Remember to use the correct chassis ID number fro
the configuration utility and to put the jumpers from the power supply 
module in the correct position for each chassis.

When an MIO/AI Series device is cabled by a ribbon cable or shielded
cable to multiple chasses, the number of reserved analog input chann
depends on the number of chasses. On MIO Series devices, lines 0, 1
and 2 are unavailable. On MIO-E Series devices, lines 0, 1, 2, and 4 a
unavailable. For more channel information refer to the LabVIEW Online 
Reference, by selecting Help»Online Reference….

When you access digital SCXI modules, you do not use onboard chan
Therefore, if you have multiple chassis, you only have to choose the cor
SCXI chassis ID and module slot.

When you use Remote SCXI to address analog input channels, specif
device number of the SCXI-1200 that is located in the same chassis 
containing the analog input module from which you take samples.

You can perform DAQ operations on channels in multiple SCXI chassis
the same time. For example, the first element of your channels array could 
be ob0!sc1!md1!0:31 , and the second element of the channels array 
could be ob1!sc2!md1!0:31 . Then, LabVIEW would scan 32 channels
on module 1 of SCXI chassis 1, using onboard channel 0, then the 
32 channels on module 1 in SCXI chassis 2, using onboard channel 1
Remember that the scan rate you specify is how many scans per second
LabVIEW performs. For each scan, LabVIEW reads every channel in 
channels array. One restriction is that the channel list for each module m
be consecutive.

You can practice reading channels from different chassis by using the
channel strings explained above in the Easy VIs.
© National Instruments Corporation 21-21 LabVIEW Data Acquisition Basics Manual
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SCXI Calibration—Increasing 
Signal Measurement Precision

Your SCXI module ships to you pre-calibrated for the specified accura
at the factory. You only need to recalibrate the module if the precision
your signal measurement is not acceptable because of shifts in 
environmental conditions.

Before learning about how to calibrate, you should understand where 
LabVIEW stores your calibration constants.

Note This chapter does not apply to the SCXI-1200. For calibration on the SCXI-120
you should use the 1200 Calibrate VI, which you can find in Functions»Data 
Acquisition»Calibration and Configuration . If you are using an SCXI-1200 in a 
Remote SCXI configuration, National Instruments recommends that you conne
directly to your parallel port to perform calibration, because it works much faste

EEPROM—Your System’s Holding Tank for 
Calibration Constants

When you calibrate your SCXI module in LabVIEW, the calibration 
constants can be stored in Electronically Erasable Programmable 
Read-Only Memory (EEPROM). EEPROM could be compared to a holdin
tank for calibration constant information in your module’s memory. The
are 3 parts to this holding tank: the factory area, the default load area, and 
the user area, shown in the following diagram.

Note Only the SCXI-1122, SCXI-1124, SCXI-1102, and SCXI-1141 have EEPROM
All other SCXI modules do not store calibration constants.
 Data Acquisition Basics Manual
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• The factory area has a set of factory calibration constants already
stored in it when you receive your SCXI module. You cannot write in
the factory area, but you can read from it, so you can always access
use these factory constants if they are appropriate for your applica

• The default load area is where LabVIEW automatically looks to lo
calibration constants the first time you access the module. When t
module is shipped, the default load area contains a copy of the fac
calibration constants. 

Note You may overwrite the constants stored in the default load area of EEPROM w
a new set of constants using the SCXI Cal Constants VI. To learn more about th
VI, refer to Chapter 29, Calibration and Configuration VIs, in the LabVIEW 
Function and VI Reference Manual, or refer to the LabVIEW Online Reference, by 
selecting Help»Online Reference….

• The user area is an area for you to store your own calibration const
that you calculate using the SCXI Cal Constants VI. You can also 
a copy of your own constants in the default load area if you want 
LabVIEW to automatically load your constants for subsequent 
operations. You can read and write to the user area.

Note You should use the user area in EEPROM to store any calibration constants th
you may need to use later. This safeguards you from accidentally overwriting yo
constants in the default load area, because you will have two copies of your n
constants and you can revert to the factory constants by copying the factory a
to the default load area without wiping out your new constants entirely.

Electronically Erasable Programmable Read-Only Memory
(EEPROM)

Factory
Area

Default Load
Area

User
Area
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The following sections explain how to calibrate your SCXI modules to 
achieve the levels of accuracy that you desire.

Calibrating SCXI Modules
The SCXI Cal Constants VI in LabVIEW automatically calculates the 
calibration constants for your module with the precision you need for y
particular application. You can find this VI in Functions»DAQ» 
Calibration and Configuration . Refer to Chapter 29, Calibration and 
Configuration VIs, in the LabVIEW Function and VI Reference Manual for 
specifics on the SCXI Cal Constants VI and each of its parameters, or r
to the LabVIEW Online Reference, by selecting Help»Online 
Reference….

By default, calibration constants for the SCXI-1102, SCXI-1122, and 
SCXI-1141 are loaded from the module EEPROM. The SCXI-1141 ha
only gain adjust constants in the EEPROM; it does not have the binary
zero offset. All other analog input modules (excluding the SCXI-1102, 
SCXI-1122, and SCXI-1141) do not have calibration constants by defa
and do not assume any binary offset and ideal gain settings. This mean
must use one of the procedures described in the SCXI Calibration Methods 
for Signal Acquisition section to store calibration constants for your modu
if it is not an SCXI-1102, SCXI-1122, or SCXI-1141.

You can determine calibration constants based specifically on your 
application setup, which includes your type of DAQ device, your 
DAQ device settings, and your cable assembly—all combined with you
SCXI module and its configuration settings.

Note If your SCXI module has independent gains on each channel, the calibration 
constants for each channel are stored at each gain setting.
© National Instruments Corporation 22-3 LabVIEW Data Acquisition Basics Manual
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SCXI Calibration Methods for Signal Acquisition
There are two ways you can calibrate your SCXI module—through 
one-point calibration or two-point calibration. The following illustration 
explains why you may need to calibrate your SCXI module.

In this picture, you can see the difference between the ideal reading an
actual reading. This difference is called Vos, or the binary offset, before the 
two readings intersect. The difference in slope between the actual and 
readings is called the gain error. 

One-point calibration removes the Vos (binary offset) by measuring a 
0 volt signal and comparing the actual reading to it. Two-point calibrati
removes the Vos (binary offset) and corrects gain error by first performing
a one-point calibration. Then you measure a voltage at x volts and compare 
it to the actual reading. The x must be as close as possible to the full-sca
range. The following sections explain how to perform a one-point and 
two-point calibration.

Binary Reading

Binary Offset

Gain Error

Vos

Actual Voltage
in Binary Representation

Actual Reading

Ideal Reading
LabVIEW Data Acquisition Basics Manual 22-4 © National Instruments Corporation
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One-Point Calibration
These steps show you how to perform a one-point calibration calculatio
LabVIEW. You should use one-point calibration when you only need t
adjust the binary offset in your module. If you need to adjust both the bin
offset and the gain error of your module, read the Two-Point Calibration 
section later in this chapter. 

Note If you are using an AT-MIO-16F-5, AT-MIO-64F-5, AT-MIO-16X device or 
an E-series device, you should calibrate your DAQ device first using either the
MIO Calibrate VI or E-Series Calibrate VI.

1. Make sure you set the SCXI gain to the gain you want to use in yo
application. If your modules have gain jumpers or DIP switches, th
must be set appropriately. Refer to your SCXI module user manua
jumper or switch setting information. If your modules have 
software-programmable gain, use the input limits  parameter in the 
AI Config VI to set gain. 

2. Program the module for a single-channel operation by using the 
AI Config VI with the channel that you are calibrating as the chann
parameter in the VI.

3. Ground your SCXI input channel to determine the binary zero offs
You should ground inputs because offset can vary at different volta
levels due to gain error. If you are using an SCXI-1100 or SCXI-112
you can ground your input channels without external hookups by 
substituting the channel string with calgnd as the channel number. 
For other modules, you need to wire the positive and negative cha
inputs together at the terminal block and wire them to the chassis 
ground.
© National Instruments Corporation 22-5 LabVIEW Data Acquisition Basics Manual
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4. Use the AI Single Scan VI to take several readings and average th
for greater accuracy. Set the DAQ device gain settings to match th
settings you plan to use in your application. If you are using an 
AT-MIO-16F-5, AT-MIO-64F-5, or AT-MIO-16X, use the MIO 
Configure VI to enable dithering, which makes your averaged data
more accurate. The dither mode is always enabled on E-series dev
By using the AI Start and AI Read VIs, instead of the AI Single Sc
VI, you can average over an integral number of 60 Hz or 50 Hz pow
line cycles (sine waves) to eliminate line noise. You now have your f
volt/binary measurement: volt = 0.0 or the applied voltage at your 
input channel, and binary is your binary reading or binary average

5. Use the SCXI Cal Constants VI with your volt/binary measuremen
from step 4 as the Volt/Amp 1  and Binary 1 inputs in your VI, 
respectively. (These input names may vary depending on your 
application setup.) For example, if your volt/binary measurement fro
step 4 was 0.00 volts and 2, then you would enter the values into y
front panel controls as shown in the following illustration.

Two-Point Calibration
These steps show you how to perform a two-point calibration calculati
in LabVIEW. You should use two-point calibration when you need to 
correct both the binary offset and the gain error in your SCXI module.

Note If you are using an AT-MIO-16F-5, AT-MIO-64F-5, or AT-MIO-16X device or 
an E-series device, you should calibrate your DAQ device first using either the
MIO Calibrate VI or E-Series Calibrate VI.

Follow steps 1 through 5 in the previous section, One-Point Calibration.

6. Now apply a known, stable, non-zero voltage to your input channe
the terminal block. This input voltage should be close to the upper li
of your input voltage range for the given gain setting. For example
your input voltage range is –5 to 5V, you would want to apply an inp
voltage that is as close to 5 volts as possible, but not exceeding 5 v
LabVIEW Data Acquisition Basics Manual 22-6 © National Instruments Corporation
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7. Take another binary reading or average of readings. If your binary
reading is the maximum binary reading for your DAQ device, try a
smaller input voltage. This is your second volt/binary measuremen

8. Use the SCXI Cal Constants VI with the first volt/binary measureme
from step 4 as Volt/Amp 1  and Binary 1 inputs, and the second 
measurement from step 7 as Volt/Amp 2  and Binary 2 inputs of the 
VI. The following illustration shows how you should enter the value
into these inputs in LabVIEW if your volt/binary measurements are
0V/0 and 5V/2045. Keep in mind that your input names may vary 
depending on your application setup.

9. If you are using SCXI-1102 or SCXI-1122 inputs, you can save th
constants in the module user area in EEPROM. Store constants in
user area as you are calibrating, and then use SCXI Cal Constant
again at the end of your calibration sequence to copy the calibrati
table in the user area to the default load area in EEPROM. Remem
constants stored in the default load area can be overwritten. If you w
to use a set of constants later, keep a copy of the constants stored 
user area in EEPROM.

Note If you are storing calibration constants in the SCXI-1102 or SCXI-1122 
EEPROM, your binary offset and gain adjust factors must not exceed the rang
given in the respective module user manuals.

For other analog input modules, you must store the constants in the 
memory. Unfortunately, calibration constants stored in the memory are 
at the end of a program session. You can solve this problem by creatin
file and saving the calibration constants to this file. You can load them
again in subsequent application runs by passing them into the SCXI C
Constants or the Scale Constant Tuner VIs.

Repeat the above procedure for any additional channel or gain settings
want to calibrate.
© National Instruments Corporation 22-7 LabVIEW Data Acquisition Basics Manual
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Calibrating SCXI Modules for Signal Generation
When you output a voltage or current value to your SCXI analog outpu
module, LabVIEW uses the calibration constants loaded for the given 
module, channel, and output range to scale the voltage or current valu
the appropriate binary value to write to the output channel. By default,
calibration constants for the SCXI-1124 are loaded into the memory fr
the EEPROM default load area.

Recalibrate your SCXI analog output module by following these steps

1. Use the AO Single Update VI to output a binary value. If you are 
calibrating a voltage output range, enter 0 in the binary array input 
of the VI. If you are calibrating current range, enter 255  into the 
binary array  input of the VI. 

2. Measure the output voltage or current at the output channel with a
voltmeter or ammeter. This is your first volt/binary measurement: 
Binary 1 = 0, and Volt/Amp 1 is the voltage or current you measure
at the output.

3. Use the AO Single Update VI to output a binary value of 4,095.

4. Measure the output voltage or current at the output channel. This 
your second volt/binary measurement: Binary 2 should be 4,095  and 
Volt/Amp 2  is the voltage or current you measured at the output.

5. Use SCXI Cal Constants VI with the first voltage/binary measurem
from step 2 as the Volt/Amp 1  and Binary 1 inputs and the second 
measurement from step 4 as the Volt/Amp 2 and Binary 2 inputs of 
the VI.

You can save the constants on the module in the user area in EEPROM
the user area as you are calibrating, and then use SCXI Cal Constant
again at the end of your calibration sequence to copy the calibration ta
in the user area to the default load area in EEPROM. Remember that 
constants that are stored in the default load area can be overwritten. If
want to use the constants later, you should store a backup copy of the
constants in the user area in EEPROM.

Repeat the procedure above for each channel and range you want to 
calibrate. Subsequent analog outputs will use your new constants to s
voltage or current to the correct binary value.

For more information on the SCXI Cal Constants VI, refer to Chapter 2
Calibration and Configuration VIs, in the LabVIEW Function and VI 
Reference Manual, or refer to the LabVIEW Online Reference, by selecting 
Help»Online Reference….
LabVIEW Data Acquisition Basics Manual 22-8 © National Instruments Corporation
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Counting Your Way 
to High-Precision Timing

This section describes the different ways you can use counters with y
data acquisition application, including generating a pulse or pulses
measuring pulse width, frequency, and period; counting events and
time; and dividing frequencies for precision timing.

Part VI, Counting Your Way to High-Precision Timing, contains the 
following chapters:

• Chapter 23, Things You Should Know about Counters, shows you how 
to add high-precision timing to your data acquisition (DAQ) system 
using counters and explains basic counter concepts.

• Chapter 24, Generating a Square Pulse or Pulse Trains, describes the 
ways you can generate a square pulse or multiple pulses (called pulse 
trains) using the counters available on your data acquisition (DAQ
device with the Easy, Intermediate, and Advanced Counter VIs in 
LabVIEW.

• Chapter 25, Measuring Pulse Width, describes how you can use a 
counter to measure pulse width.

• Chapter 26, Measuring Frequency and Period, describes the various 
ways you can measure frequencies and periods using the counter
your data acquisition (DAQ) device.

• Chapter 27, Counting Signal Highs and Lows, teaches you how to use
counters to count external events or elapsed time.

• Chapter 28, Dividing Frequencies, shows you how to divide the 
available device frequencies to get the frequency you need for you
data acquisition application.
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Things You Should Know 
about Counters

Counters add counting or high-precision timing to your data acquisitio
(DAQ) system. Counters respond to and output Transistor-Transistor Lo
(TTL) signals—square-pulse signals that are 0V (low) or 5V (high) in 
value. The following diagram shows a TTL signal.

Even though counters just count the signal transitions (edges) of a 
TTL source signal, you can use this counting capability in many ways.

• You can generate square TTL pulses for clock signals and triggers
other DAQ applications.

• You can measure the pulse width of TTL signals.

• You can measure the frequency and period of TTL signals.

• You can count TTL signal transitions (edges) or elapsed time.

• You can divide the frequency of TTL signals.

The counter chapters that follow this chapter describe each of these co
functions.

Signal Transitions
or Edges

+5 V

0 V
 Data Acquisition Basics Manual
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Knowing the Parts of Your Counter
The following illustration shows a basic model of a counter.

A counter consists of a SOURCE or CLK input pin, a GATE input pin, an 
OUT output pin, and a count register. In plug-in device diagrams and in the 
LabVIEW Function Reference and VI Reference Manual, these counter
parts are called SOURCEn (or CLKn), GATEn, and OUTn, where n is the 
number of the counter.

The parts of a counter work together as follows. Signal transitions (edges) 
are counted at the SOURCE input. The count register can be preloaded with
a count value, and then for each counted edge, the counter increments or 
decrements the count register. The count register value always reflects the 
current count of signal edges. Reading the count register does not change 
its value. The GATE input can be used to control when counting occurs in 
your application. You can also use a counter with no gating, allowing the 
software to initiate the counting operation.

The OUT pin can be toggled according to available counter programming 
modes to generate various TTL pulses and pulse trains.

Use the OUT signal of a counter to generate various TTL pulse waveforms. 
If you are incrementing the count register value, you can configure the 
OUT signal to either toggle signal states or pulse when the count register 
reaches a certain value. The highest value of a counter is called the 
terminal count (TC). If you are decrementing, the count register TC value 
will be 0. If you chose to have pulsed output, then the counter outputs a high 
pulse that is equal in time to one cycle of the counter’s SOURCE signal, 
which can be either an internal or external signal. If you chose to have a 
toggled output, the state of the output signal changes from high to low or 
low to high. If you want more control over the length of high and low 

GATE

SOURCE
(CLK)

OUT

Count Register
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outputs, then you should use a toggled output. Refer to Chapter 24, 
Generating a Square Pulse or Pulse Trains, for more information.

Multiple counters can be concatenated for a greater counting range on 
devices. For more information on how to concatenate counters, refer t
Chapter 27, Counting Signal Highs and Lows.

Knowing Your Counter Chip
Most National Instruments DAQ devices contain one of three different
counter chips: the DAQ-STC, the Am9513, or the 8253/54 chip. Typica
E-series boards (for example the AT-MIO-16E-1) use the DAQ-STC ch
legacy-type MIO boards (for example the AT-MIO-16) use the Am9513
chip, and low cost Lab/1200 type boards (for example the Lab-PC-120
use the 8253/54 chip. If you are not sure which chip your device uses, r
to your hardware manual.

Figure 23-1.  Counter Gating Modes

1

GATE

Counter Value 2

SOURCE

43 5 76 8 count rising SOURCE edge

Falling Edge Gating

1

GATE

Counter Value 2

SOURCE

43 5 76 8 109 count rising SOURCE edge

Rising Edge Gating

1

GATE

Counter Value 2

SOURCE

43 5 6 count rising SOURCE edge

High-Level Gating

1

GATE

Counter Value 2

SOURCE

43 5 6 count rising SOURCE edge

Low-Level Gating
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DAQ-STC
You can configure the DAQ-STC to count either low-to-high or 
high-to-low transitions of the SOURCE input. The counter has a 24-bi
count register with a counting range of 0 to 224-1. It can be configured to 
increment or decrement for each counted edge. Furthermore, whethe
count register increments or decrements can be controlled with an exte
digital line which is useful for encoder applications. Of the gating mod
shown in Figure 23-1, the gating modes the DAQ-STC supports depen
upon the application. You can set the configuration parameters discus
above using the Advanced VI, CTR Mode Config.vi.

Am9513
You can configure the Am9513 to count either low-to-high or high-to-lo
transitions of the SOURCE input. The counter has a 16-bit count regis
with a counting range of 0 to 65535, and can be configured to incremen
decrement for each counted edge. The Am9513 supports all of the ga
modes shown in Figure 23-1. You can set the configuration parameter
discussed above using the Advanced VI, CTR Mode Config.vi.

8253/54
The 8253/54 chip counts low-to-high transitions of the CLK input. The
counter has a 16-bit count register with a counting range of 65535 to 0
that decrements for each counted edge. Of the gating modes shown in
Figure 23-1, the 8253/54 supports only High Level Gating. For single pu
output, the 8253/54 can only create negative polarity pulses. For this 
reason, some applications require the use of a 7404 inverter chip to pro
a positive pulse. The 14-pin 7404 is a common chip available from ma
electronics stores, and can be powered with the 5 volts available on m
DAQ boards. Figure 23-2 shows how to wire a 7404 chip to invert a sig

Figure 23-2.  Wiring a 7404 Chip to Invert a TTL Signal
LabVIEW Data Acquisition Basics Manual 23-4 © National Instruments Corporation
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For specific information about the Counter VIs in LabVIEW, refer to 
Chapter 14, Introduction to the LabVIEW Data Acquisition VIs, in the 
LabVIEW Function and VI Reference Manual, or the LabVIEW Online 
Reference, available by selecting Help»Online Reference….
© National Instruments Corporation 23-5 LabVIEW Data Acquisition Basics Manual
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Generating a Square Pulse 
or Pulse Trains

This chapter describes the ways you can generate a square pulse or mu
pulses (called pulse trains) using the counters available on your data 
acquisition (DAQ) device with the example VIs in LabVIEW.

Generating a Square Pulse
There are many applications where you may need to generate TTL pu
TTL pulses can be used as clock signals, gates, and triggers. You can 
pulse train of known frequency to determine an unknown TTL pulse wid
You also can use a single pulse of known duration to determine an 
unknown TTL signal frequency, or use a single pulse to trigger an ana
acquisition.

There are two basic types of counter signal generation—toggled and 
pulsed. When a counter reaches a certain value, a counter configured 
toggled output changes the state of the output signal, while a counter 
configured for pulsed output outputs a single pulse. The width of the pu
is equal to one cycle of the counter’s SOURCE signal.

The following is a list of terms you should know before outputting a pu
or pulse train using LabVIEW.

• phase 1 refers to the first phase or delay to the pulse.

• phase 2 refers to the second phase or the pulse itself.

• period is the sum of phase 1 and phase 2.

• Frequency is the reciprocal of the period (1/period).

• In LabVIEW, you can adjust and control the times of phase 1 and 
phase 2 in your counting operation. You do this by specifying a duty 
cycle. The duty cycle equals:

phase 2
period

---------------------      where period, phase 1 phase 2+=
 Data Acquisition Basics Manual
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Examples of various duty cycles are shown in Figure 24-1. The first lin
shows a duty cycle of 0.5 , where, phase 1 and phase 2 are the same 
duration. A signal with a 0.5 duty cycle acts as a SOURCE for counter
operations. The second line shows a duty cycle of 0.1 , where phase 1 has 
increased and phase 2 has decreased. The final line shows a large duty 
cycle of 0.9  where phase 1 is very short and the phase 2 duration is longer.

Figure 24-1.  Pulse Duty Cycles

Note A high duty cycle denotes a long pulse phase relative to the delay phase.

How you generate a square pulse varies depending upon which coun
chip your DAQ hardware has. Most National Instruments DAQ device
contain one of three different counter chips: the DAQ-STC, the Am951
or the 8253/54 chip. If you are unsure which chip your device uses, refe
your hardware documentation.

DAQ-STC and Am9513
When generating a pulse or pulse train with the DAQ-STC or 
Am9513 chip, you can define the polarity of the signal as positive or 
negative. Figure 24-2 shows these pulse polarities. Notice that for a si
with a positive polarity, the initial state is low, while a signal with negati
polarity has a positive initial state.

Figure 24-2.  Positive and Negative Pulse Polarity

counter starts

phase 1 phase 2

Duty Cycle = 0.5

Duty Cycle = 0.1

Duty Cycle = 0.9

Positive Polarity Negative Polarity
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Each counter-generated pulse consists of two parts—phase 1 and phase 2. 
If the counter is configured to output a signal with positive polarity and
toggled output, as shown in the following diagram, the period of time 
from when the counter starts counting to the first rising edge is called 
phase 1. The time between the rising and the following falling edge is 
called phase 2. If you configure the counter to generate a continuous pu
train, the counter repeats this process many times as shown on the bo
line of Figure 24-3.

Figure 24-3.  Pulses Created with Positive Polarity and Toggled Output

8253/54
When generating a pulse with the 8253/54 chip, the hardware limits yo
to a negative polarity pulse, as shown in Figure 24-2. The period of tim
from when the counter starts counting to the falling edge is called phase 1. 
The time between the falling and following rising edge is called phase 2. 
Figure 24-4 shows these phases for a single negative polarity pulse. If
need to create a positive polarity pulse, you can connect your negativ
polarity pulse to an external 7404 inverter chip.

Figure 24-4.  Phases of a Single Negative Polarity Pulse

When generating a pulse train with the 8253/54 chip, the hardware lim
you to positive polarity pulses. Furthermore, the value loaded in the co
register is divided equally to create phase 1 and phase 2. This means you 
will always get a 0.5 duty cycle if the count register is loaded with an ev

counter starts

phase 1 phase 2

phase 1 phase 2phase 1 phase 2

Single Pulse

Pulse Train

counter starts

phase 1 phase 2
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number. If you load the count register with an odd number, phase 1 will be 
longer than phase 2 by one cycle of the counter’s CLK signal.

Now that you know the terms involving generating a single square puls
a pulse train, you can learn about the LabVIEW VIs, and the physical 
connections needed to implement your application.

Generating a Single Square Pulse
When do you need to generate a single square pulse? A single pulse 
be used to trigger analog acquisition or to gate another counter opera
A single pulse can also be used to stimulate a device or circuit for whi
you need to acquire and test the response.

DAQ-STC, Am9513
Figure 24-5 shows two ways to connect your counter to generate a sq
pulse. In the Basic Connection, the edges of the internal SOURCE sig
are counted to generate the output signal, the GATE is not used (softw
start) and the pulse signal on the OUT pin gets connected to your dev
The Optional Connections use an external SOURCE from your device 
is gated by your device. You can use either or both of these options.

Figure 24-5.  Physical Connections for Generating a Square Pulse

SOURCE

GATE

OUT

Count Register Your Device

SOURCE

GATE

OUT

Count Register Your DeviceYour Device

Basic Connection

Optional Connections
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Figure 24-6 shows the diagram of the Delayed Pulse-Easy (DAQ-STC
located in labview\examples\daq\counter\DAQ-STC.llb . You 
could also use the example Delayed Pulse-Easy (9513) VI located in 
labview\examples\daq\counter\Am9513.llb . These examples use
the Easy level Generate Delayed Pulse VI.

The Generate Delayed Pulse VI, found in Functions»Data Acquisition» 
Counter, tells your device to generate a single delayed pulse. This VI 
self-contained and checks for errors automatically. With the Generate 
Delayed Pulse VI, you must connect the pulse delay (phase 1) and 
pulse width (phase 2) controls to define the output pulse. Sometimes th
actual pulse delay and pulse width are not the same as you specified.

Figure 24-6.  Diagram of Delayed Pulse-Easy (DAQ-STC) VI

If you need more control over when the counter begins generating a si
square pulse, use Intermediate VIs instead of the Easy VIs. Figure 24
shows the diagram of the Delayed Pulse-Int (DAQ-STC) VI located in 
labview\examples\daq\counter\DAQ-STC.llb . You can also use 
the example Delayed Pulse-Int (9513) VI located in labview\examples\ 

daq\counter\Am9513.llb . These examples show how to generate a 
single pulse using Intermediate level VIs. The Delayed Pulse Generat
Config VI configures the counter and the Counter Start VI generates th
TTL signal. An example of this is generating a pulse as a result of mee
certain conditions. If you used the Easy Counter VI, the VI configures a
then immediately starts the pulse generation. With the Intermediate VI
you can configure the counter long before the actual pulse generation
begins. As soon as you want a pulse to be generated, the counter can
immediately begin without having to configure the counter. In this 
situation, using Intermediate VIs improves performance.
© National Instruments Corporation 24-5 LabVIEW Data Acquisition Basics Manual
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Figure 24-7.  Diagram of Delayed Pulse-Int (DAQ-STC) VI

You must stop the counter if you want to use it for other purposes. For
more information on stopping counters, refer to the Stopping Counter 
Generations section at the end of this chapter.

8253/54
The example Delayed Pulse (8253) VI located in labview\examples\ 

daq\counter\8253.llb  shows how to generate a negative polarity 
pulse. Due to the nature of the 8253/54 chip, three counters are used 
generate this pulse. Since only Counter 0 is internally connected to a clock
source, it is used to generate the timebase. Counter 1 is used to create the 
pulse delay which gates Counter 2. Counter 2 is used to generate the 
pulse, which occurs on the OUT pin. Using multiple counters requires
external wiring which is shown in Figure 24-8 as well as being describ
on the front panel of the VI.

Figure 24-8.  External Connections Diagram from the Front Panel 
of Delayed Pulse (8253) VI
LabVIEW Data Acquisition Basics Manual 24-6 © National Instruments Corporation



Chapter 24 Generating a Square Pulse or Pulse Trains

lved. 

 start 
This example uses a sequence structure to divide the basic tasks invo
Figure 24-9 shows frame 0 of the sequence where all of the counters 
are reset. Notice that counters 1 and 2 are reset so their output states
out high.

Figure 24-9.  Frame 0 of Delayed Pulse (8253) VI
© National Instruments Corporation 24-7 LabVIEW Data Acquisition Basics Manual
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Figure 24-10 shows frame 1 of the sequence where the counters are s
for different counting modes. Counter 0 is set up to generate a timebase
using the ICTR Timebase Generator subVI. Counter 1 is set up to toggle 
its output (low-to-high) when it reaches terminal count (TC). This toggl
output is used to gate Counter 2. Counter 2 is set up to output a low pulse
when its gate goes high.

Figure 24-10.  Frame 1 of Delayed Pulse (8253) VI

Figure 24-11 shows frame 2 of the sequence where a delay occurs so
delayed pulse has time to complete before the example can be run ag
This is useful if the example is used as a subVI that is called repeated
LabVIEW Data Acquisition Basics Manual 24-8 © National Instruments Corporation
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Figure 24-11.  Frame 2 of Delayed Pulse (8253) VI

While this example works well for most pulses, it does have limitations
when your pulse delay gets very short (in the microsecond range), or 
when the ratio of pulse delay to pulse width gets very large. For a 
complete description of this example, refer to the information found in 
Windows»Show VI Info….

Generating a Pulse Train
There are two types of pulse trains: continuous and finite. You can use a 
continuous pulse train as the SOURCE (CLK) of another counter or as
clock for analog acquisition (or generation). You can use a finite pulse t
as the clock of an analog acquisition that acquires a predetermined num
of points, or to provide a finite clock to an external circuit.

Generating a Continuous Pulse Train
How you generate a continuous pulse varies depending upon which cou
chip your DAQ hardware has. Most National Instruments DAQ device
contain one of three different counter chips: the DAQ-STC, the Am951
or the 8253/54 chip. If you are not sure which chip your device uses, r
to your hardware manual.
© National Instruments Corporation 24-9 LabVIEW Data Acquisition Basics Manual
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DAQ-STC, Am9513
Figure 24-12 shows how to connect your counter and device to genera
continuous pulse train. The edges of the internal source signal are cou
to generate the output signal. You obtain the continuous pulse train for y
external device from the counter’s OUT pin. You can optionally gate th
operation with a signal connected to the GATE input pin. Instead of hav
an internal timebase as your SOURCE, you can connect an external s

Figure 24-12.  Physical Connections for Generating a Continuous Pulse Train

Figure 24-13 shows the diagram of the Cont Pulse Train-Easy (DAQ-ST
VI located in labview\examples\daq\counter\DAQ-STC.llb . 
You can also use the example Cont Pulse Train-Easy (9513) VI locate
in labview\examples\daq\counter\Am9513.llb . These examples 
show how to use the Easy Counter VI, Generate Pulse Train, to specify
frequency, duty cycle, and pulse polarity of your pulse train. The numb
of pulses parameter defaults to 0 for continuous generation. When you
press the STOP button, the while loop stops and a second call to Gener
Pulse Train with the number of pulses set to –1 stops the counter.

Figure 24-13.  Diagram of Cont Pulse Train-Easy (DAQ-STC) VI

If you are generating a pulse train and want more control over when th
counter starts, use the Intermediate VIs. Figure 24-14 shows the diagr
of the Cont Pulse Train-Int (DAQ-STC) VI located in labview\ 

counter

your
device

your
devicegate

source
out
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examples\daq\counter\DAQ-STC.llb . You could also use the 
example Cont Pulse Train-Int (9513) VI located in labview\examples\ 

daq\counter\Am9513.llb . These examples show how to generate a 
simple pulse train using Intermediate VIs.

Figure 24-14.  Diagram of Cont Pulse Train-Int (DAQ-STC) VI

With this VI you can specify the frequency, duty cycle, and pulse polar
of your pulse train. If the duty cycle is set to 0.0 or 1.0, the closest 
achievable duty cycle is used to generate a train of positive or negativ
pulses. The Continuous Pulse Generator Config VI configures the cou
for the operation and the Counter Start VI controls the initiation of the pu
train. For example, you may want to generate a continuous pulse train
the result of meeting certain conditions. If you use the Easy VI, the pu
train starts immediately. With the Intermediate VIs you can configure t
counter at the beginning of your application, then wait to call Counter S
after the conditions are met. This approach will improve performance.
When the STOP button is pressed, the while loop stops and Counter S
is called to stop the pulse train.

You must stop the counter if you want to use it for other purposes. For
more information on stopping counters, refer to the Stopping Counter 
Generations section at the end of this chapter. 
© National Instruments Corporation 24-11 LabVIEW Data Acquisition Basics Manual
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8253/54
Figure 24-15 shows how to connect your counter and device to genera
continuous pulse train. If you use counter 0, an internal source is coun
to generate the output signal. If you use counter 1 or 2, you will need 
connect your own source to the CLK pin. You obtain the continuous pu
train for your external device from the counter's OUT pin.

Figure 24-15.  External Connections Diagram from the Front Panel 
of Cont Pulse Train (8253) VI

Figure 24-16 shows the diagram of the Cont Pulse Train (8253) VI loca
in labview\examples\daq\counter\8253.llb . This example shows 
how to use the Generate Pulse Train (8253) VI to generate a continuo
pulse train. When using Counter 0 with this VI, you can specify the desired
frequency. The actual frequency shows the closest frequency to your 
desired frequency that the counter was able to achieve. The actual du
cycle will be as close to 0.5 as possible for your actual frequency. Whe
using Counter 1 or Counter 2, you specify the divisor factor N to be used
to divide your supplied source. You can optionally enter the user supp
timebase if you want the VI to calculate your actual frequency and act
duty cycle. When the STOP button is pressed, the while loop stops and 
call to ICTR Control resets the counter, stopping the generation. For a
complete description of this example, refer to the information found in
Windows»Show VI Info….
LabVIEW Data Acquisition Basics Manual 24-12 © National Instruments Corporation
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Figure 24-16.  Diagram of Cont Pulse Train (8253) VI

Generating a Finite Pulse Train
How you generate a finite pulse varies depending upon which counter 
your DAQ hardware has. Most National Instruments DAQ devices cont
one of three different counter chips: the DAQ-STC, the Am9513, or th
8253/54 chip. If you are not sure which chip your device uses, refer to y
hardware manual.

You can use the Easy I/O VI, Generate Pulse Train, or a stream of 
Intermediate VIs to generate a finite pulse train. With either technique
you must use two counters as shown in the connection diagram in 
Figure 24-17. Refer to Chapter 27, Counting Signal Highs and Lows, for 
more information on how to determine counter-1 and how to use the 
adjacent counter VI. The maximum number of pulses in the pulse train
216 – 1, for Am9513 devices and 224 – 1 for DAQ-STC devices.
© National Instruments Corporation 24-13 LabVIEW Data Acquisition Basics Manual
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Figure 24-17 shows the physical connections to produce a finite pulse t
on the OUT pin of a counter. counter generates the finite pulse train with
high-level gating. counter-1 provides counter with a long enough gate 
pulse to output the number of desired pulses. You must externally con
the OUT pin of the counter-1 to the GATE pin of counter. You also can 
gate counter-1.

Figure 24-17.  Physical Connections for Generating a Finite Pulse Train

DAQ-STC, Am9513
Figure 24-18 shows the diagram of the Finite Pulse Train-Easy 
(DAQ-STC) VI located in labview\examples\daq\counter\ 

DAQ-STC.llb . You can also use the example Finite Pulse Train-Easy 
(9513) VI located in labview\examples\daq\counter\Am9513.llb . 
These examples show how to use the Easy counter VI, Generate Puls
Train, to generate a finite pulse train. With this VI you can specify the 
number of pulses, frequency, duty cycle, and pulse polarity of your pu
train. The Wait+(ms) VI is used as a delay before the counters are reset
Intermediate VI, Counter Stop, is called twice to stop the counters.

Figure 24-18.  Diagram of Finite Pulse Train-Easy (DAQ-STC) VI
LabVIEW Data Acquisition Basics Manual 24-14 © National Instruments Corporation
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You can also create a finite pulse train using Intermediate VIs. Figure 24
shows the diagram of the Finite Pulse Train-Int (DAQ-STC) VI located
labview\examples\daq\counter\DAQ-STC.llb . You could also use 
the example Finite Pulse Train-Int (9513) VI located in 
labview\examples\daq\counter\Am9513.llb . These examples 
show how to use the Intermediate VIs Continuous Pulse Generator Co
and Delayed Pulse Generator Config.

Figure 24-19.  Diagram of Finite Pulse Train-Int (DAQ-STC) VI

In this operation, you use counter to generate a continuous pulse train wit
level gating while using counter-1 to generate a minimum delayed pulse
to gate the counter long enough to generate the desired number of pu
The Continuous Pulse Generator Config VI configures counter to 
generate a continuous pulse train. Then, the Delayed Pulse Generato
Config VI configures counter-1 to generate a single delayed pulse. The
first Counter Start VI in the flow begins the continuous pulse generatio
and the next Counter Start VI generates a pulse after a specified time
The gate mode must be specified as level-gating on the Continuous P
Generator Config VI in order for the counter to wait for the gate signal
from counter-1. The gate mode for the Delayed Pulse Generator Config
can be set to a single or multiple edges. In other words, you could prod
one finite pulse train or multiple pulse trains. The GATE signal for 
counter-1 can be from an external device or from another counter on 
your DAQ device.
© National Instruments Corporation 24-15 LabVIEW Data Acquisition Basics Manual
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With the DAQ-STC chip, you have the ability to internally route the OU
of one counter to the GATE of the next higher order counter, as show
Figure 24-20. You can optionally GATE counter-1. Notice that while you 
still use two counters, you do not need to externally wire between the O
of counter-1 and the GATE of counter.

Figure 24-20.  External Connections Diagram from the Front Panel 
of Finite Pulse Train Adv (DAQ-STC) VI

The example Finite Pulse Train-Adv (DAQ-STC) VI located in 
labview\examples\daq\counter\DAQ-STC.llb  takes advantage of 
this internal wiring. Figure 24-21 shows the diagram of this example, 
which uses the Advanced counter VIs. The top row of counter VIs sets 
up counter to output a pulse train. Notice that the gate source input to 
the CTR Mode Config VI is set to output of next lower order 

counter . This sets the internal wiring such that counter will be gated by 
counter-1. The bottom row of counter VIs sets up counter-1 to output a 
single pulse. The width of the pulse is calculated so it gates counter just 
long enough to output the chosen number of pulses. For a complete 
description of this example, refer to the information found in 
Windows»Show VI Info….
LabVIEW Data Acquisition Basics Manual 24-16 © National Instruments Corporation
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Figure 24-21.  Diagram of Finite Pulse Train-Adv (DAQ-STC) VI

8253/54
Generating a finite pulse train with the 8253/54 chip uses all three coun
Figure 24-22 shows how to externally connect your counters. Since 
counter 0 is internally connected to a clock source, it is used to genera
the timebase used by counter 1 and counter 2. counter 1 generates a single
low pulse used to gate counter 2. Since counter 2 must be gated with a 
high pulse, the output of counter 1 is passed through a 7404 inverter chi
prior to being connected to the GATE of counter 2. counter 2 is set up to 
generate a pulse train at its OUT pin.

Figure 24-22.  External Connections Diagram from the Front Panel 
of Finite Pulse Train (8253) VI
© National Instruments Corporation 24-17 LabVIEW Data Acquisition Basics Manual
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The example Finite Pulse Train (8253) VI located in labview\ 

examples\daq\counter\8253.llb  shows how to generate a finite 
pulse train. This example uses a sequence structure to divide the basic
involved. Figure 24-23 shows frame 0 of the sequence where all of the
counters are reset. Notice counter 1 is reset so its output state starts high

Figure 24-23.  Frame 0 of Finite Pulse Train (8253) VI
LabVIEW Data Acquisition Basics Manual 24-18 © National Instruments Corporation
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Figure 24-24 shows frame 1 of the sequence where the counters are s
for different counting modes. Counter 0 is set up to generate a timebase
using the ICTR Timebase Generator VI. Counter 1 is set up to output a 
single low pulse using the ICTR Control VI. Counter 2 is set up to output 
a pulse train using the ICTR Timebase Generator VI.

Figure 24-24.  Frame 1 of Finite Pulse Train (8253) VI
© National Instruments Corporation 24-19 LabVIEW Data Acquisition Basics Manual
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Figure 24-25 shows frame 2 of the sequence where a delay occurs so
the finite pulse train has time to complete before the example can be r
again. This is useful if the example is used as a subVI where it may ge
called over and over. For a complete description of this example, refer
the information found in Windows»Show VI Info….

Figure 24-25.  Frame 2 of Finite Pulse Train (8253) VI

Counting Operations When All Your Counters Are Used
The DAQ-STC and Am9513 have counting operations available even 
when all the counters have been used.

DAQ-STC devices feature a FREQ_OUT pin and Am9513 devices feat
an FOUT pin. On these pins you can generate a 0.5 duty cycle square 
without using any of the available counters.

The CTR Control VI, found in Functions»Data Acquisition»Counters» 
Advanced Counters, enables and disables the FOUT signal and sets th
square wave frequency. The square wave frequency is defined by the 
FOUT timebase signal divided by the FOUT divisor. The front panel an
block diagram below show an FOUT output configured to generate a 
25,000 Hz square wave.
LabVIEW Data Acquisition Basics Manual 24-20 © National Instruments Corporation



Chapter 24 Generating a Square Pulse or Pulse Trains

ted 
 

Figure 24-26.  CTR Control VI Front Panel and Block Diagram

You can also refer to the Generate Pulse Train on FREQ_OUT VI loca
in examples\daq\counter\DAQ-STC.llb , or the Generate Pulse Train
on FOUT VI located in examples\daq\counter\Am9513.llb . These 
examples generate a pulse train on these outputs.
© National Instruments Corporation 24-21 LabVIEW Data Acquisition Basics Manual



Chapter 24 Generating a Square Pulse or Pulse Trains

one 
f the 
rt 
dge 

l 
 

re 

low 
und 
.

Knowing the Accuracy of Your Counters
When you generate a waveform, there can be an uncertainty of up to 
timebase period between the start signal and the first counted edge o
timebase. This is due to the uncertainty in the exact relation of the sta
signal, which the software calls or the gate signal supplies to the first e
of the timebase, as shown in Figures 24-27.

Figure 24-27.  Uncertainty of One Timebase Period

8253/54
In addition to the above uncertainty, the 8253/54 chip has an additiona
uncertainty when used in mode 0. Mode 0 generates a low pulse for a
chosen number of clock cycles, but a software delay is involved. This 
delay is because with mode 0 the counter output is set low by a softwa
write to the mode setting. Afterward the count can be loaded and the 
counter starts counting down. The time between setting the output to 
and loading the count is included in the output pulse. This time was fo
to be 20 microseconds when tested on a 200 MHz Pentium computer

phase 1 phase 2

uncertainty of
1 timebase period

output

timebase

starting
signal

1 timebase period
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Stopping Counter Generations
You can stop a counting operation in several ways. You can restart a 
counter for the same operation it just completed, you can reconfigure 
do something else, or you can call a specific VI to stop it. All of these 
methods allow you to use counters for different operations without 
resetting the entire board.

DAQ-STC, Am9513
Figure 24-28 shows how to stop a counter using the Intermediate VI, 
Counter Stop. Notice that the Wait+ (ms) VI is called before Counter St
The Wait+ (ms) VI allows you to wire a time delay so that the previous
counter operation has time to complete before the Counter Stop VI is 
called. The Wait+ (ms) and Counter Stop VIs are located in 
Functions»Data Acquisition»Counter»Intermediate Counter.

Figure 24-28.  Using the Generate Delayed Pulse and Stopping the Counting Operation

To stop a generated pulse train, another Generate Pulse Train VI can 
be used with the number of pulses input set to –1. Figure 24-29 shows
an example of this. This example expects that a pulse train is already 
being generated. The call to Generate Pulse Train VI stops the counte
and the call to Generate Delayed Pulse VI sets the counter up for a 
different operation.

Figure 24-29.  Stopping a Generated Pulse Train

8253/54
Calling ICTR Control VI with a control code of 7 (reset) can stop a coun
on the 8253/54 chip. Examples are shown in Figures 24-9 and 24-23.
© National Instruments Corporation 24-23 LabVIEW Data Acquisition Basics Manual
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Measuring Pulse Width

This chapter describes how you can use a counter to measure pulse w
There are several reasons you may need to determine pulse width. Fo
example, if you need to determine the duration of an event, you would w
your application to measure the width of a pulse that occurs during tha
event. Another example is determining the interval between two events
this case, you would measure the pulse width between the two events
example of when you might use this type of application is determining 
time interval between two boxes on a conveyor belt or the time it takes
box to be processed through an operation. The event would be an edg
every time a box goes by a point, which prompts a digital signal to cha
in value.

Measuring a Pulse Width
You can measure an unknown pulse width by counting the number of 
pulses of a faster known frequency that occur during the pulse to be 
measured. Connect the pulse you want to measure to the GATE input
and a signal of known frequency to the SOURCE (CLK) input pin, as 
shown in Figure 25-1. The pulse of unknown width (Tpw) gates the counter 
configured to count a timebase clock of known period (Ts). The pulse width 
equals the timebase period times the count, or: Tpw = Ts × count. The 
SOURCE (CLK) input can be an external or internal signal.

Figure 25-1.  Counting Input Signals to Determine Pulse Width

GATE

SOURCE
(CLK)

OUT

Count Register

Ts

Tpw

frequency
source
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An internal signal is based upon the type of counter chip on your 
DAQ device. With DAQ-STC devices, you have a choice between inter
timebases of 20 MHz and 100 kHz. With Am9513 devices, you can cho
internal timebases of 1 MHz, 100 kHz, 10 kHz, 1 kHz, and 100 Hz. 
With 8253/54 devices, the internal timebase is either 2 MHz or 1 MHz
depending on which board you have.

Figure 25-2 shows how to physically connect the counter on your devic
measure pulse width.

Figure 25-2.  Physical Connections for Determining Pulse Width

Determining Pulse Width
How you determine a pulse width depends upon which counter chip is
on your DAQ device. If you are uncertain of which counter chip your 
DAQ device has, refer to your hardware manual.

DAQ-STC
Figure 25-3 shows the diagram of the Measure Pulse-Easy (DAQ-STC
located in labview\examples\daq\counter\DAQ-STC.llb , which 
uses the Easy VI, Measure Pulse Width or Period.

Figure 25-3.  Diagram of Measure Pulse Width (DAQ-STC) VI

counter

your
device gate

source
out
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The Measure Pulse Width or Period VI counts the number of cycles of
specified timebase, depending on your choice from the type of 
measurement menu located on the front panel of the VI. The type of 
measurement menu choices for this VI are shown in Figure 25-4.

Figure 25-4.  Menu Choices for Type of Measurement 
for the Measure Pulse Width or Period(DAQ-STC) VI

Use the first two menu choices when you want to measure the width o
single pulse. In these cases, the GATE of the counter must start out in
opposite phase of the pulse you want to measure. For example, if you
choose measure high pulse width of a single pulse, the GATE must start 
out low when you run the VI. If you attempt to measure a single high pu
and the GATE is already high (such as in the middle of a pulse train) w
you run the VI, an error will occur.

Use the last two menu choices when you want to measure the width o
single pulse within a train of multiple pulses. In these cases, it is the 
previous GATE transition which arms the counter to measure the next
pulse. For example, if you choose measure one high pulse width of 
multiple pulses, the first high-to-low GATE transition from one pulse 
would arm the counter to measure the very next pulse.

The timebase you choose determines how long a pulse you can meas
with the 24-bit counter. For example, the 100 kHz timebase allows you
measure a pulse up to 224 × 10µs = 167 seconds long. The 20 MHz timebas
allows you to measure a pulse up to 838 ms long. For a complete 
description of this example, refer to the information found in 
Windows»Show VI Info….
© National Instruments Corporation 25-3 LabVIEW Data Acquisition Basics Manual
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Am9513
Figure 25-5 shows the diagram of the Measure Pulse-Easy (9513) VI 
located in labview\examples\daq\counter\Am9513.llb , which 
uses the Easy VI, Measure Pulse Width or Period.

Figure 25-5.  Diagram of Measure Pulse Width (9513) VI

The Measure Pulse Width or Period VI counts the number of cycles of
specified timebase, depending on your choice from the type of 
measurement menu located on the front panel of the VI. The type of 
measurement menu choices for this VI are shown in Figure 25-6.

Figure 25-6.  Menu Choices for Type of Measurement 
for the Measure Pulse Width or Period (9513) VI

Either menu choice can be used to measure the width of a single puls
to measure a pulse within a train of multiple pulses. However, the puls
must occur after the counter starts. This means it may be difficult to 
measure a pulse within a fast pulse train. This is because the counter 
high level gating. If the counter is started in the middle of a pulse, it wi
measure the remaining width of that pulse.

The timebase you choose determines how long a pulse you can meas
with the 16-bit counter. For example, the 100 Hz timebase allows you 
measure a pulse up to 216 × 10ms = 655 seconds long. The 1 MHz timebas
allows you to measure a pulse up to 65 ms long. Since a faster timeba
yields a more accurate pulse width measurement, it is best to use the fa
timebase possible without the counter reaching terminal count (TC).
LabVIEW Data Acquisition Basics Manual 25-4 © National Instruments Corporation
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The valid? output of the example VI indicates whether the counter 
measured the pulse without overflowing (reaching TC). However, valid? 
does not tell you whether a whole pulse was measured when measuri
pulse within a pulse train. For a complete description of this example, r
to the information found in Windows»Show VI Info….

8253/54
Figure 25-7 shows the diagram of the Measure Short Pulse Width 
(8253) VI located in labview\examples\daq\counter\8253.llb .

Figure 25-7.  Diagram of Measure Short Pulse Width (8253) VI

This VI counts the number of cycles of the internal timebase of Counter 0 
to measure a high pulse width. You can measure a single pulse or a p
within a train of multiple pulses. However, the pulse must occur after t
counter starts. This means it may be difficult to measure a pulse within
fast pulse train because the counter uses high level gating. If you wan
measure a low pulse width, you need to insert a 7404 inverter chip betw
your pulse source and the GATE input of counter 0.
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 VI 
On the example diagram, the first call to ICTR Control VI sets up 
counting mode 4, which tells the counter to count down while the gate in
is high. The Get Timebase (8253) VI is used to get the timebase of yo
DAQ device. A DAQ device with an 8253/54 counter has an internal 
timebase of either 1 MHz or 2 MHz, depending on the device. Inside t
while loop, ICTR Control VI is called to continually read the count regist
until one of four conditions are met:

1. The count register value has decreased, but is no longer changing
(it is finished measuring the pulse).

2. The count register value is greater than the previously read value 
(an overflow has occurred).

3. An error has occurred.

4. Your chosen time limit has been reached.

After the while loop, the final count is subtracted from the originally load
count of 65535 and multiplied by the timebase period to yield the puls
width. Finally, the last ICTR Control VI resets the counter. Notice that th
VI uses only Counter 0. If Counter 0 has an internal timebase of 2 MHz
the maximum pulse width you can measure is 216 × 0.5 µs = 32 ms. For a 
complete description of this example, refer to the information found in
Windows»Show VI Info….

Controlling Your Pulse Width Measurement
How you control your pulse width measurement depends upon which 
counter chip is on your DAQ device. If you are uncertain of which coun
chip you DAQ device has, refer to your hardware manual.

DAQ-STC or Am9513
Figure 25-8 shows one approach to measuring pulse width using the 
Intermediate VIs Pulse Width or Period Meas Config, Counter Start, 
Counter Read, Counter Stop. You can use these VIs to control when t
measurement of the pulse widths begins and ends. The Pulse Width o
Period Config VI configures a counter to count the number of cycles o
known internal timebase. The Counter Start VI begins the measureme
The Counter Read VI determines if the measurement is complete and
displays the count value. After the while loop is stopped, the Counter 
Stop VI stops the counter operation. Finally, the General Error Handler
notifies you of any errors.
LabVIEW Data Acquisition Basics Manual 25-6 © National Instruments Corporation
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Figure 25-8.  Measuring Pulse Width with Intermediate VIs

Buffered Pulse and Period Measurement
With the DAQ-STC chip, LabVIEW provides a buffer for counter 
operations. You would typically use buffered counter operations when 
have a gate signal to trigger a counter several times. Figure 25-9 show
diagram of the Meas Buffered Pulse-Period (DAQ-STC) VI located in 
labview\examples\daq\DAQ-STC.llb .

Figure 25-9.  Diagram of Meas Buffered Pulse-Period (DAQ-STC).vi
© National Instruments Corporation 25-7 LabVIEW Data Acquisition Basics Manual
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With this example, you can perform four types of buffered measureme

1. Buffered period measurement, which measures a number of period
a pulse train.

2. Buffered semi-period measurement, which measures a number of 
and low pulse in a pulse train.

3. Buffered pulse width measurement, which measures a number of 
or low pulses in a pulse train.

4. Buffered counting, where each rising edge loads the current count 
a finite buffer.

This example uses a single buffer—circular buffering is not supported.
The diagram uses the following Advanced VIs: CTR Group Config, 
CTR Buffer Config, CTR Mode Config, CTR Control, and CTR Buffer 
Read. CTR Group Config takes the counter and device and sets up a 
taskID. CTR Buffer Config sets up a finite buffer whose size is determin
by the value you enter in counts per buffer. CTR Mode Config determines 
what type of counting operation to perform based on your choices for gate 
parameters and config mode. CTR Control starts the counting operation
but does not return until the counting has completed. CTR Buffer Rea
reads the buffer of data and returns the values to buffered counts. The 
buffered times are determined by dividing the counts by your chosen 
timebase. For a complete description of this example, refer to the 
information found in Windows»Show VI Info….

Increasing Your Measurable Width Range
The maximum counting range of a counter, together with the chosen 
internal timebase, determine how long of a pulse width can be measu
Remember the internal timebase acts as the SOURCE. When measurin
pulse width of a signal, you count the number of source edges that oc
during the pulse being measured. The counted number of SOURCE e
cannot exceed the counting range of the counter. Slower internal timeb
allow you to measure longer pulse widths, but faster timebases give y
more accurate pulse width measurement. If you need a slower timeba
than is available on your counter as shown in Table 25-1, you can set u
additional counter for pulse train generation and use the OUT of that 
counter as the SOURCE of the counter measuring pulse width.
LabVIEW Data Acquisition Basics Manual 25-8 © National Instruments Corporation
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Table 25-1.  Internal Counter Timebases and Their Corresponding 
Maximum Pulse Width Measurements

Counter Type
Internal

Timebases
Maximum Pulse Width

Measurement

DAQ-STC 20 MHz 838 ms

100 kHz 167 s

Am9513 1 MHz 65 ms

100 kHz 655 ms

10 kHz 6.5 s

1 kHz 65 s

100 Hz 655 s

8253/54 2 MHz* 32 ms

1 MHz* 65 ms

*A DAQ device with an 8253/54 counter will have one of these internal timebases 
available on counter 0, but not both.
© National Instruments Corporation 25-9 LabVIEW Data Acquisition Basics Manual
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Measuring Frequency 
and Period

This chapter describes the various ways you can measure frequencie
periods of TTL signals using the counters on your data acquisition (DA
device. One cycle of a signal, known as the period, is measured in uni
time — usually seconds. The inverse of period is frequency, which is 
measured in cycles per second or hertz (Hz). The rate of your signal an
type of counter on your DAQ device determine whether you use freque
or period measurement. An example of when you would want to know 
frequency of a signal is if you need to monitor the shaft speed of the m

Knowing How and When to Measure 
Frequency and Period

A common way to measure the frequency of a signal is to measure th
number of pulses that occur during a known time period. For example
Figure 26-1 illustrates the measurement of a pulse train of an unknow
frequency (fs) by using a pulse of a known width (TG). The frequency of 
the waveform equals the count divided by the known pulse width 
(frequency = count/TG). The period is always the reciprocal of the 
measured frequency (period = 1/fs). You typically use frequency 
measurement for high frequency signals where the signal to be measu
is approaching or faster than the chosen internal timebase.

Figure 26-1.  Measuring Square Wave Frequency

GATE

SOURCE (CLK)

OUT

Count Register

TG

input of unknown
frequency, fs

pulse of known width
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DAQ-STC, Am9513
For period measurement, you count the number of pulses of a known 
frequency (fs) during one period of the signal to be measured. As shown
Figure 26-2, the signal of a known frequency is connected to the SOUR
and the signal to be measured is connected to the GATE. The period i
count divided by the known frequency (TG = count/fs).

Figure 26-2.  Measuring a Square Wave Period 

You typically use period measurement for low frequency signals where
the signal to be measured is significantly slower than the chosen inter
timebase. The internal timebases for the DAQ-STC are 20 MHz and 
100 kHz. The internal timebases for the Am9513 are 1 MHz, 100 kHz,
10 kHz, 1 kHz, and 100 Hz. Whether you use period measurement or 
frequency measurement, you can always obtain the other measureme
taking the inverse of the current one as shown in the following equatio

8253/54
The 8253/54 chip does not support period measurement, but you can 
frequency measurement for a pulse train and take the inverse to get th
period. The frequency examples discussed in this chapter calculate th
period for you.

GATE

SOURCE

OUT

Count Register

TG

input of known
frequency, fs

period measurement 1
frequency measurement
------------------------------------------------------------=

frequency measurement 1
period measurement
---------------------------------------------------=
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Connecting Counters to Measure Frequency and Period
Figure 26-3 shows typical external connections for measuring frequen
In the figure, your device provides the signal with the frequency to be 
measured to the SOURCE (CLK) of counter. It can optionally control the 
GATE of counter-1. The OUT of counter-1 supplies a known pulse to the
GATE of counter. Finally, counter counts the number of cycles of the 
unknown pulse during the known GATE pulse.

Figure 26-3.  External Connections for Frequency Measurement

DAQ-STC, Am9513
Figure 26-4 shows typical external connections for measuring period. 
In the figure, your device provides the signal with the period to be 
measured to the GATE of counter. A timebase of known frequency is 
supplied to the SOURCE. This is usually an internal timebase, but it co
be externally supplied. It is important that the counting range of your 
counter is not exceeded during the period measurement. The range o
Am9513 is 65,335, and the range of the DAQ-STC is 16,777,216. If th
counting range is exceeded, you can pick a slower internal timebase.

Figure 26-4.  External Connections for Period Measurement
© National Instruments Corporation 26-3 LabVIEW Data Acquisition Basics Manual
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Measuring the Frequency and Period 
of High Frequency Signals

How you measure the frequencty and period of high frequency signals
depends on the counter chip on your DAQ device. If you are unsure o
which chip your DAQ device has, refer to your hardware documentatio

DAQ-STC
Figure 26-5 shows the Measure Frequency-Easy (DAQ-STC) VI locat
in labview\examples\daq\DAQ-STC.llb . This example uses the 
Easy VI, Measure Frequency which can be found in Functions»
Data Acquisition»Counter.

Figure 26-5.  Diagram of Measure Frequency-Easy (DAQ-STC) VI

This VI initiates the counter to count the number of rising edges of a 
TTL signal at the SOURCE of counter during a known pulse at the GA
of counter. The width of that known pulse is determined by gate width. 
Frequency is the output for this example, and period is calculated by 
taking the inverse of the frequency. Remember, you must externally w
your signal to be measured to the SOURCE of counter, and the OUT 
of counter-1 must be wired to the GATE of counter. For a complete 
description of this example, refer to the information found in 
Windows»Show VI Info….
LabVIEW Data Acquisition Basics Manual 26-4 © National Instruments Corporation
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Am9513
Figure 26-6 shows the Measure Frequency-Easy (9513) VI located in 
labview\examples\daq\Am9513.llb . This example uses the 
Easy VI, Measure Frequency which can be found in Functions»
Data Acquisition»Counter.

Figure 26-6.  Diagram of Measure Frequency-Easy (9513) VI

This VI initiates the counter to count the number of rising edges of a 
TTL signal at the SOURCE of counter during a known pulse at the GA
of counter. The width of that known pulse is determined by gate width.
Frequency is the output for this example, and period is calculated by 
taking the inverse of the frequency. The valid? output lets you know if 
the measurement completed without an overflow. The number of coun
to use input lets you choose one counter for 16-bit measurement or tw
counters for 32-bit measurement. Remember that you must externally
wire your signal to be measured to the SOURCE of counter, and the O
of counter-1 must be wired to the GATE of counter. For a complete 
description of this example, refer to the information found in 
Windows»Show VI Info….
© National Instruments Corporation 26-5 LabVIEW Data Acquisition Basics Manual
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DAQ-STC, Am9513
If you need more control over when your frequency measurement beg
and ends, use the Intermediate VIs instead of the Easy VIs. Figure 26
shows one approach for this that uses the Event or Time Counter Con
Adjacent Counters, Delayed Pulse Generator Config, Counter Start, 
CTR Control, Counter Read, and Counter Stop VIs. The Delayed Puls
Generator Config VI configures counter to count the number of pulses 
while its GATE is high. The Adjacent Counters VI is used to determine 
correct counter-1. The Delayed Pulse Generator Config VI then configu
counter-1 to generate a single pulse for the GATE signal. The Counter
Start VI begins the counting operation for counter first, then counter-1. 
The CTR Control VI is an Advanced VI which is used to check if the GAT
pulse has completed. The Counter Read VI returns the count value fro
counter, which is used to determine the frequency and pulse width. Fina
the Counter Stop VI stops the counter operation.

Figure 26-7.  Frequency Measurement Example Using Intermediate VIs
LabVIEW Data Acquisition Basics Manual 26-6 © National Instruments Corporation
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8253/54
Figure 26-8 shows the Measure Frequency > 1kHz (8253) VI located 
labview\examples\daq\8253.llb .

Figure 26-8.  Diagram of Measure Frequency > 1 kHz (8253) VI

This VI initiates the counter to count the number of rising edges of a 
TTL signal at the CLK of counter during a known pulse at the GATE of 
counter. The known pulse is created by counter 0, and its width is 
determined by gate width. The maximum width of the pulse is 32 ms if 
your DAQ device has a 2 MHz internal timebase, and 65 ms if your DA
device has a 1 MHz internal timebase. This maximum pulse is why thi
example only reads frequencies higher than 1 kHz. A frequency of 1 k
generates 32 cycles during the 32 ms pulse. As this cycle count decre
(as with lower frequencies), the frequency measurement becomes les
accurate. Frequency is the output for this example, and period is determ
by taking the inverse of the frequency. You must externally wire the sig
to be measured to the CLK of counter, and the OUT of counter 0 must be 
wired through a 7404 inverter chip to the GATE of counter.

The diagram of the previous example uses the ICTR Control, Get 
Timebase (8253), and Wait + (ms) VIs. The first two ICTR Control VIs 
reset counter and counter 0. The next ICTR Control sets up counter to 
count down while its GATE input is high. The Get Timebase (8253) VI 
returns the internal timebase period for counter 0 of device. This value is 
multiplied by the gate width to yield the count to be loaded into the cou
register of counter 0. The next ICTR Control VI loads this count and set
up counter 0 to output a low pulse, during which cycles of the signal to b
measured are counted.

One advantage of this example is that it only uses two counters. Howe
this example has two notable limitations. One limitation is that it canno
accurately measure low frequencies. If you need to measure lower 
© National Instruments Corporation 26-7 LabVIEW Data Acquisition Basics Manual
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frequencies, use the Measure Frequency < 1 kHz (8253) VI located in
labview\examples\daq\8253.llb . This VI uses three counters. The
other limitation is that there is a small software dependency, which cau
counter 0 to output a pulse slightly longer than the count it is given. Th
is the nature of the 8253 chip, and it can increase the readings of high
frequencies. To avoid this software delay, use the Measure Frequency -
Start > 1 kHz (8253) located in labview\examples\daq\8253.llb . For 
a complete description of each example, refer to the information found
Windows»Show VI Info….

Measuring the Period and 
Frequency of Low Frequency Signals

How you measure the period and frequency of low frequency signals 
depends on which counter chip is on your DAQ device. If you are uncer
which chip your DAQ device has, refer to your hardware documentatio

DAQ-STC
Figure 26-9 shows the Measure Period-Easy (DAQ-STC) VI located in
labview\examples\daq\DAQ-STC.llb . This example uses the Easy 
VI, Measure Pulse Width or Period located in Functions»Data 
Acquisition»Counter.

Figure 26-9.  Diagram of Measure Period-Easy (DAQ-STC) VI

You connect your signal of unknown period to the GATE of counter. 
The counter measures the period between successive rising edges of
TTL signal by counting the number of internal timebase cycles that occur 
during the period. The period is the count divided by the timebase. The 
frequency is determined by taking the inverse of the period. You must 
choose timebase such that the counter does not reach its highest value
LabVIEW Data Acquisition Basics Manual 26-8 © National Instruments Corporation
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or terminal count (TC). With a timebase of 20 MHz, the DAQ-STC 
can measure a period up to 838 ms. With a timebase of 100 kHz, 
you can measure a period up to 167 seconds.

Am9513
Figure 26-10 shows the example Measure Period-Easy (9513) VI 
located in labview\examples\daq\Am9513.llb . This example uses 
the Easy VI, Measure Pulse Width or Period located in Functions» 
Data Acquisition»Counter.

Figure 26-10.  Diagram of Measure Period-Easy (9513) VI

You connect your signal of unknown period to the GATE of counter. The 
counter measures the period between successive rising edges of your
signal by counting the number of internal timebase cycles that occur during 
the period. The period is the count divided by the timebase. The frequency 
is determined by taking the inverse of the period. The valid? output 
indicates if the period was measured without overflow. Overflow occur
when the counter reaches its highest value, or terminal count (TC). Yo
must choose timebase such that it does not reach TC. With a timebase o
1 MHz, the Am9513 can measure a period up to 65 ms. With a timebas
100 Hz, you can measure a period up to 655 seconds.
© National Instruments Corporation 26-9 LabVIEW Data Acquisition Basics Manual
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If you need more control over when period measurement begins and e
use the Intermediate VIs instead of the Easy VIs. Figure 26-11 shows 
to measure period and frequency.

Figure 26-11.  Measuring Period Using Intermediate Counter VIs

The Intermediate VIs used in Figure 26-11 include Pulse Width or Per
Meas Config, Counter Start, Counter Read, and Counter Stop. The Pu
Width or Period Meas Config VI configures the counter for period 
measurement. The Counter Start begins the counting operation. Coun
Read returns the count value from the counter, which is used to determ
the period and frequency.

8253/54
The 8253/54 chip does not support period measurement, but you can 
use frequency measurement for a pulse train and take the inverse to g
the period. The Measure Frequency < 1 kHz (8253) VI located in 
labview\examples\daq\8253.llb  measures frequency and calculate
the period for you.
LabVIEW Data Acquisition Basics Manual 26-10 © National Instruments Corporation
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Counting Signal Highs and Lows

This chapter describes the various ways you can count TTL signals us
the counters on your data acquisition (DAQ) device. Counters can cou
external events such as rising and falling edges on the SOURCE (CLK
input pin. They can also count elapsed time using the rising and falling
edges of an internal timebase. A useful example of counting events wo
be if you wanted to calculate the output of a production line. A useful 
example of counting time would be if you wanted to calculate how long
takes to produce one item on a production line.

Connecting Counters to Count Events and Time
Figure 27-1 shows typical external connections for counting events. In
figure, your device provides the TTL signal to be counted, and it is 
connected to the SOURCE (CLK) of counter. The number of events 
counted is determined by reading the count register of counter.

Figure 27-1.  External Connections for Counting Events

Figure 27-2 shows typical external connections for counting elapsed 
time. In the figure, your device provides a pulse to the GATE of counte
While the gate pulse is high, counter counts a known internal timebas
Dividing the count by the internal timebase determines the elapsed tim

Figure 27-2.  External Connections for Counting Elapsed Time
 Data Acquisition Basics Manual
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Am9513
With the Am9513, you can extend the counting range of a counter by 
connecting the OUT of one counter to the SOURCE of the next higher
order counter (counter+1). This is called cascading counters. By cascading
counters you can increase your counting range from a 16-bit counting ra
of 65,535 to a 32-bit counting range of 4,294,967,295. The Am9513 ch
has a set of 5 counters where higher order counters can be cascaded
TIO-10 device has two Am9513 chips for a total of 10 counters. Table 2
identifies adjacent counters on the Am9513 (one and two chips). This 
information is useful when cascading counters.

Figure 27-3 shows typical external connections for cascading counters
when counting events. Notice that the OUT of counter is connected to the 
SOURCE of counter+1.

Figure 27-3.  External Connections to Cascade Counters for Counting Events

Table 27-1.  Adjacent Counters for Counter Chips

Next Lower Counter Counter Next Higher Counter

5 1 2

1 2 3

2 3 4

3 4 5

4 5 1

10 6 7

6 7 8

7 8 9

8 9 10

9 10 6
LabVIEW Data Acquisition Basics Manual 27-2 © National Instruments Corporation



Chapter 27 Counting Signal Highs and Lows

 

 

ire 
Figure 27-4 shows typical external connections for cascading counters
when counting elapsed time. Notice that the OUT of counter is connected 
to the SOURCE of counter+1.

Figure 27-4.  External Connections to Cascade Counters for Counting Elapsed Time

Counting Events
How you count events depends upon which counter chip is on your 
DAQ device. If you are uncertain which counter your DAQ device has,
refer to your hardware documentation.

DAQ-STC
Figure 27-5 shows the Count Events-Easy (DAQ-STC) VI located 
in labview\examples\daq\DAQ-STC.llb . This example uses the 
Count Events or Time-Easy VI which can be found in Functions» 
Data Acquisition»Counter.

Figure 27-5.  Diagram of Count Events-Easy (DAQ-STC) VI

This VI initiates the counter to count the number of rising edges of a 
TTL signal at the SOURCE of counter. The counter continues counting 
until the STOP button is pressed. Remember that you must externally w
your signal to be counted to the SOURCE of counter. For a description of 
this example, refer to the information found in Windows»Show VI Info….
© National Instruments Corporation 27-3 LabVIEW Data Acquisition Basics Manual
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If you need more control over when your event counting begins and en
use the Intermediate VIs instead of the Easy VIs. Figure 27-6 shows t
Count Events-Int (DAQ-STC) VI located in labview\examples\ 

daq\DAQ-STC.llb .

Figure 27-6.  Diagram of Count Events-Int (DAQ-STC) VI

This example uses the following Intermediate VIs: Event or Time Coun
Config, Counter Start, Counter Read, and Counter Stop. The Event or T
Counter Config VI configures counter to count the number of rising edges
of a TTL signal at its SOURCE input pin. The Counter Start VI begins t
counting operation for counter. The Counter Read VI returns the count 
until the STOP button is pressed or an error occurs. Finally, the Counte
Stop VI stops the counter operation. Remember that you must externa
wire your signal to be counted to the SOURCE of counter. You can 
optionally gate counter with a pulse to control when it starts and stops 
counting. To do this, wire your pulse to the GATE of counter, and choo
the appropriate gate mode from the front panel menu. For a complete 
description of this example, refer to the information found in 
Windows»Show VI Info….

Am9523
Figure 27-7 shows the Count Events-Easy (9513) VI located in 
labview\examples\daq\Am9513.llb . This example uses the 
Count Events or Time-Easy VI which can be found in Functions» 
Data Acquisition»Counter.
LabVIEW Data Acquisition Basics Manual 27-4 © National Instruments Corporation
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Figure 27-7.  Diagram of Count Events-Easy (9513) VI

This VI initiates the counter to count the number of rising edges of a 
TTL signal at the SOURCE of counter. The counter continues counting
until the STOP button is pressed. Remember that you must externally w
your signal to be counted to the SOURCE of counter. Additionally, you 
can cascade two counters by choosing two counters (32-bits) in the 
number of counters to use menu. This will extend your counting range to
over 4 billion. You must also wire the OUT of counter to the SOURCE of 
counter+1 for this increased counting range. For a complete description
this example, refer to the information found in Windows»Show VI Info…. 

If you need more control over when your event counting begins and 
ends, use the Intermediate VIs instead of the Easy VIs. Figure 27-8 sh
the Count Events-Int (9513) VI located in labview\examples\ 

daq\Am9513.llb .

Figure 27-8.  Diagram of Count Events-Int (9513) VI
© National Instruments Corporation 27-5 LabVIEW Data Acquisition Basics Manual
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This example uses the following Intermediate VIs: Event or Time Coun
Config, Counter Start, Counter Read, and Counter Stop. The Event or T
Counter Config VI configures counter to count the number of rising edges
of a TTL signal at its SOURCE input pin. The Counter Start VI begins t
counting operation for counter. The Counter Read VI returns the count 
until the STOP button is pressed or an error occurs. Finally, the Counte
Stop VI stops the counter operation. Remember that you must externa
wire your signal to be counted to the SOURCE of counter. You can 
optionally gate counter with a pulse to control when it starts and stops
counting. To do this, wire your pulse to the GATE of counter, and choose 
the appropriate gate mode from the front panel menu. Additionally, you 
can cascade two counters by choosing two counters (32-bits) in the 
number of counters to use menu. This will extend your counting range to
over 4 billion. You must also wire the OUT of counter to the SOURCE of 
counter+1 for this increased counting range. For a complete description
this example, read the information found in Window»Show VI Info….

8253/54
Figure 27-9 shows the Count Events (8253) VI located in 
labview\examples\daq\8253.llb . This example uses the 
Intermediate VI, ICTR Control which can be found in Functions»
Data Acquisition»Counter»Intermediate Counter.

Figure 27-9.  Diagram of Count Events (8253) VI
LabVIEW Data Acquisition Basics Manual 27-6 © National Instruments Corporation
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This VI initiates the counter to count the number of rising edges of a 
TTL signal at the CLK of counter. Looking at the diagram, the first call to
ICTR Control loads the count register and sets up counter to count down. 
The second call to ICTR Control reads the count register. Inside the fir
while loop, the count is read until it changes. While the count register 
been previously loaded, the new value is not active until the first edge
counted on the CLK pin. Once the first edge comes in, the second wh
loop takes over and continually reads the count until the STOP button is 
pressed or an error occurs. Remember that you must externally wire y
signal to be counted to the CLK of counter. For a complete description
this example, refer to the information found in Windows»Show VI Info….

Counting Elapsed Time
How you count elapsed time depends upon which counter chip is on y
DAQ device. If you are unsure of which chip your DAQ device has, re
to your hardware documentation.

DAQ-STC
Figure 27-10 shows the Count Time-Easy (DAQ-STC) VI located in 
labview\examples\daq\DAQ-STC.llb . This example uses the 
Count Events or Time-Easy VI, which can be found in Functions» 
Data Acquisition»Counter.

Figure 27-10.  Diagram of Count Time-Easy (DAQ-STC) VI

This VI initiates the counter to count the number of rising edges of a kno
internal timebase at the SOURCE of counter. The Count Events or Time 
VI takes care of dividing the count by the timebase frequency to determ
the elapsed time. The counter continues timing until the STOP button is 
© National Instruments Corporation 27-7 LabVIEW Data Acquisition Basics Manual
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pressed. You do not need to make any external connections. The leng
time that can be counted depends on the maximum count of the counte
the chosen timebase. For example, the 16,777,216 (24-bit) count of the 
DAQ-STC and a timebase of 20 MHz can count time for 838 ms. Using
100 kHz timebase, you can count time for 167 seconds. For a comple
description of this example, refer to the information found in 
Windows»Show VI Info….

If you need more control over when your elapsed timing begins and en
use the Intermediate VIs instead of the Easy VIs. Figure 27-11 shows
Count Time-Int (DAQ-STC) VI located in labview\examples\ 

daq\DAQ-STC.llb .

Figure 27-11.  Diagram of Count Time-Int (DAQ-STC) VI

This example uses the following Intermediate VIs: Event or Time Coun
Config, Counter Start, Counter Read, and Counter Stop. The Event or T
Counter Config VI configures counter to count the number of rising edges
of a known internal timebase. The Counter Start VI begins the countin
operation for counter. The Counter Read VI returns the count until the 
STOP button is pressed or an error occurs. The count value is divided
the timebase to determine the elapsed time. Finally, the Counter Stop VI 
stops the counter operation. You do not need to make any external 
connections, but you can optionally gate counter with a pulse to contro
when it starts and stops timing. To do this, wire your pulse to the GATE
counter, and choose the appropriate gate mode from the front panel menu. 
For a complete description of this example, refer to the information fou
in Windows»Show VI Info….
LabVIEW Data Acquisition Basics Manual 27-8 © National Instruments Corporation
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Am9513
Figure 27-12 shows the Count Time-Easy (9513) VI located in 
labview\examples\daq\Am9513.llb . This example uses the Count 
Events or Time-Easy VI, which can be found in Functions»Data 
Acquisition»Counter.

Figure 27-12.  Diagram of Count Time-Easy (9315) VI

This VI initiates the counter to count the number of rising edges of a kno
internal timebase at the SOURCE of counter. The Count Events or Time 
VI takes care of dividing the count by the timebase frequency to determ
the elapsed time. The counter continues timing until the STOP button is 
pressed. You do not need to make any external connections if the number 
of counters to use menu is set to one counter (16-bits). If you set the 
number of counters to use menu to two counters (32-bits), you must 
externally wire the OUT of counter to the SOURCE of counter+1. The 
length of time that can be counted depends on the maximum count of
counter(s) and the chosen timebase. For example, the 65535 (16-bit) coun
of the Am9513 and a timebase of 1 MHz can count time for 65 ms. Us
the 100 Hz timebase and two counters (32-bits), you can count time for 
a year. For a complete description of this example, refer to the informa
found in Windows»Show VI Info….
© National Instruments Corporation 27-9 LabVIEW Data Acquisition Basics Manual
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If you need more control over when your elapsed timing begins and 
ends, use the Intermediate VIs instead of the Easy VIs. Figure 27-13 
shows the Count Time-Int (9513) VI located in labview\examples\ 

daq\Am9513.llb .

Figure 27-13.  Diagram of Count Time-Int (9513) VI

This example uses the following Intermediate VIs: Event or Time Coun
Config, Counter Start, Counter Read, and Counter Stop. The Event or T
Counter Config VI configures counter to count the number of rising edges
of a known internal timebase. The Counter Start VI begins the countin
operation for counter. The Counter Read VI returns the count until the 
STOP button is pressed or an error occurs. The count value is divided
the timebase to determine the elapsed time. Finally, the Counter Stop VI 
stops the counter operation. You can optionally gate counter with a pulse 
to control when it starts and stops timing. To do this, wire your pulse to
the GATE of counter, and choose the appropriate gate mode from the 
front panel menu. Additionally, you can cascade two counters by choos
two counters (32-bits) in the number of counters to use menu. This 
extends your elapsed time range. You must also wire the OUT of counter 
to the SOURCE of counter+1 for this increased range. For a complete 
description of this example, refer to the information found in 
Windows»Show VI Info….
LabVIEW Data Acquisition Basics Manual 27-10 © National Instruments Corporation
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Figure 27-14 shows the Count Time (8253) VI located in 
labview\examples\daq\8253.llb . This example uses the 
ICTR Control-Int VI, which can be found in Functions» 
Data Acquisition»Counter»Intermediate Counter.

Figure 27-14.  Diagram of Count Time (8253) VI

This VI initiates the counter to count the number of rising edges of a 
TTL timebase at the CLK of counter. Counter 0 creates the timebase. 
Looking at the diagram, the Timebase Generator (8253) VI sets up 
Counter 0 to generate a timebase by dividing down its internal timebas
The first call to ICTR Control loads the count register and sets up counter 
to count down. Inside the while loop, ICTR Control reads the count, wh
is divided by the actual timebase frequency to determine the elapsed time. 
The elapsed time increments until the STOP button is pressed or an error
occurs. The last two calls to ICTR Control reset Counter 0 and counter. 
Remember that you must externally wire the OUT of Counter 0 to the 
CLK of counter. You can optionally gate counter with a pulse to control 
when it starts and stops timing. To do this, wire your pulse to the GATE
counter. For a complete description of this example, refer to the informa
found in Windows»Show VI Info….
© National Instruments Corporation 27-11 LabVIEW Data Acquisition Basics Manual
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Dividing Frequencies

Dividing TTL frequencies is useful if you want to use an internal timeba
and the frequency you need does not exist. You can divide an existing
internal frequency to get what you need. You can also divide the freque
of an external TTL signal. Frequency division results in a pulse or puls
train from a counter for every N cycles of an internal or external source. 
Counters can only decrease (divide down) the frequency of the source
signal. The resulting frequency is equal to the input frequency divided
by N (timebase divisor). N must be an integer number greater than 1. 
Performing frequency division on an internal signal is called a down 
counter. Frequency division on an external signal is called a signal divider. 
Figure 28-1 shows typical wiring for frequency division.

Figure 28-1.  Wiring Your Counters for Frequency Division

counter

your
device

your
device

your
device

gate

source
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counter
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Frequency Division for a Signal Divider

Frequency Division for a Down Counter
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DAQ-STC, Am9513
Figure 28-2 shows an example of a signal divider. It uses the Intermed
counter VIs Down Counter or Divide, Counter Start, and Counter Stop

Figure 28-2.  Programming a Single Divider for Frequency Division

The Down Counter or Divide Config VI configures the specified counter
divide the SOURCE signal by the timebase divisor value and output a 
signal when the counter reaches its terminal count (TC). Using Down 
Counter or Divide Config VI, you can configure the type of output to be
pulse or toggled. The diagram above outputs a high pulse lasting one c
of the source signal once the counter reaches its TC. For more informa
on the different types of signal outputs, refer to the Down Counter or Div
Config VI description in Chapter 27, Intermediate Counter VIs, of the 
LabVIEW Function and VI Reference Manual, or the LabVIEW Online 
Reference, available by selecting Help»Online Reference…. The diagram 
above counts the rising edges of the SOURCE signal, the default valu
the source edge input. In order to figure out where the inputs and outpu
are located on this VI, remember to use the Help window. Open this 
window by choosing Help»Show Help.

The Counter Start VI tells the counter to start counting the SOURCE sig
edges. The counter only stops the frequency division when the stop bu
is pressed. The Counter Stop VI stops the counter immediately and cl
the count register. It is a good idea to always check your errors at the 
of an operation to see if the operation was successful.

You can alter the Down Counter or Divide Config VI to create a 
down counter. To do this, change the timebase value from 0.0  
(external SOURCE) to a frequency available on your counter. With the
Am9513 chip, you can choose timebases of 1 MHz, 100 kHz, 10 kHz,
1 kHz, and 100 Hz. With the DAQ-STC chip, you can choose timebase
of 20 MHz and 100 kHz.
LabVIEW Data Acquisition Basics Manual 28-2 © National Instruments Corporation
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Instead of triggering frequency division for signal dividers and down 
counters by software, as previously described, you can trigger using th
GATE signal. You can trigger while the GATE signal is high, low, or on th
rising or falling edge. For more information, refer to the Down Counter
Divide Config VI description in Chapter 27, Intermediate Counter VIs, of 
the LabVIEW Function and VI Reference Manual, or the LabVIEW Online 
Reference, available by selecting Help»Online Reference…. 

8253/54
To divide a frequency with the 8253/54 counter chip, use the example C
Pulse Train (8253) VI located in labview\examples\daq\8253.llb . 
This example is explained in Chapter 24 in the Generating a Pulse Train 
section. For a complete description of this example, refer to the informa
found in Windows»VI Info… .
© National Instruments Corporation 28-3 LabVIEW Data Acquisition Basics Manual
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Debugging Your Data 
Acquisition Application

This section contains an explanation of ways you can debug your d
acquisition application to make sure your application is accurate an
runs smoothly. 

Part VII, Debugging Your Data Acquisition Application, contains the 
following chapter:

• Chapter 29, Debugging Techniques, shows you some tips to help 
figure out why your VI is not working.
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Debugging Techniques

Is your VI not working as you expected? This chapter shows you some
to help figure out why your VI is not working. First, find your LabVIEW 
User Manual because this manual is referenced in this section. With 
LabVIEW data acquisition (DAQ) applications, you might find errors in
hardware connections, software configuration, or VI construction. The g
of this chapter is to help you narrow down where the problem is in you
program flow.

Hardware Connection Errors
When no error occurs, but the data is not what you expected, then you
may want to check your hardware connections and jumper settings. 
For example, if you have an analog input application, make sure your 
signals are properly grounded. For more information on analog input 
configuration issues, refer to Chapter 5, Things You Should Know 
about Analog Input.

For SCXI modules, you must verify that gain jumpers are set up prope
To verify how a DAQ device gets set to a certain gain (or limit setting 
as noted in the software), refer to Chapter 3, Basic LabVIEW Data 
Acquisition Concepts. Another common SCXI hardware error is using 
digital lines on your DAQ device that are reserved for communication 
with the SCXI modules.

In order to test that your hardware has not been damaged, connect a 
known voltage to the channels you are using. To check the location of
any hardware connections, refer to your hardware user manual.
 Data Acquisition Basics Manual
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Software Configuration Errors
As you check hardware connections, it is a good idea to verify that the
NI-DAQ software configuration reflects your hardware setup. For possi
difficulties with software configuration, read Chapter 2, Installing and 
Configuring Your Data Acquisition Hardware, the chapter of this manual 
that describes your specific application, or the NI-DAQ User Manual.

(Windows) In the NI-DAQ Configuration utility, you can use the NI-DAQ 
Test Panels to verify that your device is operating properly. Refer to th
NI-DAQ Configuration Utility Help for more details.

VI Construction Errors
The various sections below describe methods to find problems with VI
construction. All the techniques described can be used by themselves
conjunction with one another. 

Error Handling
The best way to determine if your application executed without an erro
to use one of the error handler VIs in your application. The Error Hand
VIs are located in Functions»Time & Dialog. You can only use these VIs
with Intermediate and Advanced VIs. Easy I/O VIs already include erro
handling capabilities within each VI. Each Intermediate and Advanced
has an error input and output clusters (named error in  and error out , 
respectively). The error clusters contain a Boolean that indicates whe
an error occurred, the error code for the error, and the name of the VI 
returned the error. If error in  indicates an error, the VI returns the same
error information in error out , and does not perform any DAQ operation

When you use any of the Intermediate or Advanced VIs in a While Loo
you should stop the loop if the status in the error out  cluster reads TRUE. 
If you wire the error cluster to the General Error Handler VI or the Simp
Error Handler VI, the VI deciphers the error information and describes 
error to you. Figures 29-1 and 29-2 show how to wire a typical DAQ VI
an error handler.
LabVIEW Data Acquisition Basics Manual 29-2 © National Instruments Corporation
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Figure 29-1.  Error Checking Using the General Error Handler VI

Figure 29-2.  Error Checking Using the Simple Error Handler VI

The following figure shows an example of the dialog box the Error Hand
VIs display if an error occurs.

Please refer to the LabVIEW Function and VI Reference Manual or the 
LabVIEW Online Reference, available by selecting Help»Online 
Reference…, for more information on the error handler VIs.

Single-Stepping through a VI
Single-stepping through a VI allows you to execute one node at a time
the block diagram. A node can be subVIs, functions, structures, formu
nodes, and attribute nodes. Refer to Chapter 2, Creating VIs, in the 
LabVIEW User Manual, and Chapter 4, Executing and Debugging VIs and
SubVIs, in the G Programming Reference Manual for more information 
about single-stepping.
© National Instruments Corporation 29-3 LabVIEW Data Acquisition Basics Manual
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Execution Highlighting
Execution highlighting (the light bulb button on the diagram) shows yo
how data passes from one node to another in your program. When you
execution highlighting on, data movement is marked by bubbles movin
along the wires. Refer to Chapter 2, Creating VIs, in the LabVIEW User 
Manual, and Chapter 4, Executing and Debugging VIs and SubVIs, in the 
G Programming Reference Manual for more information about execution
highlighting.

Using the Probe Tool
If your VI is producing questionable results, you may want to use the Pr
tool to check intermediate values in a VI. The Probe tool will help you 
narrow down where the incorrect results are occurring. Refer to Chapte
Creating VIs, in the LabVIEW User Manual and Chapter 4, Executing and 
Debugging VIs and SubVIs, in the G Programming Reference Manual for 
more information on using the probe.

Setting Breakpoints and Showing Advanced DAQ VIs
Once you have narrowed down the location of an error to a subVI, 
you can set a breakpoint on that subVI to cause VI execution to pause
before executing the subVI. You can now see what values get passed
in or are generated by the Advanced VIs, single-step through the subV
execution, probe wires to see data, or change values of front panel 
controls. Refer to Chapter 2, Creating VIs, in the LabVIEW User Manual 
and Chapter 4, Executing and Debugging VIs and SubVIs, in the 
G Programming Reference Manual for more information on how to set a 
breakpoint.
LabVIEW Data Acquisition Basics Manual 29-4 © National Instruments Corporation
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LabVIEW Data Acquisition 
Common Questions

This appendix lists answers to questions frequently asked by 
LabVIEW users. 

Where is the best place to get up to speed quickly with data acquisition
and LabVIEW?

Read the LabVIEW Data Acquisition Basics Manual and look at the 
run_me.llb  examples, in labview\examples\daq\run_me.llb , 
included with the package. In Windows, run the DAQ Channel Wizard a
the DAQ Solution Wizard.

What is the easiest way to address my AMUX-64T board with my 
MIO board?

Set the number of AMUX boards used in the NI-DAQ Configuration utili
(nidaqconf.exe  on Windows or NI-DAQ  control panel on Macintosh). 
Then in the channel string inputs specify the onboard channel. For exam
with one AMUX-64T board, the channel string 0:1  will acquire data from 
AMUX channels 0 through 7, and so on.

What are the advantages/disadvantages of reading AI Read’s backlog
rather than a fixed amount of data?

Reading the backlog is guaranteed not to cause a synchronous wait fo
data to arrive. However, it adds more delay until the data is processed
(because the data was available on the last call) and it can require con
reallocation or size adjustments of the data acquisition read buffer in 
LabVIEW.

What is the easiest way to verify that my board works and is acquiring 
data from my signals?

Run one of the examples in the labview\examples\daq  folder or run the 
test panel for your board in the NI-DAQ Configuration utility.
on Basics Manual
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How can I tell when a continuous data acquisition operation does not 
have enough buffer capacity?

The scan backlog rises with time, either steadily or in jumps, or takes a 
time to drop to normal after an interrupting activity like mouse moveme
If you can open another VI during the operation without receiving an 
overrun error you should have adequate buffer capacity.

I want to group two or more ports using my DIO32, DIO24, or 
DIO-96 board, but I do not want to use handshaking. I just want to 
read one group of ports just once. How can I set it up in software?

Use Easy I/O VIs (Write to Digital Port or Read from Digital Port) or 
Advanced Digital VIs (DIO Port Config, DIO Port Write or DIO Port 
Read), and set multiple ports in the port list. For Easy I/O VIs, you can
specify up to four ports in the port list. Whatever data you try to output
each port of your “group” will correspond to each element of the data ar
This also applies for input.

I want to use the OUT1, OUT2, OUT3 and IN1, IN2, IN3 pins on my 
DIO-32F board. How do I address those pins using the Easy I/O Digital 
VIs in LabVIEW?

These output and inputs pins are addressed together as port 4. OUT1
IN1 are referred to as bit 0, OUT2 and IN2 are referred to as bit 1, and
OUT3 and IN3 are referred to as bit 2. Only the NB-DIO-32F has three p
for each direction. If you use the Write To Digital Port VI, you will outpu
on the OUT pins, and if you use the Read From Digital Port VI, you wi
input from the IN pins.

I want to be able to write up to four lines on the digital port on my 
jumpered MIO (non E-series) board while also reading in four lines of 
digital data on the remaining free digital lines. How do I do this?

Use the DIO Port Config VI twice; once to configure four lines for outp
and once more to configure four lines for input. Now call the DIO Port 
Write VI or the DIO Port Read VI for the appropriate lines. Avoid callin
the Easy I/O VIs for digital I/O, as they reconfigure the port direction ea
time the VI is called.
LabVIEW Data Acquisition Basics Manual A-2 © National Instruments Corporation
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I want to use a TTL digital trigger pulse to start data acquisition on 
my DAQ device. I noticed there are two types of triggers: Digital 
Trigger A, and Digital Trigger A&B. Which digital trigger setting 
should I use and where should I connect the signal?

You should use Digital Trigger A, which stands for “first trigger,” to start
data acquisition. Digital Trigger B, which stands for “second trigger,” 
should only be used if you are doing both a start AND a stop trigger fo
your data acquisition. Connect your trigger signal to either STARTTRIG
(pin 38) if you are using an AT-MIO-16, AT-MIO-16D, NB-MIO-16X, or
EXTTRIG* or DTRIG for any other board that has that pin. If you are usi
an E-series device, you can select which PFI pin to connect to. If you do
specify the PFI pin, it uses the defaults as the PFI pin names suggest
example, PFI0/TRIG1. The only analog input boards on which you can
do a digital trigger are the LPM devices, DAQCard-700, DAQCard-500
and the 516 devices. Refer to the AI Trigger Config description in 
Chapter 18, Advanced Analog Input VIs, in the LabVIEW Function and VI 
Reference Manual, or the LabVIEW Online Reference, available by 
selecting Help»Online Reference…, for more information on the use of 
digital triggers on your DAQ device.

Note The NB-MIO-16 has an EXTTRIG* pin, but cannot support start and stop 
triggering.

When are the data acquisition devices initialized?

All data acquisition devices are initialized automatically when the first 
DAQ VI is loaded in on a diagram when you start LabVIEW. You can al
initialize a particular device by calling the Device Reset VI.

(Windows) I open a VI that calls a DAQ VI, or drop a DAQ subVI on a 
block diagram, and crash.

The first time a DAQ VI is loaded into memory in LabVIEW, LabVIEW 
opens the Dynamic Link Library (dll ) that controls data acquisition. 
A crash at this time indicates a problem communicating with the driver
This may indicate there is a conflict with another device in the machin

To determine the source of the problem, quit LabVIEW and Windows, 
re-launch Windows, and run the NI-DAQ Configuration Utility. Run a 
simple configuration test with the DAQ devices in the machine. If this 
results in a crash, there is probably a conflict with another device in th
machine or the driver’s file versions do not correspond for some reaso
© National Instruments Corporation A-3 LabVIEW Data Acquisition Basics Manual
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If not, you need to obtain the latest version of the DAQ driver from the 
NI BBS, World Wide Web, or FTP site.

We have also seen cases where the video driver conflicts with both th
NI-DAQ Configuration Utility and LabVIEW. You can obtain the 
Error Messages and Crashes Common Questions document from the 
NI Fax-on-Demand system.

(Windows) I bought LabVIEW for Windows and also have a slightly 
older DAQ device from National Instruments. I installed the entire 
LabVIEW package, but should I go ahead and install my NI-DAQ for 
Windows drivers that I originally got with the board?

In most cases, the answer is no. The LabVIEW installer installs a set 
DAQ driver files that are guaranteed to work with LabVIEW, whereas i
you happen to install an older version of the drivers afterwards, you m
run into many problems. You may even end up crashing your compute
every time you do any data acquisition. If you buy a new DAQ device a
if you already have LabVIEW installed, it is safe to install the NI-DAQ fo
Windows drivers from those disks. In any case, make sure you install 
use the latest version of the NI-DAQ drivers, unless a dialog box at 
installation tells you your board is no longer supported on that version
LabVIEW Data Acquisition Basics Manual A-4 © National Instruments Corporation
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.

Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com
on Basics Manual
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Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
LabVIEW Data Acquisition Basics Manual B-2 © National Instruments Corporation
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed ___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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LabVIEW Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of eac
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
DAQ hardware ______________________________________________________________

Interrupt level of hardware ______________________________________________________

DMA channels of hardware ____________________________________________________

Base I/O address of hardware ___________________________________________________

Programming choice __________________________________________________________

NI-DAQ or LabVIEW version ____________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards ________________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________

Other Products
Computer make and model ____________________________________________________

Microprocessor ______________________________________________________________

Clock frequency or speed ______________________________________________________

Type of video board installed ___________________________________________________

Operating system version ______________________________________________________

Operating system mode _______________________________________________________

Programming language _______________________________________________________

Programming language version _________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards _______________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________



____
Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 
This information helps us provide quality products to meet your needs.

Title: LabVIEW™ Data Acquisition Basics Manual

Edition Date: January 1998

Part Number: 320997C-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________
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E-4. 
Prefix Meaning Value

k- kilo- 103

M- mega- 106

m- milli- 10–3

µ- micro- 10–6

n- nano- 10–9

Numbers/Symbols

1D One-dimensional.

2D Two-dimensional. 

A

A Amperes.

AC Alternating current. 

A/D Analog-to-digital. 

ADC Analog-to-digital converter. An electronic device, often an integrated 
circuit, that converts an analog voltage to a digital number. 

ADC resolution The resolution of the ADC, which is measured in bits. An ADC with 
16 bits has a higher resolution, and thus a higher degree of accuracy 
a 12-bit ADC.

AI Analog input. 

AI device An analog input device that has AI in its name, such as the NEC-AI-16

AIGND The analog input ground pin on a DAQ device.
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amplification A type of signal conditioning that improves accuracy in the resulting 
digitized signal and to reduce noise.

Am9513-based devices These MIO devices do not have an E- in their names. These devices 
the NB-MIO-16, NB-MIO-16X, NB-A2000, NB-TIO-10, and 
NB-DMA2800 on the Macintosh; and the AT-MIO-16, AT-MIO-16F-5, 
AT-MIO-16X, AT-MIO-16D, and AT-MIO-64F-5 in Windows. 

AMUX devices See analog multiplexers.

anlogin.llb A LabVIEW DAQ library containing VIs that perform analog input with 
DAQ devices and can write or stream the acquired data to disk.

anlog_io.llb A LabVIEW DAQ library containing VIs for analog I/O control loops.

analog input group A collection of analog input channels. You can associate each group
its own clock rates, trigger and buffer configurations, and so on. A chan
cannot belong to more than one group. 

Because each board has one ADC, only one group can be active at a
given time. That is, once a control VI starts a timed acquisition with 
groupn, subsequent control and read calls must also refer to group n. 
You use the task ID to refer to the group. 

analog multiplexer Devices that increase the number of measurement channels while still
an single instrumentation amplifier. Also called AMUX devices.

anlogout.llb A LabVIEW DAQ library containing VIs that generate single values or 
multiple values (waveforms) to output through analog channels.

analog output group A collection of analog output channels. You can associate each grou
its own clock rates, buffer configurations, and so on. A channel canno
belong to more than one group. 

analog trigger A trigger that occurs at a user-selected level and slope on an incomin
analog signal. Triggering can be set to occur at a specified voltage on e
an increasing or a decreasing signal (positive or negative slope). 

AO Analog output. 

array Ordered, indexed set of data elements of the same type.
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BCD Binary-coded decimal. 

bipolar A signal range that includes both positive and negative values 
(for example, –5 to 5 V). 

buffer Temporary storage for acquired or generated data. 

C

cascading Process of extending the counting range of a counter chip by connect
the next higher counter.

channel Pin or wire lead to which you apply or from which you read the analo
digital signal. Analog signals can be single-ended or differential. For dig
signals, you group channels to form ports. Ports usually consist of eith
four or eight digital channels.

channel clock The clock controlling the time interval between individual channel 
sampling within a scan. Boards with simultaneous sampling do not ha
this clock.

channel name A unique name given to a channel configuration in the DAQ Channe
Wizard.

circular-buffered I/O Input/output operation that reads or writes more data points than can
the buffer. When LabVIEW reaches the end of the buffer, LabVIEW 
returns to the beginning of the buffer and continues to transfer data. 

clock Hardware component that controls timing for reading from or writing to
groups.

cluster A set of ordered, unindexed data elements of any data type including
numeric, Boolean, string, array, or cluster. The elements must be all 
controls or all indicators.

code width The smallest detectable change in an input voltage of a DAQ device.

column-major order A way to organize the data in a 2D array by columns. 

common-mode voltage Any voltage present at the instrumentation amplifier inputs with resp
amplifier ground.
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conditional retrieval A method of triggering in which you to simulate an analog trigger usin
software. Also called software triggering.

configuration utility Refers to NI-DAQ on the Macintosh, nicfg16.exe  on Windows 3.1, and 
nidaqcfg.exe  on Windows 95/NT. 

conversion device Device that transforms a signal from one form to another. For examp
analog-to-digital converters (ADCs) for analog input, digital-to-analog 
converters (DACs) for analog output, digital input or output ports, and 
counter/timers are conversion devices. 

counter.llb A LabVIEW DAQ library containing VIs that count the rising and falling
edges of TTL signals, generate TTL pulses, and measure the frequenc
period of TTL signals.

counter/timer group A collection of counter/timer channels. You can use this type of grou
simultaneous operation of multiple counter/timers.

coupling The manner in which a signal is connected from one location to anoth

D

D/A Digital-to-analog. 

DAC Digital-to-analog converter. An electronic device, often an integrated 
circuit, that converts a digital number into a corresponding analog volt
or current.

DAQ Channel Wizard Utility that guides you through naming and configuring your DAQ ana
and digital channels.

DAQ Solution Wizard Utility that guides you through specifying your DAQ application, from
which it provides a custom DAQ solution.

data acquisition Process of acquiring data, typically from A/D or digital input plug-in 
boards. 

data flow Programming system consisting of executable nodes in which nodes 
execute only when they have received all required input data and prod
output automatically when they have executed. LabVIEW is a dataflow
system.

default input The default value of a front panel control. 
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default setting A default parameter value recorded in the driver. In many cases, the
default input of a control is a certain value (often 0) that means use the 
current default setting. For example, the default input for a parameter 
may be do not change current setting, and the default setting may be 
no AMUX-64T boards. If you do change the value of such a parameter,
the new value becomes the new setting. You can set default settings f
some parameters in the configuration utility. 

device A DAQ device inside your computer or attached directly to your compu
through a parallel port. Plug-in boards, PC cards, and devices such as
DAQPad-1200, which connects to your computer’s parallel port, are a
examples of DAQ devices. SCXI modules are distinct from devices, w
the exception of the SCXI-1200, which is a hybrid. 

device number The slot number or board ID number assigned to the device when yo
configured it.

DIFF Differential. A differential input is an analog input consisting of two 
terminals, both of which are isolated from computer ground and whos
difference you measure. 

differential 
measurement system

A way you can configure your device to read signals, in which you do 
need to connect either input to a fixed reference, such as the earth or 
building ground.

digio.llb A LabVIEW DAQ library containing VIs that perform immediate digital
I/O and digital handshaking with DAQ devices and SCXI modules.

digital input group A collection of digital input ports. You can associate each group with 
own clock rates, handshaking modes, buffer configurations, and so on
A port cannot belong to more than one group. 

digital output group A collection of digital output ports. You can associate each group wit
own clock rates, handshaking modes, buffer configurations, and so fo
A port cannot belong to more than one group. 

digital trigger A TTL signal that you can use to start or stop a buffered data acquisit
operation, such as buffered analog input or buffered analog output.

DIO devices Refers to all devices with the letters DIO in their name, unless otherw
noted. 

DIP Dual Inline Package. 
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dithering The addition of Gaussian noise to an analog input signal. By applying
dithering and then averaging the input data, you can effectively increase
resolution by another one-half bit.

DLL Dynamic Link Library. 

DMA Direct Memory Access. A method by which data you can transfer data
computer memory from a device or memory on the bus (or from compu
memory to a device) while the processor does something else. DMA is
fastest method of transferring data to or from computer memory. 

down counter Performing frequency division on an internal signal.

driver Software that controls a specific hardware device, such as a data acqui
board. 

DSP Digital Signal Processing. 

E

E-series MIO board Boards, such as the PCI-MIO-16E-1 and the AT-MIO-16E-2 which u
the MITE chip (on PCI boards for bus mastering), the DAQ-PnP chip f
Plug and Play configuration, the DAQ-STC chip for instrumentation cla
counting and timing, and the NI-PGIA for high accuracy analog input 
measurements.

EEPROM Electrically erased programmable read-only memory. Read-only mem
that you can erase with an electrical signal and reprogram. 

EISA Extended Industry Standard Architecture. 

event The condition or state of an analog or digital signal.

external trigger A voltage pulse from an external source that triggers an event such a
A/D conversion. 

F

FIFO A first-in-first-out memory buffer. In a FIFO, the first data stored is the fi
data sent to the acceptor. 

filtering A type of signal conditioning that allows you to filter unwanted signals
from the signal you are trying to measure.
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floating signal sources Signal sources with voltage signals that are not connected to an abs
reference or system ground. Some common example of floating signa
sources are batteries, transformers, or thermocouples. Also called 
nonreferenced signal sources. 

G

gain The amplification or attenuation of a signal.

GATE input pin A counter input pin that controls when counting in your application occ

grounded measurement 
system

See referenced single-ended measurement system.

grounded signal sources Signal sources with voltage signals that are referenced to a system
ground, such as the earth or a building ground. Also called referenced 
signal sources.

group A collection of input or output channels or ports that you define. Grou
can contain analog input, analog output, digital input, digital output, or
counter/timer channels. A group can contain only one type of channel
however. You use a task ID number to refer to a group after you creat
You can define up to 16 groups at one time. 

To erase a group, you pass an empty channel array and the group nu
to the group configuration VI. You do not need to erase a group to cha
its membership. If you reconfigure a group whose task is active, LabVIE
clears the task and returns a warning. LabVIEW does not restart the ta
after you reconfigure the group.

H

handle Pointer to a pointer to a block of memory; handles reference arrays a
strings. An array of strings is a handle to a block of memory containing
handles to strings.

handshaked digital I/O A type of digital acquisition/generation where a device or module ac
or transfers data after a digital pulse has been received. Also called latched 
digital I/O.

hardware triggering A form of triggering where you set the start time of an acquisition an
gather data at a known position in time relative to a trigger signal. 
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hex Hexadecimal. 

Hz Hertz. The number of scans read or updates written per second. 

I

IEEE Institute of Electrical and Electronic Engineers. 

immediate digital I/O A type of digital acquisition/generation where LabVIEW updates the 
digital lines or port states immediately or returns the digital value of an
input line. Also called nonlatched digital I/O.

input limits The upper and lower voltage inputs for a channel. You must use a pa
numbers to express the input limits. The VIs can infer the input limits fro
the input range, input polarity, and input gain(s). Similarly, if you wire th
input limits, range, and polarity, the VIs can infer the onboard gains wh
you do not use SCXI.

input range The difference between the maximum and minimum voltages an ana
input channel can measure at a gain of 1. The input range is a scalar v
not a pair of numbers. By itself the input range does not uniquely determ
the upper and lower voltage limits. An input range of 10 V could mean
upper limit of +10 V and a lower of 0 V or an upper limit of +5 V and a
lower limit of –5 V.

The combination of input range, polarity, and gain determines the inpu
limits of an analog input channel. For some boards, jumpers set the in
range and polarity, while you can program them for other boards. Mos
boards have programmable gains. When you use SCXI modules, you
need their gains to determine the input limits.

interrupt A signal indicating that the central processing unit should suspend its
current task to service a designated activity. 

interval scanning Scanning method where there is a longer interval between scans tha
is between individual channels comprising a scan.

I/O Input/output. The transfer of data to or from a computer system involvi
communications channels, operator interface devices, and/or data 
acquisition and control interfaces. 

ISA Industry Standard Architecture. 
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isolation A type of signal conditioning in which you isolate the transducer signa
from the computer for safety purposes. This protects you and your 
computer from large voltage spikes and makes sure the measurements
the DAQ device are not affected by differences in ground potentials.

K

Kwords 1,024 words of memory. 

L

Lab/1200 boards Boards, such as the Lab-PC-1200 and the DAQCard-1200, which us
8253 type counter/timer chip.

LabVIEW Laboratory Virtual Instrument Engineering Workbench.

latched digital I/O A type of digital acquisition/generation where a device or module acc
or transfers data after a digital pulse has been received. Also called 
handshaked digital I/O.

Legacy MIO board Boards, such as the AT-MIO-16, which typically are configured with 
jumpers and switches and are not Plug and Play compatible. They als
the 9513 type counter/timer chip.

limit settings The maximum and minimum voltages of the analog signals you are 
measuring or generating.

linearization A type of signal conditioning in which LabVIEW linearizes the voltage
levels from transducers, so the voltages can be scaled to measure ph
phenomena.

LSB Least Significant Bit. 

M

MB Megabytes of memory. 1 MB is equal to 1,024 KB.

memory buffer See buffer. 
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multibuffered I/O Input operation for which you allocate more than one memory buffer s
you can read and process data from one buffer while the acquisition fi
another. 

multiplexed mode An SCXI operating mode in which analog input channels are multiple
into one module output so that your cabled DAQ device has access to
module’s multiplexed output as well as the outputs on all other multiplex
modules in the chassis through the SCXI bus. Also called serial mode.

multiplexer A set of semiconductor or electromechanical switches with a common
output that can select one of a number of input signals and that you 
commonly use to increase the number of signals measured by one AD

N

NB NuBus.

NI-DAQ The NI-DAQ configuration utility on the Macintosh.

NI-PNP.EXE A stand-alone executable that NI-DAQ installs in your NI-DAQ root driv
that detects and configures any Plug and Play devices you have in yo
computer.

NI-PNP.INI A file, generated by the NI-PNP.EXE , that contains information about all 
the National Instruments devices in your computer, including Plug and
Play devices.

NIDAQCFG.EXE The NI-DAQ configuration utility in Windows.

nodes Execution elements of a block diagram consisting of functions, structu
and subVIs.

nonlatched digital I/O A type of digital acquisition/generation where LabVIEW updates the 
digital lines or port states immediately or returns the digital value of an
input line. Also called immediate digital I/O.

non-referenced signal 
sources

Signal sources with voltage signals that are not connected to an abso
reference or system ground. Also called floating signal sources. Some 
common example of non-referenced signal sources are batteries, 
transformers, or thermocouples.

Non-referenced 
single-ended (NRSE) 
measurement system

All measurements are made with respect to a common reference, but th
voltage at this reference can vary with respect to the measurement syst
ground.
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NRSE Nonreferenced single-ended. 

O

onboard channels Channels provided by the plug-in data acquisition board. 

OUT output pin A counter output pin where the counter can generate various TTL pu
waveforms.

output limits The upper and lower voltage or current outputs for an analog output 
channel. The output limits determine the polarity and voltage referenc
settings for a board.

P

parallel mode A type of SCXI operating mode in which the module sends each of its i
channels directly to a separate analog input channel of the device to t
module.

pattern generation A type of handshaked (latched) digital I/O in which internal counters
generate the handshaked signal, which in turn initiates a digital transfe
Because counters output digital pulses at a constant rate, this means 
can generate and retrieve patterns at a constant rate because the hand
signal is produced at a constant rate.

PGIA Programmable Gain Instrumentation Amplifier. 

Plug and Play devices Devices that do not require dip switches or jumpers to configure res
on the devices. Also called switchless devices.

postriggering The technique you use on a data acquisition board to acquire a progra
number of samples after trigger conditions are met. 

pretriggering The technique you use on a data acquisition board to keep a continu
buffer filled with data, so that when the trigger conditions are met, the 
sample includes the data leading up to the trigger condition. 

pulse trains Multiple pulses.

pulsed output A form of counter signal generation by which a pulse is outputted wh
counter reaches a certain value.
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R

read mark Points to the scan at which a read operation begins. Analogous to a 
I/O pointer, the read mark moves every time you read data from an inp
buffer. After the read is finished, the read mark points to the next unre
scan. Because multiple buffers are possible, you need both the buffer 
number and the scan number to express the position of the read mark

read mode Indicates one of the four reference marks within an input buffer that 
provides the reference point for the read. This reference can be the re
mark, the beginning of the buffer, the most recently acquired data, or t
trigger position. 

referenced signal sources Signal sources with voltage signals that are referenced to a system
such as the earth or a building ground. Also called grounded signal sources

referenced single-ended 
(RSE) measurement 
system

All measurements are made with respect to a common reference or a
ground. Also called a grounded measurement system.

RMS Root Mean Square. 

row-major order A way to organize the data in a 2D array by rows. 

RSE Referenced Single-Ended. 

RTD Resistance Temperature Detector. A temperature-sensing device who
resistance increases with increases in temperature.

RTSI Real-Time System Integration bus. The National Instruments timing b
that interconnects data acquisition boards directly, by means of connec
on top of the boards, for precise synchronization of functions. 

run_me.llb A LabVIEW DAQ VI library containing VIs that perform basic operation
concerning analog I/O, digital I/O, and counters.

S

sample A single (one and only one) analog or digital input or output data poin

sample counter The clock that counts the output of the channel clock, in other words
number of samples taken. On boards with simultaneous sampling, this
counter counts the output of the scan clock and hence the number of s
LabVIEW Data Acquisition Basics Manual G-12 © National Instruments Corporation
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scan One or more analog or digital input samples. Typically, the number of in
samples in a scan is equal to the number of channels n the input group
example, one pulse from the scan clock produces one scan which acq
one new sample from every analog input channel in the group.

scan clock The clock controlling the time interval between scans. On boards with
interval scanning support (for example, the AT-MIO-16F-5), this clock
gates the channel clock on and off. On boards with simultaneous samp
(for example, the EISA-A2000), this clock clocks the track-and-hold 
circuitry.

scan rate The number of times (or scans) per second that LabVIEW acquires d
from channels. For example, at a scan rate of 10Hz, LabVIEW sample
each channel in a group 10 times per second.

scan width The number of channels in the channel list or number of ports in the 
list you use to configure an analog or digital input group.

SCXI Signal Conditioning eXtensions for Instrumentation. The National 
Instruments product line for conditional low-level signals within an 
external chassis near sensors, so only high-level signals in a noisy 
environment are sent to data acquisition boards. 

scxi_ai.llb A LabVIEW DAQ library containing VIs specific to analog input 
SCXI modules.

scxi_ao.llb A LabVIEW DAQ library containing VIs specific to analog output 
SCXI modules.

scxi_dig.llb A LabVIEW DAQ library containing VIs specific to digital SCXI modules

sec Seconds. 

settling time The amount of time required for a voltage to reach its final value with
specified limits. 

signal conditioning The manipulation of signals to prepare them for digitizing.

signal divider Performing frequency division on an external signal.

simple-buffered I/O Input/output operation that uses a single memory buffer big enough f
of your data. LabVIEW transfers data into or out of this buffer at the 
specified rate, beginning at the start of the buffer and stopping at the en
the buffer. You use simple buffered I/O when you acquire small amou
of data relative to memory constraints. 
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single-ended inputs Analog inputs that you measure with respect to a common ground. 

software trigger A programmed event that triggers an event such as data acquisition.

software triggering A method of triggering in which you to simulate an analog trigger usi
software. Also called conditional retrieval.

SOURCE input pin An counter input pin where the counter counts the signal transitions.

STC System Timing Controller.   

strain gauge A thin conductor, which is attached to a material, that detects stress 
vibrations in that material.

subVI VI used in the block diagram of another VI; comparable to a subroutin

switchless device Devices that do not require dip switches or jumpers to configure reso
on the devices. Also called Plug and Play devices.

syntax The set of rules to which statements must conform in a particular 
programming language. 

T

task A timed I/O operation using a particular group. See task ID.

task ID A number generated by LabVIEW, which identifies to the NI-DAQ driv
the task at hand.

The following table gives the function code definitions.

Function Code I/O Operation

1 analog input 

2 analog output

3 digital port I/O

4 digital group I/O

5 counter/timer I/O
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TC Terminal count. The highest value of a counter.

toggled output A form of counter signal generation by which the output changes the 
of the output signal from high to low, or low to high when the counter 
reaches a certain value.

top-level VI VI at the top of the VI hierarchy. This term is used to distinguish the V
from its subVIs.

track-and-hold A circuit that tracks an analog voltage and holds the value on comma

transducer excitation A type of signal conditioning that uses external voltages and curren
excite the circuitry of a signal conditioning system into measuring phys
phenomena.

trigger Any event that causes or starts some form of data capture.

U

unipolar A signal range that is either always positive or negative, but never bo
(for example 0 to 10 V, not –10 to 10 V).

update One or more analog or digital output samples. Typically, the number 
output samples in an update is equal to the number of channels in the o
group. For example, one pulse from the update clock produces one up
which sends one new sample to every analog output channel in the gr

update rate The number of output updates per second.

update width The number of channels in the channel list or number of ports in the 
list you use to configure an analog or digital output group.

V

V Volts.

VDC Volts, Direct Current. 

VI Virtual Instrument. A LabVIEW program; so-called because it models th
appearance and function of a physical instrument.

Voltage reference. Vref
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waveform Multiple voltage readings taken at a specific sampling rate. 

wire Data path between nodes.

write mark Points to the update at which a write operation begins. Analogous to 
file I/O pointer, the write mark moves every time you write data into an
output buffer. After the write is finished, the write mark points to the ne
update to be written. Because multiple buffers are possible, you need 
the buffer number and the update number to express the position of th
write mark. 
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8253/54 counter

accuracy, 24-22
continuous pulse train generation, 

24-12 to 24-13
description, 23-4
determining pulse width, 25-5 to 25-6
dividing frequencies, 28-3
elapsed time counting, 27-11
events counting, 27-6 to 27-7
finite pulse train generation, 24-17 to 24-20
frequency and period measurement

high frequency signals, 26-7 to 26-8
how and when to measure, 26-2
low frequency signals, 26-10

internal timebases with corresponding 
maximum pulse width measurements 
(table), 25-9

single square pulse generation, 24-6 to 24-9
square pulse generation, 24-3 to 24-4
stopping counter generations, 24-23

A
ACK (Acknowledge Input) line, 17-2
ACK (Acknowledge) line, 17-2
Acquire & Process N Scans VI, 7-10
Acquire & Proc N Scans-Trig example VI, 

8-5, 8-8
Acquire 1 Point from 1 Channel VI, 6-2
Acquire and Average VI, 21-7
Acquire N-Multi-Analog Hardware Trig 

example VI, 8-8
Acquire N-Multi-Digital Trig example VI, 8-5
Acquire N-Multi-Start example VI, 7-7

Acquire N Scans Analog Hardware Trig exampl
VI, 8-7 to 8-8

Acquire N Scans Analog Software Trig exampl
VI, 8-11

Acquire N Scans Digital Trig example VI, 
8-4 to 8-5

Acquire N Scans example VI, 7-4, 7-6
Acquire N Scans-ExtChanClk example VI, 

9-4, 9-6
acquisition rate. See external control.
ADC

limit settings effects (figure), 5-6
measurement precision for various device 

ranges and limit settings (table), 5-8
range effects (figure), 5-5
resolution, 5-4

effects on precision (figure), 5-4
adjacent counters for counter chips (table), 27
Adjacent Counters VI, 26-6
Advanced VIs. See also VIs.

analog output SCXI example, 
21-16 to 21-17

buffered pulse and period 
measurement, 25-8

external control of channel clock, 9-4
finite pulse train generation, 24-16
non-buffered handshaking, 17-5
overview, 3-5
simple-buffered handshaking, 17-7 to 17-9

AI Acquire Waveform VI, 7-2 to 7-3
AI Acquire Waveforms VI

multiple-waveform acquisition, 7-3
simple-buffered analog input with graphing

7-5 to 7-6
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AI Clear VI
hardware-timed analog I/O control 

loops, 6-9
multiple-waveform acquisition, 7-4
SCXI temperature measurement, 21-8
simple-buffered analog input with 

multiple starts, 7-7
simultaneous buffered waveform 

acquisition and generation, 
14-2 to 14-3

AI Clock Config VI
external control of channel clock, 9-4
external conversion pulses, 9-4
retrieving channel clock setting, 20-5
scan clock control, 9-6, 9-7

AI Config VI
basic non-buffered application, 6-4
hardware-timed analog I/O control 

loops, 6-8
interchannel delay, 9-2
multiple-channel single-point analog 

input, 6-5
multiple-waveform acquisition, 7-4
one-point calibration, 22-5
simple-buffered analog input with 

multiple starts, 7-7
simultaneous buffered waveform 

acquisition and generation, 14-2
AI Control VI, 9-6
AI Hardware Config VI, 20-4
AI Read One Scan VI, 6-7
AI Read VI

advantages and disadvantages of reading 
backlog, A-1

asynchronous continuous acquisition 
using DAQ Occurrences, 7-11 to 7-12

conditional retrieval cluster, 8-10
conditional retrieval example, 8-11
controlling startup times (note), 7-7
forcing time limit for, 9-5, 9-7
multiple-waveform acquisition, 7-4

one-point calibration, 22-6
SCXI temperature measurement, 21-8
simple-buffered analog input with 

multiple starts, 7-7
simultaneous buffered waveform 

acquisition and generation, 
14-2 to 14-3

software triggering, 8-10
AI Sample Channel VI, 6-1 to 6-2
AI Sample Channels VI, 6-3
AI Single Scan VI

basic non-buffered application, 6-4
hardware-timed analog I/O control loops

6-8 to 6-9
improving control loop performance, 

6-9 to 6-10
multiple-channel single-point analog 

input, 6-4
one-point calibration, 22-6
software-timed analog I/O control 

loops, 6-6
AI Start VI

hardware-timed analog I/O control loops
6-8 to 6-9

multiple-waveform acquisition, 7-4
one-point calibration, 22-6
scan clock control, 9-6
SCXI temperature measurement, 21-8
simple-buffered analog input with 

multiple starts, 7-7
simultaneous buffered waveform 

acquisition and generation, 
14-2 to 14-3

Am9513 counter
continuous pulse train generation, 

24-10 to 24-11
controlling pulse width measurement, 

25-6 to 25-7
counting operations with no counters 

available, 24-20 to 24-21
description, 23-4
determining pulse width, 25-4 to 25-5
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dividing frequencies, 28-2 to 28-3
events or elapsed time counting

connecting counters, 27-2 to 27-3
elapsed time, 27-9 to 27-10
events, 27-4 to 27-6

finite pulse train generation, 
24-14 to 24-15

frequency and period measurement
connecting counters, 26-3
high frequency signals, 26-5 to 26-26
how and when to measure, 26-2
low frequency signals, 26-9 to 26-10

internal timebases with corresponding 
maximum pulse width measurements 
(table), 25-9

single square pulse generation, 
24-4 to 24-6

square pulse generation, 24-2 to 24-3
stopping counter generations, 24-23

amplification
increasing signal-to-noise ratio 

(figure), 18-4
methods for minimizing noise 

(note), 18-4
amplifier offset, reading, 21-5
AMUX-64T devices

addressing with MIO boards, A-1
analog input channel range (table), 5-13
channel addressing, 5-13 to 5-17
scanning order for DAQ devices, 

5-14 to 5-17
four AMUX-64Ts (table), 5-16
one or two AMUX-64Ts (table), 5-15

specifying number for AMUX-64T 
device (table), 5-17

analog input. See also buffered waveform 
acquisition.

AMUX-64T external multiplexer device, 
5-12 to 5-17

analog input/output control loops, 
6-6 to 6-10

channel clock control, 9-3 to 9-5, 9-8
circular-buffered analog input examples,

7-12 to 7-14
continuous acquisition from multiple 

channels, 7-10 to 7-11
defining signals, 5-1 to 5-2
digital triggering, 8-2 to 8-5
external control of acquisition rate, 

9-1 to 9-3
hardware triggering, 8-1 to 8-8
measurement systems, 5-4 to 5-6
multiple-channel single point analog 

input, 6-3 to 6-5
multiple waveform acquisition, 7-3 to 7-5
scan clock control, 9-6 to 9-7, 9-8
SCXI applications for measuring 

temperature (example), 21-2 to 21-13
selecting input settings, 5-7 to 5-12

calculating code width, 5-7
considerations for selecting, 

5-7 to 5-8
differential measurement system, 

5-9 to 5-10
measurement precision for various 

device ranges and limit settings 
(table), 5-8

nonreferenced single-ended 
measurement system, 5-11 to 5-1

referenced single-ended 
measurement system, 5-11

signals, 4-3, 5-1 to 5-6
single-buffered analog input examples, 

7-5 to 7-8
single-channel single point analog input,

6-1 to 6-2
single waveform acquisition, 7-2 to 7-3
software triggering, 8-8 to 8-11
terminology, 5-17
triggering, 8-5 to 8-8
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analog input/output control loops, 6-6 to 6-10
hardware-timed control loops, 6-7 to 6-9
improving performance, 6-9 to 6-10
overview, 6-6
software-timed control loops, 6-6 to 6-7

Analog Input palette, 6-1
analog input SCXI modules

applications for measuring temperature 
(example), 21-2 to 21-13

multiplexed mode, 19-4 to 19-5
parallel mode, 19-5 to 19-6

analog input signals
choosing a measurement system, 

5-4 to 5-6
choosing between analog and digital 

signals, 4-3
defining signals, 5-1 to 5-2
device voltage range, 5-5
floating signal sources, 5-3
grounded signal sources, 5-2
referenced and non-referenced, 5-2
resolution of ADC, 5-4
signal voltage range (limit settings), 5-6
types of analog signals (figure), 5-1

Analog IO Control Loop (HW timed) VI, 6-8
Analog IO Control Loop VI, 6-6 to 6-7
analog multiplexers (AMUX), 5-9. See also 

AMUX-64T devices.
analog output

buffered
overview, 10-1 to 10-2
stored in 2D arrays, 3-16
waveform generation, 12-1 to 12-3

circular-buffered, 12-4 to 12-5
eliminating errors, 12-6

multiple-immediate updates, 11-3
SCXI analog output application example, 

21-16 to 21-17

single-immediate updates, 11-1 to 11-2
single-point output

choosing between single-point or 
multiple-point generation, 4-4

overview, 10-1
analog output SCXI modules

application example, 21-16 to 21-17
multiplexed mode, 19-5

analog-to-digital converter (ADC). See ADC.
analog triggering

description, 8-5 to 8-6
diagram, 8-6
examples, 8-7 to 8-8
timeline for post-triggered data 

acquisition (figure), 8-6
anlogin DAQ example file, 3-2
anlog_io.llb DAQ example file, 3-2
anlogout.llb DAQ example file, 3-2
AO Clear VI

circular-buffered output, 12-5
simultaneous buffered waveform 

acquisition and generation, 
14-2 to 14-3

waveform generation, 12-3
AO Config VI

analog output SCXI example, 21-16
circular-buffered output, 12-5
simultaneous buffered waveform 

acquisition and generation, 14-2
waveform generation, 12-3

AO Continuous Gen VI, 12-4
AO Generate Waveforms VI, 12-1 to 12-2
AO Group Config VI, 21-16
AO Hardware Config VI, 21-16
AO Single Update VI

analog output SCXI example, 21-16
calibrating SCXI modules for signal 

generation, 22-8
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, 
AO Start VI
circular-buffered output, 12-5
external control of update clock, 13-2
simultaneous buffered waveform 

acquisition and generation, 
14-2 to 14-3

waveform generation, 12-3
AO Trigger and Gate Config VI, 14-4
AO Update Channel VI, 11-2
AO Update Channels VI, 11-1
AO Wait VI, 12-3
AO Waveform Gen VI, 12-2
AO Write One Update VI, 6-7

multiple-immediate updates, 11-3
single-immediate updates, 11-2

AO Write VI
circular-buffered output, 12-5
simultaneous buffered waveform 

acquisition and generation, 
14-2 to 14-3

waveform generation, 12-3
Array & Cluster option, 3-15
arrays

transposing, 3-15, 3-16, 7-6
two-dimensional (2D) arrays, 

3-14 to 3-16

B
bipolar range, 3-14, 5-7
breakpoints, setting, 29-4
buffered handshaking, 17-6 to 17-10

circular-buffered examples, 17-9 to 17-10
simple-buffered examples, 17-7 to 17-9

buffered pulse and period measurement, 
25-7 to 25-8

buffered waveform acquisition, 7-1 to 7-14
circular-buffered analog input, 

7-12 to 7-14
asynchronous continuous acquisition

using DAQ occurrences, 
7-11 to 7-12

continuous acquisition from multiple 
channels, 7-10 to 7-11

determining adequate buffer 
capacity, A-2

examples, 7-12 to 7-14
overview, 7-8 to 7-10

how buffers work, 7-2
simple-buffered analog input

data buffer overview, 7-1 to 7-2
displaying waveforms on graphs 

(example), 7-5 to 7-6
multiple-waveform acquisition, 

7-3 to 7-5
sampling with multiple starts 

(example), 7-7 to 7-8
single-waveform acquisition, 

7-2 to 7-3
waiting to analyze data, 7-1 to 7-2

buffered waveform acquisition and generation
simultaneous, 14-1 to 14-7

E-series MIO boards, 14-1 to 14-4
hardware triggered, 14-3 to 14-4
software triggered, 14-2 to 14-3

Lab/1200 boards, 14-7
legacy MIO boards, 14-4 to 14-6

hardware triggered, 14-6
software triggered, 14-4 to 14-5
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buffered waveform generation
buffered analog output, 12-1 to 12-3
choosing between single-point or 

multiple-point generation, 4-4
circular-buffered output, 12-4 to 12-5

eliminating errors, 12-6
overview, 10-1 to 10-2
stored in 2D arrays, 3-16

bulletin board support, B-1

C
calibration. See SCXI calibration.
cascading counters

defined, 27-2
external connections (figure), 27-2, 27-3

channel addressing
AMUX-64T devices, 5-13 to 5-17

analog input channel range 
(table), 5-13

scanning order, 5-14 to 5-17
SCXI modules, 20-1 to 20-2
VI channel, port, and counter addressing, 

3-9 to 3-12
channel clock, 9-3 to 9-5

channel and scan intervals using channel 
clock (figure), 9-1

considerations for specific boards 
(notes), 9-5

controlling externally, 9-3 to 9-5
rate parameter, 5-17
setting channel clock rate, 9-3
simultaneous control of scan and channel 

clocks, 9-8
TTL signal (example), 9-3

channel configuration, in NI-DAQ 5.x or 6.0, 
2-13 to 2-14

Channel to Index VI (note), 8-10

circular-buffered analog input
asynchronous continuous acquisition 

using DAQ occurrences, 7-11 to 7-12
continuous acquisition from multiple 

channels, 7-10 to 7-11
examples

basic circular-buffered analog 
input, 7-13

Cont Acq to File (binary).vi, 7-14
Cont Acq to File (scaled).vi, 7-14
Cont Acq to Spreadsheet File.vi, 7-1
Cont Acq&Chart (buffered).vi, 7-14
Cont Acq&Graph (buffered).vi, 7-14

how circular buffers work (figure), 7-9
overview, 7-8 to 7-10

circular-buffered analog output
changing waveform during generation, 

12-4 to 12-5
eliminating errors, 12-6

circular-buffered digital I/O examples, 
17-9 to 17-10

clocks. See channel clock; scan clock; 
update clock.

code width, calculating, 5-7
cold junction compensation, 21-3 to 21-4
column major order, 3-15 to 3-16
common-mode voltage

defined, 5-10
illustration, 5-10

common questions about LabVIEW data 
acquisition, A-1 to A-4

conditional retrieval, 8-8. See also 
software triggering.

configuration. See installation 
and configuration.

Cont Acq to File (binary).vi, 7-14
Cont Acq to File (scaled).vi, 7-14, 12-7
Cont Acq to Spreadsheet File.vi, 7-14
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Cont Acq&Chart (Async Occurrence) VI, 
7-11 to 7-12

Cont Acq&Chart (buffered).vi, 7-14
Cont Acq&Graph (buffered).vi, 7-14
Cont Acquire&Chart (immediate) VI, 

6-4 to 6-5
Cont Pulse Train (8253) VI, 24-12, 28-3
Cont Pulse Train-Easy (9513) VI, 24-10
Cont Pulse Train-Easy (DAQ-STC) VI, 24-10
Cont Pulse Train-Int (9513) VI, 24-11
Cont Pulse Train-Int (DAQ-STC) VI, 

24-10 to 24-11
continuous acquisition from multiple 

channels, 7-10 to 7-11
Continuous Generation example VI, 

12-4, 12-6
Continuous Pulse Generator Config VI

finite pulse train generation, 24-15
single square pulse generation, 24-11

continuous pulse train generation, 
24-9 to 24-13

8253/54, 24-12 to 24-13
DAQ-STC and Am9513, 24-10 to 24-11

Continuous Transducer VI, 21-6
control loops. See analog input/output 

control loops.
Convert RTD Reading VI, 21-12
Convert Strain Gauge Reading VI, 

21-14 to 21-15
Convert Thermocouple Reading VI, 21-8
Count Events (8253) VI, 27-6 to 27-7
Count Events-Easy (9513) VI, 27-4 to 27-5
Count Events-Easy (DAQ-STC) VI, 27-3
Count Events-Int (9513) VI, 27-5 to 27-6
Count Events-Int (DAQ-STC) VI, 27-4
Count Events or Time Easy VI

events, 27-3
time

Am9513, 27-9
DAQ-STC, 27-7 to 27-8

Count Time (8253) VI, 27-11
Count Time-Easy (9513) VI, 27-9
Count Time-Easy (DAQ-STC) VI, 

27-7 to 27-8
Count Time-Int (9513) VI, 27-10
Count Time-Int (DAQ-STC) VI, 27-8
counter addressing for VIs, 3-9 to 3-12
counter chips used in National Instruments 

devices, 23-3 to 23-5. See also 8253/54 
counter; AM9513 counter; 
DAQ-STC counter.

Counter Read VI
controlling pulse width 

measurement, 25-6
counting events

Am9513, 27-6
DAQ-STC, 27-4

counting time
Am9513, 27-10
DAQ-STC, 27-8

measuring frequency and period
high frequency signals, 26-6
low frequency signals, 26-10

Counter Start VI
continuous pulse train generation, 24-11
controlling pulse width 

measurement, 25-6
counting events

Am9513, 27-6
DAQ-STC, 27-4

counting time
Am9513, 27-10
DAQ-STC, 27-8

dividing frequencies, 28-2
finite pulse train generation, 24-15
measuring frequency and period

high frequency signals, 26-6
low frequency signals, 26-10

single square pulse generation, 24-5
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Counter Stop VI
controlling pulse width 

measurement, 25-6
counting events

Am9513, 27-6
DAQ-STC, 27-4

counting time
Am9513, 27-10
DAQ-STC, 27-8

dividing frequencies, 28-2
finite pulse train generation, 24-14
measuring frequency and period

high frequency signals, 26-6
low frequency signals, 26-10

stopping counter generations, 24-23
counter.llb DAQ example file, 3-2
counters

accuracy of counters, 24-22
basic functions, 23-1 to 23-5
capabilities, 23-1
choosing between counting methods, 4-5
counting events or elapsed time, 

27-1 to 27-11
connecting counters, 27-1 to 27-3
elapsed time, 27-7 to 27-11
events, 27-3 to 27-7

counting operations with no counters 
available, 24-20 to 24-21

digital vs. counter interfacing, 4-3
dividing frequencies, 28-1 to 28-3
frequency and period measurement, 

26-1 to 26-10
connecting counters for 

measuring, 26-3
high frequency signals, 26-4 to 26-8
how and when to measure, 

26-1 to 26-2
low frequency signals, 26-8 to 26-10

gating modes (figure), 23-3

pulse train generation, 24-9 to 24-20
continuous pulse train, 24-9 to 24-13
finite pulse train, 24-13 to 24-20

pulse width measurement, 25-1 to 25-9
controlling pulse width 

measurement, 25-6 to 25-7
determining pulse width, 

25-2 to 25-6
increasing measurable width range,

25-8 to 25-9
square pulse generation, 24-1 to 24-4

single square pulse generation, 
24-4 to 24-9

stopping counter generations, 24-23
timebase uncertainty, 24-22

CTR Buffer Config VI, 25-8
CTR Buffer Read VI, 25-8
CTR Control VI

buffered pulse and period 
measurement, 25-8

enabling and disabling FOUT signal, 
24-20 to 24-21

measuring frequency and period, 26-6
CTR Group Config VI, 25-8
CTR Mode Config VI

buffered pulse and period 
measurement, 25-8

finite pulse train generation, 24-16
current setting for VIs, 3-7
current value conventions for VIs, 3-7
customer communication, xvii, B-1 to B-2

D
daisy chaining SCXI chassis, 21-20 to 21-21
DAQ Channel Wizard

limit settings, 3-12
SCXI programming considerations 

(note), 20-1
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DAQ examples
list of example files, 3-2
locations, 3-1 to 3-2

DAQ hardware. See hardware; installation 
and configuration.

DAQ Occurrence Config VI, 7-11 to 7-12
DAQ Solution Wizard, 3-1
DAQ-STC counter

continuous pulse train generation, 
24-10 to 24-11

controlling pulse width measurement, 
25-6 to 25-7

counting operations with no counters 
available, 24-20 to 24-21

description, 23-4
determining pulse width, 25-2 to 25-3
dividing frequencies, 28-2 to 28-3
events or elapsed time counting

events, 27-3 to 27-4
time, 27-7 to 27-28

finite pulse train generation
using Advanced VIs, 24-16 to 24-17
using Easy and Intermediate VIs, 

24-14 to 24-15
frequency and period measurement

connecting counters, 26-3
high frequency signals, 26-4, 26-6
how and when to measure, 26-2
low frequency signals, 

26-8 to 26-9, 26-10
internal timebases with corresponding 

maximum pulse width measurements 
(table), 25-9

single square pulse generation, 
24-4 to 24-6

square pulse generation, 24-2 to 24-3
stopping counter generations, 24-23

DAQ VIs. See VIs.

data acquisition. See also analog input; VIs.
analog input/output control loops, 

6-6 to 6-10
basic LabVIEW data acquisition 

concepts, 3-1 to 3-16
data organization for analog 

applications, 3-14 to 3-16
limit settings, 3-12 to 3-14
location of common DAQ examples,

3-1 to 3-2
buffered. See buffered 

waveform acquisition.
common questions about LabVIEW data

acquisition, A-1 to A-4
important terms, 5-17
multiple-channel single-point, 6-3 to 6-5
single-channel single-point, 6-1 to 6-2
triggered. See triggered data acquisition.

data acquisition hardware. See hardware.
Data Acquisition palette, 3-4
data organization for analog applications, 

3-14 to 3-16
column major order, 3-15 to 3-16
row major order, 3-14 to 3-15
two-dimensional (2D) arrays, 

3-14 to 3-16
data types for LabVIEW, xvi
debugging VIs, 29-1 to 29-4

error handling, 29-2 to 29-3
execution highlighting, 29-4
hardware connection errors, 29-1
setting breakpoints and showing advance

DAQ VIs, 29-4
single-stepping through VIs, 29-3
software configuration errors, 29-2
using Probe tool, 29-4
VI construction errors, 29-2 to 29-4

default input for VIs, 3-7
default setting for VIs, 3-7
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Delayed Pulse (8253) VI, 24-6 to 24-9
Delayed Pulse-Easy (9513) VI, 24-5
Delayed Pulse-Easy (DAQ-STC) VI, 24-5
Delayed Pulse Generator Config VI

finite pulse train generation, 24-15
measuring frequency and period, 26-6
single square pulse generation, 24-5

Delayed Pulse-Int (9513) VI, 24-5
Delayed Pulse-Int (DAQ-STC) VI, 24-5, 24-6
delays for improving control loop 

performance, 6-9 to 6-10
device voltage range, 5-5

considerations for selecting analog input 
settings, 5-7 to 5-8

description, 5-5
effect on ADC precision (figure), 5-5
measurement precision for various ranges 

and limit settings (table), 5-8
differential measurement system, 5-9 to 5-10

channel differential system (figure), 5-9
common mode voltage (figure), 5-10
when to use, 5-10

digital and relay SCXI modules, 19-5
Digital Buffered Handshaking VI, 17-7
Digital Clock Config VI, 17-8
digital DAQ example file, 3-2
digital I/O

buffered handshaking, 17-6 to 17-10
circular-buffered examples, 

17-9 to 17-10
simple-buffered examples, 

17-7 to 17-9
choosing between non-latched or latched 

digital I/O, 4-5
digital vs. counter interfacing, 4-3
handshaking (latched) digital I/O, 

17-1 to 17-2
immediate (non-latched) digital I/O, 

16-1 to 16-3

non-buffered handshaking, 17-5 to 17-6
overview, 15-1 to 15-2
SCXI application examples

digital input, 21-17 to 21-18
digital output, 21-19 to 21-20

sending out multiple digital values, 
17-3 to 17-5

Digital Mode Config VI, 17-8
digital ports and lines, 15-1
digital SCXI application examples

digital input, 21-17 to 21-18
digital output, 21-19 to 21-20

digital SCXI modules
multiplexed mode for digital and relay 

modules, 19-5
parallel mode, 19-6

digital triggering
defined, 8-2
description, 8-2 to 8-3
diagram of signal connections, 8-2
examples, 8-4 to 8-5
timeline for post-triggered data 

acquisition (figure), 8-3
DIO Buffer Control VI, 17-8 to 17-9
DIO Clear VI, 17-7
DIO Config VI, 17-8 to 17-9
DIO Group Config VI, 17-5
DIO Port Config VI

digital input application example 
(note), 21-18

immediate digital I/O, 16-3
DIO Single Read/Write VI, 17-5 to 17-6
DIO Start VI, 17-8
DIO Wait VI, 17-7
Disable Indexing option, 3-15
Display and Output Acq'd File (scaled) VI, 

12-6 to 12-7
dividing frequencies, 28-1 to 28-3
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documentation
conventions used in manual, xiv-xvi
flowchart for finding information, 4-2
how to use this book, 1-1 to 1-3
organization of manual, xiii-xiv
related documentation, xvii

down counter, 28-1, 28-2
Down Counter or Divide VI, 28-2

E
e-mail support, B-2
E-series MIO boards, for simultaneous 

buffered waveform acquisition and 
generation, 14-1 to 14-4

hardware triggered, 14-3 to 14-4
software triggered, 14-2 to 14-3

Easy Counter VI
continuous pulse train generation, 24-10
finite pulse train generation, 24-14
single square pulse generation, 24-5

Easy VIs. See also VIs.
addressing OUT and IN pins on DIO-32F 

board, A-2
continuous pulse train generation, 24-10
counting elapsed time

Am9513, 27-9
DAQ-STC, 27-7 to 27-8

counting events, 27-3 to 27-24
digital input application, 21-17 to 21-18
digital output application, 21-19 to 21-20
finite pulse train generation, 24-14
grouping two or more ports, A-2
immediate digital I/O, 16-2
limitations, 6-3
measuring frequency and period

high frequency signals, 26-4 to 26-5
low frequency signals, 26-8 to 26-9

multiple-channel single-point analog 
input, 6-3

multiple-immediate updates, 11-3
multiple-waveform acquisition, 7-3
overview, 3-4 to 3-5
single-channel single-point analog 

input, 6-1
single-immediate updates, 11-1 to 11-2
single square pulse generation, 24-5
single-waveform acquisition, 7-2 to 7-3
strain gauge application, 21-14
waveform generation, 12-1 to 12-2

edges of signals, 23-2
EEPROM, for storing calibration constants, 

22-1 to 22-3
default load area, 22-2
factory area, 22-2
user area, 22-2

elapsed time counting. See events or elapsed 
time counting.

electronic support services, B-1 to B-2
Error Handler VIs, 29-2
error handling

debugging VIs, 29-2 to 29-3
error in and error out output clusters, 

3-8 to 3-9
Event or Time Counter Config VI

counting events
Am9513, 27-6
DAQ-STC, 27-4

counting time
Am9513, 27-10
DAQ-STC, 27-8

measuring frequency and period, 26-6
events or elapsed time counting, 27-1 to 27-1

adjacent counters for counter chips 
(table), 27-2

connecting counters, 27-1 to 27-3
Am9513, 27-2 to 27-3
cascading counters (figure), 27-2
external connections (figures), 27-1
© National Instruments Corporation I-11 LabVIEW Data Acquisition Basics Manual



Index
elapsed time, 27-7 to 27-11
8253/54, 27-11
Am9513, 27-9 to 27-10
DAQ-STC, 27-7 to 27-28

events, 27-3 to 27-7
8253/54, 27-6 to 27-7
Am9513, 27-4 to 27-6
DAQ-STC, 27-3 to 27-4

execution highlighting, 29-4
external control

acquisition rate, 9-1 to 9-8
channel and scan intervals using 

channel clock (figure), 9-1
channel clock control, 9-3 to 9-5
choosing between triggering and 

external clock control, 4-4
description, 9-1 to 9-3
round-robin scanning (figure), 9-2
scan clock control, 9-6 to 9-7
simultaneous control of scan and 

channel clocks, 9-8
update clock, 13-1 to 13-3

Generate N Updates-ExtUpdateClk 
VI, 13-1 to 13-2

input pins (table), 13-2
supplying test clock from DAQ 

device, 13-3
external conversion pulses, 9-4 to 9-5
EXTUPDATE* signal (table), 13-2

F
fax and telephone support, B-2
Fax-on-Demand support, B-2
filtering, 18-4
Finite Pulse Train (8253) VI, 24-17 to 24-20
Finite Pulse Train-Adv (DAQ-STC) VI, 

24-16, 24-17

Finite Pulse Train-Easy (9513) VI, 24-14
Finite Pulse Train-Easy (DAQ-STC) VI, 24-14
finite pulse train generation, 24-13 to 24-20

8253/54, 24-17 to 24-20
DAQ-STC, 24-16 to 24-17
DAQ-STC and Am9513, 24-14 to 24-15
physical connections (figure), 24-14

Finite Pulse Train-Int (9513) VI, 24-15
Finite Pulse Train-Int (DAQ-STC) VI, 24-15
floating signal sources, 5-3
FOUT pin, 13-3, 24-20
FREQ_OUT pin, 13-3, 24-20
frequency and period measurement, 

26-1 to 26-10
connecting counters for measuring, 26-3
equation for obtaining 

measurements, 26-2
high frequency signals, 26-4 to 26-8
how and when to measure, 26-1 to 26-2
low frequency signals, 26-8 to 26-10
square wave frequency measurement 

(figure), 26-1
square wave period measurement 

(figure), 26-2
frequency division, 28-1 to 28-3

8253/54, 28-3
DAQ-STC and Am9513, 28-2 to 28-3
wiring (figure), 28-1

FTP support, B-1
Function Generator VI, 12-5, 12-6
Functions palette

Array & Cluster, 3-15
DAQ, 6-1
illustration, 3-3
locating VIs, 3-3
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G
gain, defined, 3-14
gains (SCXI)

default gain, 20-3
description, 20-3 to 20-5
SCXI-1100 channel arrays, input limits 

array, and gains (table), 20-4
GATE input, for counters, 23-2
General Error Handler VI

debugging VIs, 29-2 to 29-3
pulse width measurement, 25-6

Generate Continuous Sinewave VI, 12-3, 12-6
Generate Delayed Pulse VI

single square pulse generation, 24-5
stopping counter generations, 24-23

Generate N Updates example VI, 12-2, 12-6
Generate N Updates-ExtUpdateClk VI, 

13-1 to 13-2
Generate Pulse Train on FOUT VI, 

13-3, 24-21
Generate Pulse Train on FREQ_OUT VI, 

13-3, 24-21
Generate Pulse Train VI

continuous pulse train generation
8253/54, 24-12 to 24-13
DAQ-STC and Am9513, 24-10

finite pulse train generation, DAQ-STC 
and Am9513, 24-14

stopping counter generations, 24-23
supplying external test clock, 13-3

Get DAQ Device Information VI, 2-1
Get Timebase (8253) VI, 25-6
Getting Started Analog Input example VI

channel clock control (figure), 9-4
reading amplifier offset, 21-5
scan clock control (figure), 9-7
temperature sensor, 21-4

graphing simple-buffered analog input 
(example), 7-5 to 7-6

grounded signal sources, 5-2

H
handshaking (latched) digital I/O, 

17-1 to 17-10
buffered handshaking, 17-6 to 17-10

circular-buffered examples, 
17-9 to 17-10

simple-buffered examples, 
17-7 to 17-9

connecting signal lines
digital input (figure), 17-3
digital output (figure), 17-4

DAQ devices supporting digital 
handshaking, 17-1

defined, 15-2
grouping ports for DIO-32 devices 

(notes), 17-4
non-buffered handshaking, 17-5 to 17-6
overview, 17-1 to 17-2
sending out multiple digital values, 

17-3 to 17-5
hardware. See also installation and 

configuration.
debugging connection errors, 29-1
LabVIEW data acquisition 

hardware support
Macintosh systems (table), 2-5
Windows environment (table), 

2-4 to 2-5
relationship between LabVIEW, NI-DAQ, 

and DAQ hardware (figure), 2-3
hardware-timed analog input/output control 

loops, 6-7 to 6-9
hardware triggering, 8-1 to 8-8

analog
description, 8-5 to 8-6
examples, 8-7 to 8-8

digital
description, 8-2 to 8-3
examples, 8-4 to 8-5

overview, 8-1
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I
IBF (Input Buffer Full) line, 17-2
ICTR Control-Int VI

counting events, 27-6
counting time, 27-11

immediate digital I/O. See nonlatched 
digital I/O.

immediate updates
multiple, 11-3
single, 11-1 to 11-2

Index Array function, 3-15
initialization of data acquisition boards, A-3
Input Buffer Full (IBF) line, 17-2
input range, and input setting selection, 

5-7 to 5-8
installation and configuration

channel configuration in NI-DAQ 5.x or 
6.0, 2-13 to 2-14

DAQ devices
installing and configuring 

(figure), 2-2
using NI-DAQ 4.8.x on Macintosh, 

2-6 to 2-8
using NI-DAQ 5.x or 6.0, 2-6

debugging software configuration 
errors, 29-2

LabVIEW data acquisition 
hardware support

Macintosh systems (table), 2-5
Windows environment (table), 

2-4 to 2-5
relationship between LabVIEW, NI-DAQ, 

and DAQ hardware (figure), 2-3
SCXI chassis

hardware configuration, 2-9 to 2-10
software configuration

NI-DAQ 4.8.x on Macintosh 
systems, 2-10 to 2-13

NI-DAQ 5.x or 6.0, 2-10
Intermediate VIs. See also VIs.

advantages, 6-4 to 6-5

asynchronous continuous acquisition 
using DAQ occurrences, 7-11 to 7-12

circular-buffered output, 12-5
continuous acquisition from multiple 

channels, 7-10 to 7-11
continuous pulse train generation, 

24-10 to 24-11
controlling pulse width measurement, 

25-6 to 25-7
counting elapsed time

8253/54, 27-11
Am9513, 27-10
DAQ-STC, 27-8

counting events
8253/54, 27-6 to 27-7
Am9513, 27-5 to 27-6
DAQ-STC, 27-4

dividing frequencies, 28-2 to 28-3
finite pulse train generation, 24-15
measuring frequency and period

high frequency signals, 26-6
low frequency signals, 26-10

multiple-channel single-point analog 
input, 6-3 to 6-4

multiple-waveform acquisition, 7-4 to 7-5
non-buffered handshaking, 17-5 to 17-6
overview, 3-5
SCXI temperature measurement 

examples, 21-6, 21-8
simple-buffered handshaking, 17-7
simultaneous buffered waveform 

acquisition and generation, 
14-2 to 14-3

single-immediate updates, 11-2
single square pulse generation, 24-5
stopping counter generations, 24-23
strain gauge application, 21-14
waveform generation, 12-3

interval scanning, 5-17
isolation of transducer signals, 18-4
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L
Lab/1200 boards, simultaneous buffered 

waveform acquisition and generation, 14-7
LabVIEW software

basic LabVIEW data acquisition 
concepts, 3-1 to 3-16. See also VIs.

data organization for analog 
applications, 3-14 to 3-16

location of common DAQ examples, 
3-1 to 3-2

common questions about LabVIEW, 
A-1 to A-4

data acquisition hardware support
Macintosh systems (table), 2-5
Windows environment (table), 

2-4 to 2-5
data types, xvi
relationship between LabVIEW, NI-DAQ, 

and DAQ hardware (figure), 2-3
latched digital I/O. See handshaking (latched) 

digital I/O.
legacy MIO boards, simultaneous buffered 

waveform acquisition and generation, 
14-4 to 14-6

hardware triggered, 14-6
software triggered, 14-4 to 14-5

limit settings
considerations for selecting analog input 

settings, 5-7 to 5-8
description, 5-6
effect on ADC precision (figure), 5-6
measurement precision for various device 

ranges and limit settings (table), 5-8
SCXI gains, 20-3 to 20-5
VI limit settings, 3-12 to 3-14

linearizing voltage levels, 18-5

M
Macintosh systems

configuring DAQ devices, 2-6 to 2-8
LabVIEW data acquisition hardware 

support (table), 2-5
NI-DAQ driver files, 2-3
SCXI chassis

hardware configuration, 2-9 to 2-10
software configuration, 2-10 to 2-13

manual. See documentation.
maximum sampling rate per channel, 7-5
Meas Buffered Pulse-Period (DAQ-STC) VI, 

25-7 to 25-8
Measure Frequency - Dig Start > 1kHz (8253

VI, 26-8
Measure Frequency < 1kHz (8253) VI, 

26-8, 26-10
Measure Frequency > 1kHz (8253) VI, 26-7
Measure Frequency-Easy (9513) VI, 26-5
Measure Frequency-Easy (DAQ-STC) 

VI, 26-4
Measure Frequency VI, 26-4, 26-5
Measure Period-Easy (9513) VI, 26-9
Measure Period-Easy (DAQ-STC) VI, 26-8
Measure Pulse-Easy (9513) VI, 25-4
Measure Pulse-Easy (DAQ-STC) VI, 25-2
Measure Pulse Width or Period VI

determining pulse width
Am9513, 25-4
DAQ-STC, 25-2 to 25-3

measuring low frequency signals, 26-9
Measure Short Pulse Width (8253) VI, 25-5
measurement system

choosing, 5-4 to 5-6
differential measurement system, 

5-9 to 5-10
nonreferenced single-ended measureme

system, 5-11 to 5-12
referenced single-ended measurement 

system, 5-11
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Microsoft Windows. See Windows 
environment.

MIO boards. See E-series MIO boards; legacy 
MIO boards.

multiple-channel single-point analog input, 
6-3 to 6-5

multiple-immediate updates, 11-3
multiple-waveform acquisition

choosing between single-point and 
multi-point acquisition, 4-4

procedure for acquiring, 7-3 to 7-5
multiplexed mode (SCXI)

analog input modules, 19-4 to 19-5
analog output modules, 19-5
channel addressing, 20-1 to 20-2
digital and relay modules, 19-5
SCXI-1200 (Windows), 19-4 to 19-5

My Single Scan Processing VI, 6-5

N
NI-DAQ software

driver files
deciding which driver version to 

use, A-4
Macintosh versions, 2-3
versions of NI-DAQ drivers 

(note), 2-1
Windows versions, 2-3

installing
NI-DAQ 4.8.x on Macintosh, 

2-6 to 2-8
NI-DAQ 5.x or 6.0, 2-6

relationship between LabVIEW, NI-DAQ, 
and DAQ hardware (figure), 2-3

NIDAQ32.DLL file, 2-3
NIDAQ.DLL file, 2-3
non-buffered handshaking, 17-5 to 17-6
non-referenced signal sources, 5-2

nonlatched digital I/O, 16-1 to 16-3
channel names, 16-2 to 16-3
defined, 15-2
resetting digital lines to default 

values, 16-3
using Easy Digital VIs, 16-2

nonreferenced single-ended (NRSE) 
measurement system, 5-11 to 5-12

18-channel NRSE system (figure), 5-12
when to use, 5-12

Nyquist frequency, 5-2
Nyquist Theorem, 5-2

O
OBF (Output Buffer Full) line, 17-2
one-point calibration, 22-4 to 22-6
OUT output pin, 23-2
OUT2 signal (table), 13-2
Output Buffer Full (OBF) line, 17-2

P
parallel mode (SCXI)

analog input modules, 19-5 to 19-6
channel addressing, 20-1 to 20-2
digital modules (Macintosh and 

Windows), 19-6
SCXI-1200 (Windows), 19-6

parameters for VIs
common DAQ VI parameters, 3-7 to 3-8
conventions, 3-6

pattern generation, 17-2
period measurement. See frequency and period 

measurement.
PFI5/UPDATE* signal (table), 13-2
polling for analog input, 6-9 to 6-10
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ports
digital ports and lines, 15-1
grouping ports without handshaking, A-2
VI port addressing, 3-9 to 3-12
writing to digital port while reading 

digital data, A-2
pressure measurement with strain gauges 

(example), 21-13 to 21-16
Probe tool, 29-4
pulse generation, square. See square 

pulse generation.
Pulse Generator Config VI, 26-6
pulse train generation, 24-9 to 24-20

8253/54, 24-3 to 24-4
continuous pulse train, 24-9 to 24-13

8253/54, 24-12 to 24-13
DAQ-STC and Am9513, 

24-10 to 24-11
DAQ-STC and Am9513, 24-2 to 24-3
duty cycles (figure), 24-2
finite pulse train, 24-13 to 24-20

8253/54, 24-17 to 24-20
DAQ-STC, 24-16 to 24-17
DAQ-STC and Am9513, 

24-14 to 24-15
physical connections (figure), 24-14

pulse width measurement, 25-1 to 25-9
buffered pulse and period measurement, 

25-7 to 25-8
controlling pulse width measurement, 

25-6 to 25-7
counting input signals (figure), 25-1
determining pulse width, 25-2 to 25-6
increasing measurable width range, 

25-8 to 25-9
measuring pulse width, 25-1 to 25-2
overview, 25-1
physical connections for determining 

pulse width (figure), 25-2

Pulse Width or Period Meas Config VI
controlling pulse width measurement, 

25-6 to 25-7
measuring low frequency signals, 26-10

pulsed counter signal generation, 24-1

Q
questions

about using DAQ devices, 4-3 to 4-5
LabVIEW data acquisition common 

questions, A-1 to A-4

R
range and polarity of device, setting, 3-14
range of device voltage

considerations for selecting analog inpu
settings, 5-7 to 5-8

description, 5-5
effect on ADC precision (figure), 5-5
measurement precision for various devic

ranges and limit settings (table), 5-8
Read from Digital Line VI, 16-2
Read from Digital Port VI

digital input application, 21-17 to 21-18
immediate digital I/O, 16-2

referenced signal sources, 5-2
referenced single-ended (RSE) measuremen

system, 5-11
18-channel RSE system (figure), 5-11

relay SCXI modules, 19-5
Remote SCXI, sampling rate limits 

(note), 19-3
REQ (Request) line, 17-2
Resistance-Temperature Detectors (RTDs), 

21-10 to 21-13
resolution of ADC, 5-4

effects on ADC precision (figure), 5-4
round-robin scanning (figure), 9-2
row major order, 3-14 to 3-15
© National Instruments Corporation I-17 LabVIEW Data Acquisition Basics Manual



Index

7

s, 
RSE (referenced single-ended) measurement 
system, 5-11

RTD Conversion VI, 21-12
RTDs for measuring temperature, 

21-10 to 21-13
run_me.llb DAQ example file, 3-2

S
SC-2042 RTD device, 21-11
Scale Constant Tuner VIs, 22-7
Scaling Constant Tuner VI, 21-5, 21-8
scan clock, 9-6 to 9-7

channel and scan intervals using channel 
clock (figure), 9-1

devices without scan clocks (note), 9-6
input pins (table), 9-6
MIO device ScanClock output (note), 9-6
scan-clock orientation of LabVIEW, 9-2
simultaneous control of scan and channel 

clocks, 9-8
scans

channel clock rate parameter, 5-17
defined, 5-17
interval scanning, 5-17
maximum scan rate, calculating, 7-5
number of samples parameter, 5-17
number of scans to acquire 

parameter, 5-17
round-robin scanning (figure), 9-2
scan rate parameter, 5-17

SCXI-116x Digital Output VI, 21-20
SCXI-1100 One-Point Calibration example, 

22-5 to 22-6
SCXI-1100 Thermocouple VI, 21-6
SCXI-1100 Two-Point calibration example, 

22-6 to 22-7
SCXI-1100 Voltage example, 21-5
SCXI-1120/1121 Thermocouple example 

VI, 21-10

SCXI-1122 Voltage example, 21-9
SCXI 1124 Update Channels VI, 

21-16 to 21-17
SCXI-1162/1162HV Digital Input VI, 21-18
SCXI-1200 module

multiplexed mode (Windows), 
19-4 to 19-5

parallel mode (Windows), 19-6
SCXI application examples, 21-1 to 21-21

analog input application for measuring 
temperature, 21-2 to 21-13

analog output application, 21-16 to 21-1
DAQ example files, 3-2
digital input application, 21-17 to 21-18
digital output application, 21-19 to 21-20
multi-chassis applications, 

21-20 to 21-21
overview, 21-1 to 21-2
pressure measurement with strain gauge

21-13 to 21-16
temperature measurement applications

amplifier offset, 21-5
sensors for cold-junction 

compensation, 21-3 to 21-4
using RTDs, 21-10 to 21-13
using thermocouples, 21-2 to 21-3
VI examples, 21-6 to 21-10

SCXI Cal Constants VI
automatic calculation of calibration 

constants, 22-3
calibrating SCXI modules for signal 

generation, 22-8
loading saved calibration constants, 

22-7, 22-8
one-point calibration, 22-5
overwriting default constants in 

EEPROM, 22-2
two-point calibration, 22-7
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SCXI calibration, 22-1 to 22-8
EEPROM for storing calibration 

constants, 22-1 to 22-3
default load area, 22-2
factory area, 22-2
user area, 22-2

one-point calibration, 22-4 to 22-6
overview, 22-3
signal acquisition, 22-4 to 22-7
signal generation, 22-8
two-point calibration, 22-6 to 22-7

SCXI modules
components

chassis (figure), 19-3
illustration, 19-2
overview, 19-2

hardware configurations
illustration, 19-1
overview, 19-1
Windows or Macintosh systems, 

2-9 to 2-10
sampling rate limits for Remote SCXI 

(note), 19-3
software configuration

Macintosh systems, 2-10 to 2-13
Windows environment, 2-10

when to use, 4-3
SCXI operating modes, 19-3 to 19-6

multiplexed mode
analog input modules, 19-4 to 19-5
analog output modules, 19-5
channel addressing, 20-1 to 20-2
digital and relay modules, 19-5
SCXI-1200 (Windows), 19-4 to 19-5

parallel mode
analog input modules, 19-5 to 19-6
channel addressing, 20-1 to 20-2
digital modules (Macintosh and 

Windows), 19-6
SCXI-1200 (Windows), 19-6

SCXI programming considerations, 
20-1 to 20-5

channel addressing, 20-1 to 20-2
gains, 20-3 to 20-5

SCXI-1100 channel arrays, input 
limits array, and gains (table), 20-4

settling time, 20-5
SCXI Temperature Monitor VI, 21-9
settling time (SCXI), 20-5
Show Help option, 3-2
Show VI Info option, 3-2
signal conditioning

amplification, 18-3 to 18-4
common transducers (table), 18-1 to 18-
common types of signal 

conditioning, 18-2
conditioning for common types of 

transducers/signals (figure), 18-3
defined, 18-2
filtering, 18-4
isolation, 18-4
linearization, 18-5
transducer excitation, 18-5

signal divider, 28-1
signal edges, 23-2
signal voltage range. See limit settings.
signals. See also analog input signals.

choosing between analog and digital 
signal analysis, 4-3

simple-buffered analog input
data buffer overview, 7-1 to 7-2
examples

displaying waveforms on graphs, 
7-5 to 7-6

sampling with multiple starts, 
7-7 to 7-8

multiple-waveform acquisition, 7-3 to 7-5
single-waveform acquisition, 7-2 to 7-3
waiting to analyze data, 7-1 to 7-2
© National Instruments Corporation I-19 LabVIEW Data Acquisition Basics Manual



Index

I)

 

Simple Error Handler VI
analog output SCXI example, 21-16
debugging VIs, 29-2 to 29-3
multiple-channel single-point analog 

input, 6-5
single-immediate updates, 11-2

Simul AI/AO Buffered (E-series MIO) VI, 
14-2 to 14-3

Simul AI/AO Buffered (Lab/1200) VI, 14-7
Simul AI/AO Buffered (legacy MIO) VI, 

14-4 to 14-5
Simul AI/AO Buffered Trigger (E-series MIO) 

VI, 14-3 to 14-4
Simul AI/AO Buffered Trigger (Lab/1200) 

VI, 14-7
Simul AI/AO Buffered Trigger (legacy MIO) 

VI, 14-6
simultaneous buffered waveform acquisition 

and generation. See buffered waveform 
acquisition and generation, simultaneous.

single-channel single-point analog input
choosing between single-point and 

multi-point acquisition, 4-4
description, 6-1 to 6-2

single-ended measurement system
nonreferenced, 5-11 to 5-12
referenced, 5-11

single-immediate updates, 11-1 to 11-2
single-point analog output

choosing between single-point or 
multiple-point generation, 4-4

overview, 10-1
single-stepping through VIs, 29-3
single-waveform acquisition, 7-2 to 7-3
software configuration errors, debugging, 29-2
software-timed analog input/output control 

loops, 6-6 to 6-7
software timing, 10-1

software triggering
conditional retrieval examples, 8-11
description, 8-8 to 8-11
timeline of conditional retrieval 

(figure), 8-9
solution DAQ example files, 3-2
SOURCE input, for counters, 23-2
spreadsheet files

Cont Acq to Spreadsheet File.vi, 7-14
simple-buffered-analog input 

example, 7-8
square pulse generation, 24-1 to 24-4

8253/54, 24-3 to 24-4
DAQ-STC and Am9513, 24-2 to 24-3
duty cycle (figure), 24-2
overview, 24-1 to 24-2
single square pulse generation, 

24-4 to 24-9
8253/54, 24-6 to 24-9
DAQ-STC and Am9513, 

24-4 to 24-6
terminology related to, 24-1

square wave frequency, measuring 
(figure), 26-1

STB (Strobe Input) line, 17-2
Strain Gauge Conversion VI, 21-14
strain gauges for measuring pressure 

(example), 21-13 to 21-16
Strobe Input (STB) line, 17-2

T
technical support, B-1 to B-2
telephone and fax support, B-2
temperature measurement applications (SCX

amplifier offset, 21-5
sensors for cold-junction compensation,

21-3 to 21-4
using RTDs, 21-10 to 21-13
using thermocouples, 21-2 to 21-3
VI examples, 21-6 to 21-10
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terminal count (TC), 23-2
thermocouples for measuring temperature 

(example), 21-2 to 21-3
timebase period uncertainty, 24-22
toggled counter signal generation, 24-1
transducers

common transducers (table), 18-1 to 18-2
excitation, 18-5
linearization, 18-5
signal conditioning for common types of 

transducers/signals (figure), 18-3
Transpose 2D Array option (note), 3-15
transposing arrays, 3-15, 3-16, 7-6
triggered data acquisition, 8-1 to 8-11

analog hardware triggering
description, 8-5 to 8-6
examples, 8-7 to 8-8

deciding which digital trigger 
setting to use, A-3

digital hardware triggering
description, 8-2 to 8-3
examples, 8-4 to 8-5

hardware triggering, 8-1 to 8-8
overview, 8-1
software triggering

conditional retrieval examples, 8-11
description, 8-8 to 8-11

triggering vs. external clock control, 4-4
triggering, defined, 8-1
triggers, defined, 8-1
two dimensional (2D) arrays, 3-14 to 3-16

analog output buffers, 3-16
column major order, 3-15 to 3-16
extracting single channel, 3-15 to 3-16
illustration, 3-14
row major order, 3-14 to 3-15

two-point calibration, 22-6 to 22-7

U
unipolar range, 3-14, 5-7
update clock, controlling externally, 

13-1 to 13-3
Generate N Updates-ExtUpdateClk VI, 

13-1 to 13-2
input pins (table), 13-2
overview, 13-1
supplying test clock from DAQ 

device, 13-3
Utility VIs, 3-5

V
VIs. See also Advanced VIs; Easy VIs; 

Intermediate VIs.
channel, port, and counter addressing, 

3-9 to 3-12
common DAQ VI parameters, 3-7 to 3-8
crashing VIs in Windows, A-3
data organization for analog applications

3-14 to 3-16
debugging, 29-1 to 29-4
default and current value conventions, 3-
error handling, 3-8 to 3-9
finding VIs in LabVIEW, 3-3
limit settings, 3-12 to 3-14
organization, 3-4 to 3-5
parameter conventions, 3-6
SCXI examples, 21-6 to 21-10
Utility VIs, 3-5

W
Wait (ms) VI, 6-9, 6-10
Wait on Occurrence function, 7-11 to 7-12
Wait+(ms) VI

finite pulse train generation, 24-14
stopping counter generations, 24-23
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Wait Until Next ms Multiple VI
improving control loop performance, 6-10
multiple-channel single-point analog 

input, 6-5
software-timed analog I/O control 

loops, 6-6
waveform acquisition. See buffered 

waveform acquisition.
waveform acquisition and generation, 

simultaneous. See buffered waveform 
acquisition and generation, simultaneous.

waveform generation. See buffered 
waveform generation.

Wheatstone bridge, 21-13
Windows environment

crashing VIs, A-3 to A-4
installation and configuration

DAQ devices, 2-6
SCXI hardware, 2-9 to 2-10
SCXI software, 2-10

LabVIEW data acquisition hardware 
support (table), 2-4 to 2-5

NI-DAQ drivers, 2-3
problems with older DAQ drivers, A-4

Write N Updates example VI, 11-3
Write to Digital Line VI, 16-2
Write to Digital Port VI

digital output application, 21-19 to 21-20
immediate digital I/O, 16-2

Write to Spreadsheet File VI, 7-8
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